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Tutorial Outline

Time (Tentative!)

Module

Topics

Presenter

8:30-9:00

1. Overview of Eclipse
and PTP

+

Introduction to Eclipse/PTP; demo

Greg

9:00-9:15

2. Installation

+

Confirm Eclipse and PTP installation done
by students before the tutorial

Greg

9:15-10:00

3. CDT: Working with C/C++
Remote Projects

Eclipse basics; Creating a new project
Building and launching remotely

Beth

10:00-10:30

BREAK

10:30-12:00

4. Working with MPI

Makefiles, PLDT MPI tools
Resource Managers
Launching a parallel application

12:00 - 1:30

Lunch

1:30-2:15

5. Debugging

Debugging an MPI program

2:15-3:00

6. Fortran; Refactoring

Photran overview; comparison w/ CDT
Refactoring support

3:00-3:30

BREAK

3:30-4:45

7. Advanced Features: Incl.
Performance Tuning &
Analysis Tools

UPC overview (25 min)
Perf tools: TAU (20), PPW (10)
GEM (20)

Beth
Wyatt/Max
Alan

4:45- 5:00

8. Other Tools, Wrapup

NCSA HPC Workbench, Other Tools,
website, mailing lists, future features

Jay/Beth
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Module 1: Introduction

+ Objective
+ To introduce the Eclipse platform and PTP

+ Contents
+ What is Eclipse?
+ What is PTP?

Module 1
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What is Eclipse?

+ A vendor-neutral open-source workbench for
multi-language development

+ A extensible platform for tool integration

+ Plug-in based framework to create, integrate
and utilize software tools

Java C/C++/Fortran Test and
Development Development Performance Parallel Tools
Tools Tools Tools

Platform

User

Module 1
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Eclipse Platform

+ Core frameworks and services with which all
plug-in extensions are created

+ Represents the common facilities required by
most tool builders:
+ Workbench user interface
+ Project model for resource management
+ Portable user interface libraries (SWT and JFace)

+ Automatic resource delta management for
incremental compilers and builders

+ Language-independent debug infrastructure

+ Distributed multi-user versioned resource
management (CVS supported in base install)

+ Dynamic update/install service

Module 1
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Plug-ins

Java Development Tools (IJDT)

Plug-in Development Environment (PDE)
C/C++ Development Tools (CDT)

Parallel Tools Platform (PTP)

Fortran Development Tools (Photran)

Test and Performance Tools Platform (TPTP)
Business Intelligence and Reporting Tools (BIRT)
Web Tools Platform (WTP)

Data Tools Platform (DTP)

Device Software Development Platform (DSDP)
Many more...

+
+
+
+
+
+
+
+
+
+
+
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Eclipse Parallel Tools Platform (PTP)

Coding & Analysis Launching & Monitoring
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Parallel Tools Platform (PTP)

The Parallel Tools Platform aims to provide a highly

integrated environment specifically designed for parallel
application development

Features include:

+ An integrated development environment (IDE) that

supports a wide range of parallel architectures and runtime
systems

+ A scalable parallel debugger

+ Parallel programming tools
(MPI, OpenMP, UPC, etc.)

+ Support for the integration
of parallel tools

+ An environment that simplifies the E
end-user interaction with parallel systems

+ http://www.eclipse.org/ptp

Module 1
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PTP Features Demo...

+ Creating a project from existing source code -
importing into Eclipse and PTP

+ Content assist, searching, include browser
+ Building the project

+ Launching an MPI program

+ Debugging an MPI program

Module 1
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Module 2: Installation

+ Objective
+ To learn how to install Eclipse and PTP

+ Contents
+ System Prerequisites
+ Eclipse Download and Installation
+ PTP Installation from an Update Site
+ Installation Confirmation

Module 2
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About the Tutorial Installation

This tutorial assumes you have Eclipse and PTP pre-
installed on your laptop

If you already have Eclipse installed, go directly to
“Starting Eclipse”, slide 2-5

If you don't have Eclipse installed, you will need to
follow the handouts so that you can catch up with the
rest of the class

Note: up-to-date info on installing PTP and its pre-reqgs
is available from the release notes:

+ http://wiki.eclipse.org/PTP/release_notes/4.0

+ This information may supersede these slides

Module 2




paratieltools platform

System Prerequisites

+ Local system (running Eclipse)

+ Linux (just about any version)
+ MacOSX (10.5 Leopard or 10.6 Snow Leopard)
+ Windows (XP on)

+ Java: Eclipse requires Sun or IBM Java
+ Only need Java runtime environment (JRE)
+ Java 1.5 or higher
+Java 1.5 is the same as JRE 5.0

+ Note: The GNU Java Compiler (GCJ), which comes
standard on Linux, will not work!

+ See http://wiki.eclipse.org/PTP/installjava

Module 2
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Eclipse Packages

+ Eclipse is available in @ number of different
packages for different kinds of development
+ http://eclipse.org/downloads
+ This is Eclipse 3.6, also known as “"Helios”

+ Two packages are more relevant for HPC:

+ Eclipse IDE for C/C++ developers
+ Base Eclipse distribution plus C/C++ Dev Tools (CDT)
+ Smaller and less cluttered than full SDK
+ Recommended

+ Eclipse Classic

+ The full software development kit (SDK), including Java
and plug-in development tools (PDT)

Module 2
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Eclipse Installation

+ Download the appropriate package

+ If your machine is Linux or Mac OS X, untar

the file
+ On Mac OS X you can just double-click in the Finder

+ If your machine is Windows, unzip the file

+ This creates an eclipse folder containing the
executable as well as other support files and
folders

Module 2
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Starting Eclipse

+ Linux

+ From a terminal window, enter
“<eclipse_installation_path>/eclipse/eclipse &”

+ Mac OS X
+ From finder, open the eclipse folder where you installed
+ Double-click on the Eclipse application
+ Or from a terminal window

+ Windows
+ Open the eclipse folder
+ Double-click on the eclipse executable

Module 2

_——
-
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Specifying A Workspace

e ‘}\\\

+ Eclipse prompts for a workspace location at
startup time

+ The workspace contains all user-defined data
+ Projects and resources such as folders and files

[€= Workspace Launcher

Select a workspace

Th e p rom pt can be Eclipse Platform stores your projects in a folder called a

workspace.

turned off | |
et ———— o | Browse...

Workspace: [l Sl L

[] Use this as the default and do not ask again

Module 2
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Eclipse Welcome Page

+ Displayed when Eclipse is run for the first time
Select “"Go to the workbench”

5y A oA [

= Eclipse
C/C++

Java - Eclipse SDK

Welcome to Eclipse

) Overview : Tutorials

Get an overview of the features

Go through tutorials

Samples _/\_ What's New )
Try out the samples Find out what is new ECI I pse

Classic

Module 2
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Confirm PTP Installation

+ If you pre-installed Eclipse and PTP
+ This will check that it is installed correctly
+ Skip to “"Check Installation Details”, slide 2-14

+ If you have pre-installed Eclipse but not PTP
+ Continue following these slides

Module 2
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PTP Installation

+ New functionality is added to Eclipse using features

+ Features are obtained and installed from
+ An update site on a web server, or
+ A local archive

+ Eclipse 3.6 comes preconfigured with a link to the
Helios Update Site

+ This is a remote site that contains a large number of
official features

+ Helios projects are guaranteed to work with Eclipse 3.6

Module 2
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-t'ﬂ\\

- 3%
-

Helios Update Site

Install

Available Software

Check the items that you wish to install.

+ From the Help menu, choose /
Install New Software... 3 (

+ The Helios site comes
already configured with Eclipse |[ES=—

+ Choose H eI iOS Site I Programming Languages

Find more software by working with the "Available Software Sites" preferences.

4y Autotools support for CDT (Incubation) 2.0.0.201006152250
i+ C/C++ Call Graph Visualization (Incubation) 0.0.1.201006152250
C/C++ Development Tools 7.0.0.201006141710
C/C++ Library APl Documentation Hover Help (Incubation) 0.2.0.201006152250
namic Languages Toolkit - iTcl Development Tools 2.0.0.v20100603-4--90A57D5F9||
tDynamic Languages Toolkit - Ruby Development Tools 2.0.0.v20100505-1154-7G~--E_EK
J== Dynamic Languages Toolkit - TCL Development Tools 2.0.0.v20100505-1154-7L0-EC3V
namic Languages Toolkit - XOTc| Development Tools 2.0.0.v20100603-5--_kE79070D,
I Eclipse Java Development Tools 3.6.0.v20100526-0800-7z8XFUJF
<= Eclipse XML Editors and Tools 3.2.0.v201005241510-7H7AFUID:
«J*Fortran Development Tools (Photran) 6.0.0.201006142322

«J=JavaScript Development Tools 1.2.0.v201005270528-7C78FGDF ¥
>

[ JOOO00

+ We are going to install:
+ C/C++ Development Tools (CDT)*

+ Parallel Tools Platform (PTP) —_— —T
End-User Runtime

* PTP Re m Ote Deve I O p m e nt TOO | S ( RDT) Eclipse C/C++ development tools. Binary runtime and user documentation.

«

X If yo u I N Sta I Ied th e C/C + + I D E , ™ Show °me the latest versions of available software [ Hide. items that are a{ready installed
@_ Group items by category What is already installed?

you already have CDT In your ECIIpse ¥ Contact all update sites during install to find required software
installation and you can omit this.

Module 2
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e Q

Install PTP Features

Install

Available Software |

Check the items that you wish to install. )a___,

+ U n d €r G €nera I P u rp OS€ TOO | S Work with: | Helios - http:/ /download.eclipse.org/releases/helios »] (  Add..

* Para”el TOOIS Platform (PTP) Find more software by working with the "Available Software Sites" preferences.
End-User Runtime ope fer et

Name

* PTP Pa ra I Iel La n g Dev . TOO I S U PC : : 00 Business Intelligence, Reporting and Charting

(0 Collaboration

S u p po rt* : : 000 Database Development

(0 EclipseRT Target Platform Components
v IIX General Purpose Tools

* PTP Re m Ote Dev TOO | S ( RDT) : ) <+ ACTF Visualization Extension for PDT Feature (Incubation)

4= ACTF Visualization Extension for WST Feature (Incubation)
«J=ACTF Visualization SDK Feature (Incubation)

EEm———————————————
4+ Check these and 3. Parallel Tools Platform (PTP) End-User Runtime
CI |Ck \ Neth = = PDE/API Tools Environment Descriptions
«J:- PHP Development Tools (PDT) SDK Feature
- PTP External Tools Framework TAU Extension
- PTP Graphical Explorer of MPI Programs (GEM)
4#- PTP Parallel Language Development Tools UPC Support
- PTP Parallel Performance Wizard (PPW)
- PTP RDT Remote Tools Support
- PTP RDT XL C/C++ Compiler Support
- PTP Remote Development Tools (RDT)

Module 2 ) :
* pre-req pulls in optional CDT UPC feature
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w: Q

Finishing Installation

+ Review the items to be
installed

. - 0 0 Review the items to be installed.
+ Finish installing:
* C h Oose N ext > Na":i Parallel Tools Platform (PTP) End-User Runtime
«J:= PTP Parallel Language Development Tools UPC Support
* Acce pt I I Ce n Se te rm S «J= PTP Remote Development Tools (RDT)
+ Choose Finish
+ Features are downloaded and installed

+ Any pre-requisites are also installed if available
+ Restart Eclipse when prompted

Module 2
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Restart after Install

+ W e | CO m e p a g e ) Java - Eclipse SDK - /Users/beth/ews/test1106_ptp404_tutorialTest

informs you of new | =
features installed

+ Click to learn it

The Eclipse software development kit #development environment used to develop plug-ins for the Eclipse platform. It provides

m O re O r first-class Java programiae=e8Bls, and plug-in development tools for building Eclipse-based applications and extensions.
’ LI |

+ Se I ect WO rkbe n Ch ((3+ C/C++ Development C *H Java development
\ Get familiar with the C/C++ Development Tools (CDT) \ 4 Get familiar with developing Java programs using Eclipse
g | Parallel Tools Platform =‘J) Eclipse plug-in development
WO rk b e n C h Learn more about PTP, the Parallel Tools Platform.

Learn how to extend Eclipse by building new plug-ins

Learn more about PLDT, to help in developing parallel
programs including MPI, OpenMP, and UPC.

Parallel Language Development Tools \ N I

-installed
features in yellow

Workbench basics

Learn about basic Eclipse workbench concepts

Team support

Find out how to collaborate with other developers

Module 2
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Check Installation Details

+ To confirm you have installed OK
+ Mac: Eclipse>About Eclipse
+ Others: Help>About

+ Choose Installation Details

+ Confirm you have the following installed
software

Eclipse Installation Details

[ Installed Software Installation History Features Plug-ins

Name Version
<= Eclipse IDE for C/C++ Developers =
< Parallel Tools Platform (PTP) End-User Runtime 4.0.3.201009141727 {
«J= PTP Parallel Language Development Tools UPC Support  4.0.3.201009141727 ¢
,’L PTP Remote Development Tools (RDT) 4.0.3.201009141727 ¢

Module 2

Differs
depending
on base
download

2-14

_——
-

2
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Checking for PTP Updates

+ From time-to-time there may be newer PTP
releases than the Helios release
+ Helios updates are released only in Sept and February

+ PTP maintains its own update site with the
most recent release
+ Bug fix releases can be more frequent than Helios’

+ You must enable the PTP-specific update site
before the updates will be found

Module 2
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Updating PTP

au ‘}\\\

+ Enable PTP-specific update site —

Available Software

+ Help>Install new software et s o enter o oo fa .

+ Click Available Software 3 ¢
S ites | I n k Find more software by working with tffe "Available Software Sites" prefjrences.
+ Enable/Check the PTP site:
http://download.eclipse.org/tools/ptp/updates/helios
+ Choose OK

+ Choose Cancel (to return to Eclipse workbench)
+ Now select Help>Check for updates

+ Follow prompts like a normal installation

* ReSta rt L IeN$) Available Updates
Available Updates ‘ [—

Check the updates that you wish to install. )=u

Name Version Id
IZ' ) Parallel Tools Platform (PTP) End-User Runtime 4.0.4.201011041729 org.eclip:
121 <= PTP Parallel Language Development Tools UPC Support 4.0.4.201011041729 org.eclip:
[21_ <= PTP Remote Development Tools (RDT) 4.0.4.201011041729 org.eclip:

Module 2
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Module 3: Working with C/C++

+ Objective
+ Learn basic Eclipse concepts: Perspectives, Views, ...
+ Learn how to use Eclipse to manage a remote project
+ Learn how to use Eclipse to develop C programs
+ Learn how to launch and run a remote C program

+ Contents

+ Brief introduction to the C/C++ Development Tools
(CDT)

+ Create a simple remote application
+ Learn to launch a remote C application
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Login Information

+ The hands on portion of this module will be
done on a remote system at NCSA

+ abe.ncsa.uiuc.edu

+ See the following URL for more information on the
system

+ http://www.ncsa.illinois.edu/UserInfo/Resources/Hardware/
Intel64Cluster/

+ Each student will be assigned an ID and
password at the start of the tutorial

+ Please use only this ID
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Eclipse Basics

+ A workbench contains the menus, toolbars, editors and
views that make up the main Eclipse window

+ The workbench represents
the desktop development
environment

+ Contains a set of tools
for resource mgmt

+ Provides a common way
of naVigating through putsC"1 | ello Worddi11°3; /% prints 111
the resources _
Multiple workbenches editor
can be opened at the
same time

Only one workbench can view
be open on a workspace

at a time
Module 3 perspective

Writable S I
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Perspectives

+ Perspectives define the layout of views and
editors in the workbench

+ They are task oriented, i.e. they contain
specific views for doing certain tasks:

+ There is a Resource Perspective for manipulating
resources

+ C/C++ Perspective for manipulating compiled code
+ Debug Perspective for debugging applications

+ You can easily switch between perspectives

+ If you are on the Welcome screen now, select
“Go to Workbench” now &

Module 3
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Switching Perspectives

hrch  Project Run RULGIUE Help

C/C++  New Window
# New Editor

™ Open Perspective > ‘& Debug

. et [ Hel — _ :
+ Three ways of changing 35 ot R N

. Name | Customize Perspective... Other...
pe rS pectlves Save Perspective As... ¥
Reset Perspective...
Close Perspective
. Close All Perspectives

+ Choose the Window>Open
Perspective menu option

+ Then choose Other... ghrarliel Debug A |

888 Parallel Runtime
«J=Plug-in Development

e —) |
+ CIICk On the Open tERemOteSystem Explorer -

Ly Resource
Perspective button in the S
upper right corner of screen G ) =5
1af ﬁl:fJRemote CIC

+ Click on a perspective
shortcut button

+ Switch perspective
on next slide...

Module 3




Select Window>0Open
Perspective

Then choose Other...

Only needed if you're not
already in the perspective

What Perspective am in in?
See title Bar

New Window s

CVS Repository Exploring

Show View \Lu Resource

Customize Perspective... Other...

Save Perspective As...

Reset Perspective

Close Perspective % parallel Debug

Close All Perspectives | | 246 Parallel Runtime
J"Plug-in Development

Navigation FORemoteC/Crs |1}

;E Remote System Explorer
Working Sets {5 Resource -

Preferences...
(  cCancel ) | oK )
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Resource - MyCproject/src/MyCproject.c - Eclipse SDK
File Edit Refactor Navigate Search P i |

Views

+ The workbench window is
divided up into Views

+ The main purpose of a view is:
+ To provide alternative ways of presenting information
+ For navigation
+ For editing and modifying information

4+ Views can have their own menus and toolbars

+ Items available in menus and toolbars are
available only in that view

+ Menu actions only —
apply to the view 5= Qutline 52

+ Views can be resized ¢ main():int

Module 3
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Stacked Views

+ Stacked views appear as tabs

+ Selecting a tab brings that view to the
fO reg rO U n d 800 Remote C/C++ - hello/hello.c - Eclipse - /Users/beth/ews/test0917c
S Eiv&iv [ @r ||~ X ea

838 Parallel Runt... FiclRemote C/C...
B | [E M| FE e

: N
[ Projec 83 8 Remo | = O/[[<] hello.c £3 = O|[ 8 outline 2
= -4 A ‘ﬂz \
. . hel =l stdio.h
= stdlib.h
@ main(void) : int

=5 hello
\.c| hello.c
nit Includes

#include <stdi >
#include <stdlib.h>

int main(void) {
puts("!!!Hello World!!!"); nts
return EXIT_SUCCESS;

111Hello World

ETTTTTTTTIZISSN. >

2

E console £ _[Z( Problems | 12® Remote Call Hiera | f¢ Remote Type Hier | [ Remote Environm =0
C-Build [hello] BH Gk |2 Bv [

gcc -g -0 hello hello.c

Writable Smart Insert - | Remote Tools DStore S...c.edu): (100%)
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Help

TO access help ®eOno Help - Eclipse SDK
+ Hel p >Hel P Contents [ <[> J[&][+]® hup://127.0.0.1:52360/help/index.jsp
[ PTPWiki Eclipse, Jav...Eclipse Zone E Downld Stats Google Calendar Gmail - Contacts
+ Help>Search

Search: |:]@ Scope: All topics
+ Help>Dynamic Help _ =k

Contents v | v =
Help Contents provides
detailed help on different
Eclipse features in a
browser

Search allows you to
search for help locally, or
using Google or the Eclipse
web site

Dynamic Help shows help
related to the current
context (perspective, view,
etc.)

Module 3

Workbench User Guide

ava development user guide

Platform Plug-in Developer Guide

DT Plug-in Developer Guide

Plug-in Development Environment Guide
C/C++ Development User Guide

CDT Plug-in Developer Guide

avaScript Development Guide

Parallel Tools Platform (PTP) User Guide
Photran User's Guide

Remote Development Tools User Guide
Rephraser Engine Plug-in Developer Guide
RSE Developer Guide

RSE DStore Developer Guide

RSE User Guide

Subclipse - Subversion Eclipse Plugin

> Web Tools Platform User Guide

Display a menu

Using the help system

Browse topics in the Contents frame (E) on the left. Click
on a topic to have it displayed. Use the Back and Forward
buttons to navigate within the history of viewed topics.

Searching

To quickly locate topics on a particular subject in the
documentation, enter a query in the Search field. Use the

Search frame (V') to display the Search view. You can
narrow the scope of your search by selecting only the
sections you are interested in.

Synchronizing

Clicking the Show in Table of Contents button () will
select that topic in the navigation tree. The Link with

Contents button (%ﬁ ) keeps the navigation tree
synchronized to the current topic.

Capabilities
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Preferences

type filter text

General

Ant

C/C++
Appearance
Build
Code Analysis

Debug
Editor
Environment
File Types

Code Style

Select a profile:

K&R [built-in]

Configure Project Specific Settings...

B

New... Import...

Preview:

/%
/

* A sample source file for

Indexer

e NO

Profile 'K&R [built-in]'

+ Eclipse Preferences allow
customization of almost everything

+ To open use
+ Mac: Eclipse>Preferences...
+ Others: Windows>Preferences...

+ The C/C++ preferences

Language Ma
New CDT Pro|
Property Pag¢
Scripting :
Task Tags
Template Def
XL C/C++ Cq
XLC/C++ La

Fortran

Help

Install/Update

Java

JavaScript

Parallel Tools

Plug-in Develop

Remote Systems

Remote Tools

Run/Debug

Server

Service Configur

TAU Configurati

Team

Validation

Web

Web Page Editor

XML

Profile name: | K&R [built-in]

{“Indentation

Braces

White Space Control Statements Line Wrapping

General settings

Tab policy:

] Use tabs only for leading indentations
Indentation size:

Tab size:

Indent

") 'public', 'protected', 'private’ within class body

@ Declarations relative to 'public’, 'protected’, 'private’
@ Statements within function body

¥ Statements within blocks

(") Statements within 'switch' body

@ Statements within ‘case’ body

@ 'break' statements

] Declarations within ‘namespace’ definition

) Empty lines

Preview:
Tabs only v /*

* Indentation
*/

#include <math.h>

class Point {
public:

Point(double xc, double yc) :
x(xc), y(yed {

double distance(const Point& other) cong
int compareX(const Point& other) const;

double x;
double y;
b

double Point::distance(const Point& other) ¢
double dx = x -
double dy = y -

allow many options to
be altered
: Ml +In this example the
Code Style preferences
are shown
+ These allow code to be
automatically
formatted in different
ways

other.x;
other.y;

return sgrt(dx * dx + dy * dy);

}

int_Point::compoareX(const Point& other) cons”
<€ : >

Cancel
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Types of C/C++ Projects

C/C++ Projects can be
+ Local - source is located on local machine, builds happen locally

+ Remote - source is located on remote machine, builds take place
on remote machine

+ Makefile-based - project contains its own makefile (or makefiles)
for building the application

+ Managed- Eclipse manages the build process, no makefile
required

Parallel programs can be run on the local machine or on a remote
system

+ MPI needs to be installed

+ An application built locally probably cant be run on a remote
machine unless their architectures are the same

We will show you how to create, build and run the program on a
remote machine

+ We will create a remote Makefile project

Module 3
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Remote Projects

Remote Development Tools (RDT)

+ Source is located on remote machine
+ Eclipse is installed on the local machine and can be used for:
+ Editing
+ Building
+ Running
+ Debugging

+ Source indexing is performed on remote machine

+ Enables call hierarchy, type hierarchy, include browser, search,
outline view, and more...

+ Builds are performed on remote machine
+ Supports both managed and makefile projects

+ Application is run and debugged remotely using the PTP resource
managers
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Creating a Remote C/C++ Project =

+ Use File>New>Remote C/C++ Project to open the
new project wizard

+ The wizard will take you through the steps for creating
the project

g Eclipse ;[0 Edit Source Refactor Navigate Search Run Project Se

New L#EN > T pemote C/C++ Project
J Open File... =4 Project...
w Open Save Pt Close
| Close All
—— © Example...

e Save

Save As... % Other...

4 Connection

Don’t see the "Remote C/C++ Project” choice?
Make sure you are in the Remote C/C++ Perspective

Module 3
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aw ‘2\\

New Remote Project Wizard

M. NeN) New Remote Project
+ Enter prOjeCt name’ e'g' “heIIO,, g;v:r:;:olza’:i;:i::ectorymustbespeciﬁed
+ Select a Remote Provider R
+ Remote providers supply different ' :
ways of accessing remote (or local) Z”’ P"
systems R
+ Choose Remote Tools

Location:

Project type: Toolchains:

+ A Connection specifies how to > Remote ke £

@ Empty Pro Cygwin GCC

Linux GCC

connect to the remote host

MinGW GCC

4+ Click on the New... button to create a Solaris GCC
new connection

) Show project types and toolchains only if they are supported on the platform
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. ‘2\\

Remote Host Configuration

Enter a connection name (can be Remote Host

anything) for the Target name roperies P omedna o sremote e

+ Use “abe.ncsa.uiuc.edu” Target name: | abe.ncsa.uiuc.edu
The host is remote, so the Remote [ —
host option should be checked Host: |abe ncsa.uiuc.edu

Enter the host name or IP address User: | ewain

) password based authentication

of the remote host for the Host R
+ Use “a be.ncsa_UiUC_edu" () Public key based authentication

File with private key:

Enter the user name and

password supplied at the beginning
of the tutorial for the User and
Password

+ Click Finish

Passphrase:

( Advanced )

Cancel ) (€ Finish )




paratieltools platform

Project Location

+ The Location is the directory on
the remote host containing the
source and executable files

+ Click on the browse button to
browse for folders on the remote
machine

+ You should see the folders in your
home directory

+ Choose the “hello” directory

+ Click OK

New Remote Project
New Remote Project

Existing project settings will be overridden

Project name: hello

Remote Provider: | Remote Tools

Connection: | abe.ncsa.uiuc.edu

Location: fufac/etrainl/hello

Project type: Toolchains:
(= Remote Makefile Project -- Other Toolchain #/~
@ Empty Project Cygwin GCC

Linux GCC
e NoO Browse Directory

Select directory:

fu/ac/etrainl/he

(= .ssh

I &= hello

(= shallow
(") Show proje

aw ‘2\\
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Project Type
- :
+ The Project type determines e -
Informatlon about the prOJeCt Existing project settings will be overridden

If the project is managed or Project name: [hell
unmanaged (described later)

Remote Provider: | Remote Tools T]

The tool chain (compiler, linker, etc.) L m—
to use When bu”dlng Location: >/'u.lac/etrain1/hello

If the project creates an executable,

Project type: Toolchains:

Statl C, O r Sh a red I | b ra ry (== Remote Makefile Project -- Other Toolchain -~
Cygwin GCC

Options available depend on whether Linux GCC

MacOSX GCC

the project is local or remote MinGW GCC

+ Under Remote Makefile
Project, select Empty Project

+ FO r TOO I C h a i ns , se | e Ct ot h (] g () Show project types and toolchains only if they are supported on the platform
Toolchain

+ Click on Finish to complete the @ <tk ) (o> ) ((Ganel ) (@ormsie)
wizard

Module 3
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Changing Remote Connection Information

+ If you need to change remote connection
information (such as username or
password), use the Remote

Environments view

"% Remote Environments &3

Target Environment
7_;] Ceneric Host
7_;] PTP Remote Host

e Create + Stop the remote

connection first

+ Right-click and
select Edit

Remove

+ Note: running server is shown in lower right
+ Opening any remote file restarts it LR St IR DRGNS
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Project Explorer View

+ Shows the user’s projects
+ Each project contains
+ Source files
+ Executable files
+ Folders
+ Metadata (not visible)
+ Can have any number of projects

+ We only have a single project so
far

| L5 Project Explorer 23

=< hello
.| hello.c
hello
& makefile
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Editor and Outline View

eno

Remote C/C++ - hello/hello.c - Eclipse SDK - /Users/beth/ews/test1106_ptp404_tutorialTest

Double-click on
source file to open o

[ Project Ex 23 28 Remote s

g | EfY BIv civ @~

editor o T

lo1$ hello.o
@ makefile

Outline view is

= 084 hello.c 52

O [ O & B fgc/c++

0= Outline &3

: hello_world.c " stdio.h
: Eclipse PTP Bl stdlib.h

L] ;ﬁin(void) int

Name
Author
Version
Copyright
Descrdnls

: Your copyright _ogis
e norld in C, Ansi-s

shown for file in
editor

You should see red
on the include files:
we will fix this

later

#include <stdio.h>
#include <stdlib.h>

int main(void) {
puts("!!!Hello World!!!"); /* prind{
return EXIT_SUCCESS;

} N

v
3 s
Console &3 |2 Problems :*" Remote Call Tz Remote Typ &o) Remote Env

C-Build [hello] & 0| LE GE G| 2

gcc -g -c hello.c
gcc -g -0 hello hello.o

>

Console shows
results of build

Remote Tools DStore S...s.edu): (100%)
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Editors

esource - MyCp
Eile Edit Refactc Navigate Search P

An editor for a resource (e.g. a file)

opens when you double-click on
a resource

The type of editor depends on the type of the resource
+ .c files are opened with the C/C++ editor
+ Some editors do not just edit raw text

When an editor opens on a resource, it stays open across
different perspectives

An active editor contains menus and toolbars specific to that
editor

When you change a resource, an asterisk on the editor’s
title bar indicates unsaved changes

Save the changes by using Command/ =5
Ctrl-S or File>Save

Module 3
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Source Code Editors & Markers

A source code editor is a [ElrERrTS s
special type of editor for o i e

manipulating source

double evaluate(double X)

code S R | |
. add semicolon to end of next line

Language features are g ——double.y 23.0%.£.2.9

highlighted

Marker bars for showing

+ Breakpoints

+ Errors/warnings

+ Task Tags, Bookmarks

Location bar for
navigating to interesting

features in the entire file ¢/ Task tag
Warning
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Line Numbers

.| hello.c &3

+ Text editors can show line numbers in the

left column

+ To turn on line
numbering:

+ Right-mouse click in
the editor marker bar

4+ Click on Show Line
Numbers

3 Name
1 Author
Version

6 Copyrig
.c| hello.c 3

v)

Author 1 #include

Toggle Breakpoint 1t notic

Enable Breakpoint in C, Ansi-style

1
1
12 #include
s
-st

Breakpoint Types p [TUTTTEETEEEEmEmmmmmmmmmmm——

Add Bookmark...
Add Task...

v Show Quick Diff ~0Q

S'iow Line NumBerS ); /% prints !!!lHello Wo

Folding >

Preferences...

rld
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Include File Locations

.c| hello.c &3
*/

Content assist and navigation —
requires knowledge of include file [ —
location on the remote system | Fetien o stcces,

The editor will highlight lines in e

E Console | [5( Problems &3 ::*" Remote Call Hierarchy T; Remote Type Hierarchy [%) Remote En

t h a t h a Ve t h e p ro b | e m OD:;:::ijnwami"gs' — A |Resource Path Location Type

% Warnings (2 items)

/* prints !11Hello W

inclusion: <stdio.h> in hello.c /hello line 11 Indexer Problem

Problems View will display a D nder Uresotved nclson: sl heloe. [tk Boe 32 deses robie
warning

The project properties must be
Changed to resolve the problem Indexer: Unresolved inclusion: <stdio.h> in

file: /u/ac/etrainl/hello/hello.c:11. Please re-
configure project's remote include paths or
symbols.
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Changing the Project Properties

. . (o NON&) Properties for hello
O p e n t h e p rOJ e Ct p ro pe rt I e S by type filter text Remote Paths and Symbols e

Resource

right-clicking on project and

C/C++ Build Configuration: | Default [ Active ]
I t P t' C/C++ General
S e e C ro pe r I es Project References
Remote Development
Remote Paths and Symbc

Expand Remote Run/Debug Settings

Service Configurations

Development ke
Select Remote Paths and
Symbols

Select GNU C to change
C paths and symbols

CIiCk Add [ (= Remote Includes | # Symbols |
Enter “/usr/include” ssems )
Click OK

Remote Include Directory

] Add to all languages
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Saving the Project Properties

+ Click OK to save the Project
Properties

+ You will be prompted to
rebUild the IndeX O Remote Paths and Symbols

1 Changes to the include search paths or defined symbols will not be reflected in the

* Se I eCt Yes . index until it is rebuilt. Do you wish to rebuild it now?

|| Remember my decision

+ Red warnings should be & helloc 52
gone from editor, Slnce #include <stdio.h>

#include <stdlib.h>

ECIipse knOWS the Iocation int main(void) { |
of the include files now } patsC}1 (Het1o NorkdIL15; /2 prints [filetic bo
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Navigating to Other Files

+ On demand hyperlink B hellox 53
+ HOId down COmmand/Ctr| key #inc{uge stj{obh}
#include <stdlib.h>
+ Click on element to navigate to it matnCuoid)
its definition in the header flle puts("!11Hello World!!!"); /* prints 111Hello World!!! */
. . return EXIT_SUCCESS;
(Exact key combination }
depends on your OS)

+ E.g. Command/Ctrl and click on
EXIT_SUCCESS

L] hello.c 7h) stdlib.h 23

he same for all machines.
Changes\ from this to the outside world should be done in
#define EXIJ_FAILURE 1 /* Faili t status. */
#define EXIT_SUCCESS @ /* Successful exit status. */

+ Open declaration

+ Right-click and select Open
Declaration will also open the

. . . . : P Open Type Hierarchy F4
#include <st
ﬁle In Wthh the element IS #include <st  Open Call Hierarchy ~XH

' _ ~ Quick Outline #0
declared int EEZ:EV?} Quick Type Hierarchy 8T

+ E.g. right-click on stdio.h and return £ Explore Macro Expansion %=
. 1 Toggle Source/Header ~Tab
select Open Declaration

irld!!

Module 3
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Content Assist & Templates

+ Type an incomplete function name e.g. “get” into the editor,

and hit ctrl-space

+ Select desired completion value with cursor or mouse

lint main(v
puts("
get

[

1:
]
1!
1¢
1
1
]

- ret
) }

v)

oid) {

I11Hello World!!!" /* prints !!!Hello World!!! */

yeluian_uliiucn vUIU) L
A

bdr * * __lineptr,* __n,int __delimit
* __name) : char * 0
getline(char * * __lineptr,* __n,FILE * __strear

neatlnadavaldnuhle * lnadawva int nelam)
18

Press "~Space’ to show Template Propos

+ Code Templates: type

‘for” and Ctrl-space

-| for - for loop
-| for - for loop

Hit ctrl-space again
for code templates

for (int var = 9; var < mcix; ++var) {

with temporary variable

}

e ‘,}\\\




paratbel—tools platform

7E*$§

Building the Project

+ The project should build automatically when created
+ If there is no makefile, then the build will fail

+ To manually build, select [ Project Explorer 53 =0
the project and press the & <

the “build” button
+ Alternatively, select Project>Build g hello.c
Project ' hello

& makefile
+ The executable should appear in

the project
+ The Console view shows [fEpammmes

build output C-Build [hello] 11, ¢ &

gcc -g -0 hello hello.c'

Executable
‘hello’
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Build Problems

+ If there are problems, they g

g€l hello.c 23 = 0| 5% outline 2 =0

will be shown in a variety - 2 BN ok~

tint main(void) { 5] stdio.h

Of Ways ' puts("!!!Hello World!!!"); /* prints !!lHello = Std_“b'h_ )
. . ' getenv(D; - g main(void) : int
+ Marker on editor line -
+ Marker on overview ruler
+ Listed in the Problems view

] console | . Problems &3 :”" Remote Call Hi ‘f:; Remote Type F}g Remote Enviro
4 errors, 7 warnings, 0 others
Description A Resource Path Location Type

€3 Errors (4 items)

€3 'for' loop initial declaration used outside C9 hello.c  /hello line 18 C/C++ Problem
3 'max' undeclared (first use in this function) hello.c  /hello line 18 C/C++ Problem

(®) make: *** [hello.o] Error 1 hello [ |  |C/C++Problem |
3 too few arguments to function ‘getenv' hello.c  /hello line 17 C/C++ Problem
% Warnings (7 items)

+ Double-click on line in
Problems view to go to
location of error
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Fix Build Problems

Fix errors by giving getenv an argument and fixing
declarations as shown

Save the flle = h‘::\.zlie <stdlib.h>
Rebuild by pressing build "

1int main(void) {

puts("!!!Hello World!!!"); /* prints !!lHello

Problems view is now S gethnv("LANG");
empty &‘1 ;Of‘ (var = @; var < max; ++var) {

return EXIT_SUCCESS;

1.

1

1

15 int var;

bUtton 16 int max=99;

17

1

1

Ll v
3 -
E Console | % Problems &3 :*v Remote Call Hi Tz Remote Type

0 items

Description A Resource Path Loc
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Create a Resource Manager

+ A Resource Manager specifies how/where
programs will be launched e

+ Switch to the Parallel Runtime perspective i St

%5 Debug

+ Window>Open Perspective... F Fortran

ﬁParallel Debug

:
+ In the Resource Managers view,

fEiRemote C/C++

right_CIICk and Select Add Resource £ remote System Explorer

Ly Resource

M a nage r. (N ] é':'Team Synchronizing
+ Select Generic Remote Launch and\Next >
( cancel ) 0k )

Ne—— —
Choose Resource Manager Type

Select the type of resource manager to use

Resource Manager Types:

Add Resource Manager...
L3

IBM LoadLeveler Remove Resource Manager
IBM Parallel Environment

MPICH?2 Edit Resource Manager
Open MPI
ol Set Default Resource Manager
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Configure the Resource Manager

e NO

Connection configuration

+ Choose Remote TOOIS for Enter connection information
Remote service provider

+ Choose “abe.ncsa.uiuc.edu”
for Connection name

+ This was the connection used
when the project was created

+ Select SSH port forwarding
for Tunneling Options

4+ Click Finish
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Start the Resource Manager

(+) Resource Managers &3 -0

+ Right-click on the new D termoteabe nciuuc - S T —————
resource manager and select Remove Resource Manager

o
Start Resource Manager Flit Resource Manager
Set Default Resource Manager
from the menu
+ If the resource manager M Stop Resource Manager
starts successfully, the icon
should turn green
(+) Reslarce Managers 53

+ An |C0n COIOr Of red Indlcates Remote@abe.ncsa.uluc.edu(CenerlcRemoteLaunch)
a problem occurred

' {

greg@localhost:~

fle Edit View Terminal Help NOTE: On some Linux systems, starting a resource

[greg@localhost ~]$ eclipse/eclipse

Kerberos username [greg]: manager may appear to hang. Open the window
Kerberos password for greg: . - c
you launched Eclipse from and check if there is a

prompt for a kerberos username. Hit “enter” twice
if you see the prompt.

3-33
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Create a Run Configuration

To run the application, create a
Run Configuration

+ Open the run configurations
dialog
+ Click on the arrow next to the run button
+ Or use Run>Run Configurations ==

+ Select Parallel Application
+ Select the New button

type filter text

[C]C/C++ Application
Erortran Local Application
@ Launch Group

: Parallel Application

Depending on which flavor of
Eclipse you installed, you might
have more choices of application

types @

Module 3

e ‘}\\\

Run Configurations...

Organize Fayorites..k
Run Configurations
@

- Press the 'New' button to ...ration of the selected type.

Configure launch settings from this dialog:

- Press the 'Duplicate’ butt... the selected configuration.
- Press the 'Delete’ button ... the selected configuration.
- Press the 'Filter' button to configure filtering options.
- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the
Perspectives preference page.
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Complete the Resources Tab

+ Select your Resource Manager
+ Should be selected automatically if it has been started

+ The Generic Remote Launch doesn’t require additional
attributes

+ Other resource managers may have additional attributes, such as a
gueue name, etc.

Run Configurations

Create, manage, and run configurations
Create a configuration to launch a parallel application in Parallel Perspective <1/>

& = % —»,
= Name: hello

type filter text 5% Resources ). [E] Application | ()= Arguments | i Environment | Synchronize | %5 Debugger | 2
Lc |C/C++ Application Resource Manager: | Remote@abe.ncsa.uiuc.edu +
| F |Fortran Local Application

= Launch Group Launch Attributes
5=} Parallel Application
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Complete the Application Tab

+ Make sure “hello” is selected =

Create, manage, and run configurations

-
fo r t h e Pa ra I I e I P rOJ ect Create a configuration to launch a parallel application in Parallel Perspective

+ Browse to find the EEIEES
. type filter text 8 Resources (=] Application ) (9= Arguments | B§ Environment | 4
exe C u ta b I e fl I e fo r t h e [€]c/C++ Application Parallel Projec A

[F]Fortran Local Application

Application program Firate pphcion
[ hello |

"hello
Application program:

fufac/etrainl/hello/hello

("] Copy executable from local filesystem
Path to the local file:

* LaunCh the applicatlon by ™ Display output from all processes in a console view
clicking the Run button

Filter matched 5 of 5 items
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Viewing Program Output

+ When the program runs, the Console view should
automatically become active

+ Any output will be displayed in this view

4+ Stdout is shown in black
+ Stderr is shown in red

El console 23

Remote@Remote Host:Default:job0
I11Hello World!!!




paratieltools platform

Other CDT features

+ Searching
+ Mark Occurrences

+ Open Declaration / hyperlinking between files
in the editor

First, return to the "Remote C/C++
Perspective”
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Language-Based Searching

Navigate p-{-i < Project Run Wi

c - Eclipse - ' Search...
7 File...
* Remote C/C++.\
F” Remote...

Text

[ B7Remote Search -/ File Search 7 Task Search  %/C/C++ Search | £5Remote C/C++ Search | “Knows” What thlngs can
Search string (* = any string, ? = any character): T] S be declared |n eaCh

I — - | language (functions,

e variables, classes,
Enumeration (7 Enumerator (7 Namespace | R modules, etc.)

Y Typedef S For example, search for
i : every call to a function
Overispace  Oselecedresources O fndosimgprojecss whose name starts with

() Working set:
S—— A\Y n
get

Search can be project- or
@ (Ccustomize..) CGancsl ) (search ) | workspace-wide
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Mark Occurrences

+ Double-click on a variable in the CDT editor

+ All occurrences in the source file are
highlighted to make locating the variable
easier

+ Alt-shift-O to turn off

.c| hello.c 23

lint main(void) {
g int var}

puts("!!!Hello World!!!"); /* prints !!lHello
getenv("LANG");
for (var = @; var < max; ++var) {

}
return EXIT_SUCCESS;

1

1

1°

16 int max-99;
17

1

1
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Open Declaration

Jumps to the declaration of FERSGEECEE 53 ) sdio.h
a variable, function, etc.,

N . : ” Undo Typin
even if it's in a different file YPing

Author
Versio

Right-click on an identifier Copyri

] i Open Declaration
Click Open Declaration

Open Type Hierarchy
Open Call Hierarchy

Can also Ctrl-click (Mac: Quick Outline
Cmd-click) on an identifier #includ Quick Type Hierarchy

W . . Explore Macro Expansion
to “hyperlink™ to its v) 1nt mal  Toggle Source/Header

declaration Z:: Show In Caew
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Remote Projects - Location

L[ Project Explorer &3
How to tell where a project
resides?

Right-click Project 300 Properties for hello
Select Properties... o T

C/C++ Build Type:
C/C++ General Location:
Project References

In Properties dialog, Remote Development | (22 mecfed T

Remote Paths and Symbc Text file encoding

Run/D Setti i i
Se I ect Reso u rce S:rr:/ilceegzaﬁ;rrl:t?;ns ® Inherited from container (MacRoman)

(O Other: MacRoman '~

New text file line delimiter

@ Inherited from container

() other:

Cancel
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Remote Projects - Reopening

+ When re-opening Eclipse S
workbench, remote projects o Biiec Exploreals

will be closed :t:fhello
] shallow

+ To re-open a closed project,
Right-click on closed project
and select Open Project

Open project shows folder [ \Project Explorers?
icon, and can be expanded to LS hello
show contents of project L shallow
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Module 4: Working with MPI

+ Objective

+ Learn how to develop, build and launch a parallel
(MPI) program on a remote parallel machine

+ Contents
+ Remote project setup
+ Building with Makefiles
+ MPI assistance features
+ Working with resource managers
+ Launching a parallel application

Module 4
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L ocal vs. Remote

+ PTP allows the program to be run locally if you have MPI
installed

+ However we want to run the program on a remote
machine

+ We will now show you how to run a parallel program on
a remote machine

+ Interactively
+ Through a batch system

+ We have provided the source code to an MPI program
on the remote machine

+ The project will be created using this source code

Module 4




Creating a Remote MPI Project

Like the previous module, create

2 new Remote C/C++ project
W—

- v Remote C/C++ Project

Open File... 4 Project...

Enter “shallow” for the Project L »
N ame e 4 Close All 4 8BW

- [2] Save %S
Use the same Connection as before

Click the Browse... button and
choose the directory “shallow” in New Remote Project
|n your home dlrectory Existing project settings will be overridden

Select a Remote Makefile Project

as before
. = om emote Provider: | Remote Tools v
Click Finish vemos provier: (Remere Tocs B3

Connection: | abe.ncsa.uiuc.edu o ( New.. )

Location: fu/ac/etrainl/shallow ( Browse... )

-4 Connection

% Other...

New Remote Project

Project name: shallow

You may be prompted to open
the Remote C/C++ Perspective Prolect type: Tookchalns:

(= Remote Makefile Project -- Other Toolchain -~
@ Empty Project Cygwin GCC
Linux GCC

Module 4
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Changing the Project Build Properties

+ The project makefile has a non-standard name
Makefile.mk

. L[ Project Explorer =R ~ = B[4 hello.c
+ We need to change the build e, — =

New

properties so that the project oy Go Into

1€] copy.c

W| ” bu | Id [n] decs.h Open in New Window

,c| diag.c
+ By default, the project is built by 8 dump.c 2 Copy
3 A\ ” vcl init. X
running “make [8) main.c Paste
l.c| time.c ¥ Delete

] tstep.c Remove from Context
- AL . 1C| worker.c Move...
+ Right-click on project scocint | ename..
Sha”OW N the ProJeCt {Jmain.o Run As
Explorer Makefile.am Debug As

| Makefile.in Profile As

+ Select Properties pakeflenk  eam

:;;'Sng Compare With
——mnm Restore from Local History...

Module 4
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Changing the Build Command

+ Select C/C++ Build
+ Uncheck Use default build command

+ Change the Build command to:
+ make -f Makefile.mk

Properties for shallow

C/C++ Build

Resource
Builders
C/C++ Build Configuration: | Default [ Active ]
Build Variables
Discovery Options
Environment
Logging (/=] Builder Settings | (@) Behaviour _
Settings - g
Tool Chain Editor Builder
C/C++ General
Project References Builder type: External builder
Remote Development
Run/Debug Settings
Service Configurations
Task Repository
WikiText

e default build commangd

Build command:” make -f Makefile.mK

Makefile generation

Build location

Build directory: | fu/ac/etrainl/shallow

Module 4
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Building the Project

+ Click OK to save project properties after changing
build command

+ Select project and hit the build button

+ The project can be built at any time
by hitting this button

o | [Ef B ¢y (&~
L[| Project Explorer &3 = 0O

=< hello

.c| hello.c Author
hello Version
Copyrig

Module 4
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Include File Locations

+ Like the previous example, Eclipse content assist and
navigation require knowledge of include file locations on the
remote system

+ Since the build will be running remotely, the compiler knows
how to find include files

+ But Eclipse does not

L[ Project Explorer &3

£~ shallow New

+ In Project Explorer, oe. | Golo
right-click on project Openin New Windoy

= Copy
Paste
- ¥ Delete
+ Se I eCt Pro pe rtles -l \‘.OSS{TTOVQ from Context
Rename...

o1y main.o Run As
Makefile.am Debug As
Makefile.in Profile As
.:‘M.akéﬁle.mk Team
Compare With
e Restore from Local History...
5 shallg -
b= sha Properties

Module 4
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Remote Paths and Symbols

In Project Properties,
Expand Remote Development
Select
Remote Paths and Symbols
Select Languages>GNU C

+ This is compiler on abe

Click Add...

+ Enter /usr/local/openmpi-1.4.2-intel-11.1/include
Click OK, then Add... again

+ Enter /usr/include

. Include directories
Click OK 5 /usr/local/openmpi-1.4.2-intel-11.1/include

Click OK to close preferences (2 jusr/include

When prompted to rebuild
index, click OK

Module 4
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MPI-Specific Features

+ PTP’s Parallel Language Development Tools (PLDT)
has several features specifically for developing MPI
code

+ Show MPI Artifacts

+ Code completion

+ Context Sensitive Help for MPI
+ Hover Help

+ MPI Templates in the editor

More MPI features covered in
Module 7: Advanced Features

Module 4
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Show MPI Artifacts =

+ In Project Explorer, select a project, folder, or a single source file
+ The analysis will be run on the selected resources

+ Run the analysis by clicking on drop-down menu next to the
analysis button

+ Selecting Show MPI Artifacts

C/C+ shallow/main.c<Eciipse,- /Users/beth/ews/testptp

FY [B2CVS Reposit...  »

I Project Explorer 23 = BRI . Clhew MDPI Ardifarte . B3z o 23 @m|ET|=0
i - Show MPI Artifacts N hnv e me
VB> shallow [cvsncsa.uivc.ed " Show OpenMP Artifacts B mathh
e 1 - . =1 mpih
> [ calcc 1.1 | w4 MPI Barrier Analysis ‘ B stdioh
o . o decs.h
"fr)' ShOW UPC Al’tlfaCtS ) ++ worker() : void
) . ++ setup_res() : MPI_Datatype
" ShOW LAPI Al’tlfaCtS @ main(int, char*(])
® setup_res() : MPI_Datatype
fprintf(stderr, "must have at least 2 processes, © update_global_ds(MPI_Dat:
MPI_FinalizeQ);
return 1;

> [d) 1
b | tstep.c 1.1
» [l worker.c 1.1 }
jaclocalm4 1.1
JAUTHORS 1.1 if ( (n % (proc_cnt - 1)) 1= 0 )
j Changelog 1.1 {
commile 11 == o
j config.guess 1.1 = -
} config.hin 1.1 [2( Problems | | Tasks | &) Console | =] Properties | §» MPI Artifact View 53

jconfig.sub 1.1 Artifact Filename

_‘conﬁgure 11 P MPLInit main.c
j configure.ac 1.1 W MPI_Comm_size main.c
) COPYING - ¥ MPI_Comm_rank main.c
) depcomp 1.1 W MPI_Finalize main.c
§INSTALL 1.1 ¥ MPI_Finalize main.c
jinstall-sh 1.1 W MPI_Barrier main.c

j Makefile.am 1.1 <

Module 4




Markers indicate the
location of artifacts in
editor

The MPI Artifact View
list the type and location
of each artifact

Navigate to source code
line by double-clicking on
the artifact

Run the analysis on
another file (or entire
project!) and its markers
will be added to the view
Remove markers via

Click on column headings
to sort

Module 4

o | ©iv & [ @~
S Sy v
Rroject Explorer 53 =
P (=5 Helld
vb_% ~shallow [cVS
P [n)} Includes
P lgjcalcc 1.1
P | copy.c 1
» [Rdecs.h 1.2

> | tstep.c 1.1

b | worker.c 1
jaclocal.m4 1.1
J AUTHORS 1.1

:‘conﬁg.h.in 1.1
3 config.sub 1.1
3 configure 1.1

3 configure.ac 1.1
4 COPYING 1.1

3 depcomp 1.1
JINSTALL 1.1
jinstall-sh 1.1

} Makefile.am 1.1

¥ = 8| [g main.c

paratieltools platform

MPI Artifact View

C/C++ - shallow/main.c - Eclipse - /Users/beth/ews/testptp
3 O Qr Qe | O

float vold_start[m];
int proc_cnt;
int tid;

MPI_Datatype * res_type;

MPI_Init(&argc, &argv); m
MPI_Comm,_size(MPI_COMM_WORLD, &proc_cnt);
MPI_Comm_rank(MPI_COMM_WORLD, &tid);

if ( proc_ent < 2 )

fprintf(stderr, "must have at least 2 processes,
MPI_Finalize(Q);
return 1;

}
if ( (n % (proc_ent - 1)) =0 )

if (( tid == 0 )
e ;

|2 Problems | | Tasks | E] Console | = Properties » MPI Artifact View 53

Artifact Filename
MPI_Init main.c
main.c
» MPI_Comm_rank main.c
¥ MPLFinalize main.c
» MPI_Finalize main.c
» MPI_Barrier main.c

= 8|0 x

_——
w53\
—_——

Y @2 CVS Reposit...  »

@m|ET|= 08
BN o %~

1 math.h

= mpi.h

Pl stdio.h

® decs.h

++ worker() : void

++ setup_res() : MPI_Datatype
@ main(int, char*(])

® setup_res() : MPI_Datatype
@ update_global_ds(MPI_Dat:
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MPI Editor Features

Cigmaines Eeeasaaemis +  Code completion will show all
float  vold_start[n]; : 1% R N the possible MPI keyword

int proc_cnt;

int tid; [ math.h completions

MPI_Datatype * res_type; = mpi.h

. Bl sudiok + Enter the start of a keyword
- worke then press <ctrl-space>

MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt); . ——
MPI_Comm_rank(MPI_COMM_WORLD, &tid); + setup_res( : MPI
MPI_B| e main(int, char*(]
I MPI_Barrier(MPI_Comm ) int + Blocks each task until all tasks have called it. |
MPI_Bcast(void*, int, MPI_Datatype, int, MPI_|

MPI_Bsend(void*, int, MPI_Datatype, int, int,

MPI_Bsend_init{void*, int, MPI_Datatype, int,

MPI_Buffer_attach( void*, int) int ‘

MPI_Buffer_detach( void®, int *) int [} main.c 53
MPI_Barrier(MPI_Comm comm) : int float vold_start[m];
MPI_Bcast(void * buffer,int count,MPI_Dataty int proc_cnt;
MPI_Bsend(void * buf,int count,MPI_Datatype .| int tid;

MP] _Bsend _init{void * buf.int count.MPI Datz * MPI_Datatype * res_type;

[

if. ()
{

e B B

-
-
~

()
(]
(]
(]
(]
} -]
(]
L]
L]
®

A

Press '~ ' to show Template Propos ./ MPI_Init(&argc, &argv);
MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);
MPI_Comm_rardk(MPI_COMM_WORLD, &tid);

* Hover Over MPI API Name:MPl_Cor:m_rank

Prototype: int MPI_Comm_rank(MPI_Comm, int *)
Description:

+ D i s p I a yS th e fu n Cti O n Returns the rank of the local task in the group associated with a;:g:?r:zl-‘:;rc?:fu:" 4
prototype and a return 1;

}

descri ption if ( (n % (proc_ent - 1)) != 0 )
{

if ( tid == 0 )
fprintf(stderr, "(number of processes - 1) must be a mu.
v

b

>
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Context Sensitive Help

Click mouse, then press help
key when the cursor is within a
function name

+ Windows: F1 key

+ Linux: ctrl-F1 key

+ MacOS X: Help key or

Help»Dynamic Help

A help view appears (Related
Topics) which shows
additional information
(You may need to click on MPI
API in editor again, to
populate)

Click on the function name to
see more information

Move the help view within your
Eclipse workbench, if you like,
by dragging its title tab

Module 4

PI_Comm_ranl
Protoype: int MPI_Comm_rank(MPI_Comm, int *)
iDescription:
Returns the rank of the local task in the group associated with a com

.

Related Topics

v About

Click below to see help.

See also:

B Editor view click here

= int MPI_Comm_raﬁP-I_Comm, int *) .
Some special

info has been
added for MPI
APIs

D Help 52

& @ e =y (=]

MPI Comm rank

~

int MPI Comm vark (MPI Comm, int *)

Retums the rank of the local
task in the group associated
with a communicator.
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MPI Templates

+Allows quick entry of common patterns in MPI programming

+ Example:
MPI send-receive
+ Enter:
mpisr <ctrl-space>
+ Expands to a send-receive
pattern
+ Highlighted variable names
can all be changed at once
+ Type mpi <ctrl-space> <ctrl-
space> to see all templates

- mpiif - MPI_Init and Finalize
-| mpisr - MPI Send Receive

Module 4

MPI_Comm_rank(MPI_COMM_WORLD, &rank);
MPI_Comm_size(MPI_COMM_WORLD, &p);
if (rank == @8){ //master task
brintf("Hello From process @: Num processes: %d\n",p);
for (source = 1; source < p; source++) {
MPI_Recv(essage] 100, MPI_CHAR, source, tag,
MPI_COMM_WORLD, &status);
printf("%s\n",message);
}
}
else{ // worker tasks
/* create message
sprintf(message, "Hello from process %d!", my_rank);
dest = 9;
/* use strlen+l so that '\@' get transmitted */
MPI_Send(message, strlen(message)+1l, MPI_CHAR,
dest, tag, MPI_COMM_WORLD);

*/

Add more templates using Eclipse preferences!
C/C++>Editor>Templates
Extend to other common patterns
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Running the Program

+ Creating a resource manager
+ Starting the resource manager
+ Creating a launch configuration
+ Launching the application

+ Viewing the application run

Module 4
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Terminology

+ The Parallel Runtime perspective is provided for
monitoring and controlling applications

+ Some terminology

+ Resource manager - Corresponds to an instance of
a resource management system (e.g. a job
scheduler). You can have multiple resource
managers connected to different machines.

+ Queue - A queue of pending jobs

+ Job - A single run of a parallel application

+ Machine - A parallel computer system

+ Node - Some form of computational resource

+ Process - An execution unit (may be multiple
threads of execution)

Module 4




paratieltools platform

Resource Managers

+ PTP uses the term “resource manager” to refer to any
subsystem that controls the resources required for launching a
parallel job.

+ Examples:

+ Job scheduler (e.g. LoadLeveler, PBS, SLURM)

+ Interactive execution (e.g. Open MPI, MPICH2, etc.)
+ Each resource manager controls one target system
+ Resource Managers can be local or remote

Module 4
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Preparing to Launch

+ Setting up a resource manager is done in the Parallel
Runtime perspective

+ Select Window>0Open Perspective>Other
4+ Choose Parallel Runtime and click OK

New Window ‘ Hg C/C++ (default)
| CVS Repository Exploring
| | %5 Debug
Show View » | &9 Team Synchronizing {4 Parallel Debug |
»
Customize Perspective... Other... ') Planning i
Save Perspective As... \ HigiRemote C/C++
EB Remote System Explorer

Reset Perspective
| | [yResource

Close Perspective &P Team Synchronizing
Close All Perspectives

Navigation

( Cancel ) OK )

Working Sets
Preferences...

Module 4




Resource
managers
view

Machines
view

Node details
view

Jobs List view

paratieltools plat

Parallel Runtime Perspective

® Eclipse File Edit Navigate Search Project Run Window Help

SO Parallel Runtime - Eclipse - /Users/beth/ews/tutorial_1021

ooo

\ FHE S > RA 22 AN & R = = F 888 parallel Runt...

—
(#) Resource Managers b1

= B | E console 2
C-Build [shallow]

v US| kb oH Cu

2| Tasks
(@) Open_MPI@abe.ncsa.uiuc.edu (Open MPI)

Console
view

make: *** No rule to make target
— - “all'. Stop.

288 Machines &3 =8
Open_MPl@abe.ncsa.uiuc.edu: abe.ncsa.uiuc.edu - Root [32]

-~ abe.ncsa.uiuc.edu

e &-=08

Di—l—i—i—l—li—ll—ll—ll—i

10

HUO OO D O D D el

20

= e
ELN

Node Attributes

Attribute Value

Name honestl.ncsa.uiuc.edu

Node Number 0

Open MPl num 1

Process Info

“lprop 82 . [20 Prob | B Rem =08
<€ B

-1

= 7

Property Value

888 Jobs List 53 = m Name honestl.ncsa.
Node Number 0

State Name Open MPI number of nodes 1

Properties
W

C/C++ Indexer: (0%)
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About PTP Icons

+ Open using legend icon in e
t00|bar (@ STARTING
(#) STARTED
STOPPING
STOPPED
SUSPENDED
ERROR

Machine Icons Node Icons

up up 2 UNKNOWN

—

2 [l DOWN || PROCESS RUNNING
ALERT

ERROR
UNKNOWN

B ERROR |ty PROCESS TERMINATED

Job Icons Process Icons
) STARTING & STARTING
2 RUNNING » RUNNING
() SUSPENDED y SUSPENDED
© COMPLETED « COMPLETED

{ Close )

Module 4
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Running Jobs Interactively

= Parallel Runtime - Eclipse

File Edit Refactor Navigate Search Run Project Window Help

Interactive resource - G 0B Q- O Y-z
managers will run the EY YR—

parallel application ' —
immediately

They are also used for
debugging the application

Right-click in Resource R
Managers view and select —
Add Resource Manager

IBM Parallel Environment
MPICH2

Choose the Open MPI s —
Resource Manager Type |

Select Next>

Module 4
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Configure the Remote Location

=5 Choose Remote Tools for
Open MPI connection configuration RemOte se I‘Vice pI‘OVider

Enter Open MPI connection information ChOOSG the remote
connection you made
previously

Tunneling Options Configure Tunneling
o Options to use SSH Port

Remote service provider: | Remote Tools

Connection name: abe.ncsa.uiuc.edu

Local address: | localhost FO rwa rd i n g
Click Next>

';) < Back Next > Finish Cancel

Module 4




Configure the Resource Manager

Open MPI tool configuration

Enter information to configure the Open MPI tool

Open MPIversion: | Auto Detect

Tool Commands

Use default commands
Launch command:
Debug command:
Discover command: | ompi info -a --parseable
Installation Location
V| Use default location<

Location:

Automatically start resource manager when Eclipse starts

Module 4

BT

+ The Open MPI resource

manager will auto detect the
version and use the
appropriate commands

+ Change only if you're an
expert

Set the location of the
“mpirun” command if it is not

in your path
Click Next>

Change the Name or
Description of the resource
manager if you wish

You can also set the resource
manager to automatically
start

Click Finish




+ Right click on new
resource manager and
select Start resource
nELET],

If everything is ok, you
should see the resource
manager change to green

If something goes wrong,
it will change to

f = Parallel Runtime - Eclipse

File Edit Refactor MNavigate Search Run Project Window Help
=4 v ‘ 010 -1#3 o G v (_(I v (/H v 0 v b~
() Resource Managers

pen_MPI@abe.ncsa.uiuc Add Resource Manager...

Remove Resource Manager
Edit Resource Manager

ooog - o

828 Machines &< Set Default Resource Manager

Please select a machine
P Start Resource Manager

Stop Resource Manager

T*‘I-?- 9 ) y 5 y
010 y)_,.v !35" ’Eé' v L&&v

( ») Resource Managers 53

.Open_MPI@abe.ncsa.uiuc.edu (Open MPI | ,.Open_MPi@abe.ncsa.uiuc.edu (Open MPI (
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-u ‘2\\

System Monitoring

= Parallel Runtime - shallow/main.c - Eclipse

Machine status shown File Edit Navigate Search Run Project Window Help
in Machines view il IERE R0 R R RN
Node status also OT=CTEl 2

shown Machines view

Hover over node to see
node name 558 Machines ©1 ae T -0 @0

@ Open_MPI@abe.ncsa.uiuc.edu (Open MPI)

Open_MPI@abe.ncsa.uiuc.edu: abe.ncsa.uiuc.edu - Root [32]

Double-click on node to T T T 111111

show attributes P TTTTTTITT

18 [ I I I
7.

_Node Attributes | Process Info
Attribute

Node Number
Open MPI number of nodes 1

< I
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Create a Launch Configuration

= Run Configurations -®

Create, manage. and run configurations

Create a configuration to launch a parallel application in Parallel Perspective

) , ‘ =l 3P Configure launch settings from this dialog:
ype filter text 7 - Press the ‘New' button to create a configuration of the selected type.

Run Configurations... )
Organize Fayorites..k

[c] C/C++ Application =| - Press the 'Duplicate’ button to copy the selected configuration.
[¥] Fortran Local Applica
@ Launch Group

5=} Parallel Application 1 - Press the 'Filter' button to configure filtering options.

+ Open the run Conflguratlon ’ - Edit or view an existing configuration by selecting it.
dialog Run>Run
Configurations...

+ Select Parallel Application

+ Select the New button

¥ - Press the 'Delete’ button to remove the selected configuration.
—2L
35

Configure launch perspective settings from the Perspectives preference page.

< m »

Filter matched 4 of 4 items

@

Depending on which flavor of Eclipse you
installed, you might have more choices in

Application types
Module 4
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Complete the Resources Tab

Enter a name for the
launch configuration,
e.g. “shallow”

In Resources tab,
select the resource
manager you want to
use to launch this job

Enter a value

in the Number of
processes field

Other fields can be used
to specify resource
manager-specific
information
+ E.g. specify
By node to allocate
each process to a
different node

Module 4

= Run Configurations

Create, manage. and run configurations

@ [Application]: Application program is not specified

»

X | B3~

type filter text

Name:  shallow|

[€] C/C++ Application

Application 9= Arguments | g Environment | Synchronize | %5 Debugger E/ Source >
Resource Manager: ’Open_MPI@abe‘ncsa.uiuc.edu

[F] Fortran Local Application
@ Launch Group
5=} Parallel Application

8= New_configuration (1)

Launch Attributes
Basic Open MPI | Advanced Open MPI

Number of processes

Options
No oversubscribe No local

V| By node By slot

Prefix:
Hosts
Host file:

Host list:

Filter matched 5 of 5 items

\1’?;
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Complete the Application Tab

Select the Application
tab

Choose the Application
program by clicking
the Browse button and
locating the executable
on the remote machine

+ There should be a
“shallow” executable in
the “shallow” directory

Select Display output
from all processes in
a console view

Click Run to run the
application

Module 4

= Run Configurations

Create. manage, and run configurations

Create a configuration to launch a parallel application in Parallel Perspective

Name: shallow
8= Resourcds | [£] Application ) 6= Arguments| Bi§ Environment | Synchronize | %35 Debugger| 2

Parallel Project:
Browse

B2 X B3~
type filter text

[T] C/C++ Application
[¥] Fortran Local Applicatio
= Launch Group
5} Parallel Application
5=} shallow

shallow
Application program:

/u/ac/etrain?/shallow/shallow

Copy executable from local filesystem

Path to the local file:

y output from all processes in a console view

Filter matched 5 of 5 items

@




+ Double-click a
node in machines
view to see which
processes ran on
the node

Hover over a
process for tooltip

popup

4+ Job status and
information

Module 4
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Viewing The Run

- =T

= Parallel Runtime - shallow/main.c - Eclipse
File Edit Navigate Search Run Project Window Help
‘ofo ﬁ;v@v?v%v Ov
(@ Resource Managers &3
@ Open_MPI@abe.ncsa.uiuc.edu (Open MPI)

EEE Machines i3 @'g o~ =) -
Open_MPI@abe.ncsa.uiu

=== abe.ncsa.uiuc.edu

u: abe.ncsa.uiuc.edu - Root [32]

0 [ I I I

9 [ I I I I
T Tl

ng?uuu

_Node Attributes Prﬁss Info
Attribute Value ¥ job0:job0.0

Name honestl.
Node Number 28
Open MPI number of nodes 1

< Ll

oog _—
298 Jobs List &3

S.. Name Status

Q jobd

Executable Name
NORMAL  shallow

Executable Path

/ufac/etrain?/shal...

ooo

[Ty 528 Parallel Runti...

El Console 2 ® s.,-ﬁ‘ #E~-r5y=0

Open_MPI@abe.ncsa.uiuc.edu:default:;job0
Cycle number 850 Model time in days 0.89
Potential energy nan Kinetic Energy
Total Energy nan Pot. Enstrophy

Cycle number S00 Model time in days 0.94
Potential energy nan Kinetic Energy

Total Energy nan Pot. Enstrophy

Cycle number 950 Model time in days 0.99
Potential energy nan Kinetic Energy
Total Energy nan Pot. Enstrophy

Cycle number 1000 Model time in days 1.04
Potential energy nan Kinetic Energy
Total Energy nan Pot. Enstrophy |=

< m

{2 Problems | ¥ Tasks fj?) Remote Enviro

Bk

= Properties &2

Property Value

Name honestl.ncsa.uiuc.edu
Node Number 28
Open MPI number of nc 1

Remote Tools DStore S...c.edu): (100%)




- | B |3

= Parallel Runtime - shallow/main.c - Eclipse
Fi

le Edit Navigate Search Run Project Window Help

Ci~ @ -0~~~ O~ i &4~ iR A CHER =R i (888 Parallel Runti... |
(@ Resource Managers &3 = B |/ & Console 52 » “_7_‘;‘ # B~y =0
(@ Open_MPI@abe.ncsa.uiuc.edu (Open MP]) pen_MPI@abe.ncsa.uiuc.edu:default:;job0

Cycle number 850 Model time in days 0.89
Potential energy nan Kinetic Energy
EEE Machines 53 @g ”1- - &~ =6 Total Energy nan Pot. Enstrophy
Open_MPI@abe.ncsa.uiuc.edu: abe.ncsa.uiuc.edu - Root [32] Cycle number 900 Model time in days 0.94
abe.ncsa.uiuc.edu a 11111111\ T Potential energy nan Kinetic Energy
T 1T 111101101 Total Energy nan Pot. Enstrophy
18
27I_IEIT“T“T“_“_“_“_I Cycle number 950 Model time in days 0.99
(] EEE i Potential energy nan Kinetic Energy
_Node Attributes Process Info Total Energy nan  Pot. Enstrophy
i ¥ job0:job0.0
Aitrbute alue ¥ ioblijo Cycle number 1000  Model time in days  1.04
Name honestl. Potential energy nan Kinetic Energy
Node Number 28 Total Energy nan Pot. Enstrophy |=
Open MPI number of nodes 1
£ L1 » <4 m »
m =5 = Properties &2 [2 Problems| ¥4 Tasks| (& RemoteEnvio] — O
a8 ISt &5
Bl @~
S.. Name Status Executable Name User An i
~
O job0  NORMAL shallow Jufac/etrain/shal... [ Mraropety Nalue -
Name honestl.ncsa.uiuc.edu =
Node Number 28
< il L Open MPI number of nc 1 S
Remote Tools DStore S...c.edu): (100%) )
IEp—— —




Using a

+ Right-click in Resource
Managers view and
select Add Resource
Manager

+ Choose the PBS
Resource Manager

Type

+ Select Next>

Module 4

Open_MPI@abe.ncsa.uiuc.edu: abe.ncsa.uiuc.edu - Ro

paratieltools platform

Job Scheduler

‘m ey A BEy RESEN & 4
(2) Resource Managers &3
@ Open_MPI@abe.ncsa.uiuc.edu (Open MPI)

888 Machines 3 =l Set Default Resource Manager

Start Resource nager

=== abe.ncsa.uiuc.edu
0 g Il Stop Resource Manager

e NO

Choose Resource Manager Type

Select the type of resource manager to use

Resource Manager Types:

Generic Remote Launch
IBM LoadLeveler

IBM Parallel Environment
MPICH2

Open MPI

SLURM

_——

-

DA

=N\
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Configure the Remote Location

BEISS) 4 Choose Remote Tools for
PBS Proxy Configuration Remote service provider

Choose the remote
Remote service provider: | Remote Tools CO n n e Ctl O n y0 U m a d e
Connection name: abe.ncsa.uiuc.edu p reV I O U S | y

[CTERE— Configure Tunneling
Tinnesing Opticns Options to use SSH Port

Enter information to connect to an PBS proxy server

None

Forwarding
Click Next>

Local address for proxy connection: | |ogalaest

Module 4
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e ‘,}\\\

Configure the Resource Manager

eyt The PBS resource manager
allows customization to
match the local site options
for the PBS installation

+ By default, all known PBS
options will be displayed

+ Templates can be used to

| customize the options for
Name Default Value Tool Tip &t . -
Account_Name Format: string eaCh InSta“atlon
Error path rormat: T hostname = + We will not change this, just
ob_Name ormat: string up to 15 . = sl
Output_PatAh Format: "[hostname:]p CIle FInISh to Complete the
Resource_List.nodes The value is one or mc CO nfl g u ratl O n

PBS Batch Script Configuration

Enter information to configure PBS Batch Script Templates

Default Template: default_template  ~

Edit Template I Delete Template

Attribute Placeholders

Resource_List.walltime 00:30:00 Format: [[hours:]minu

-
rectinatinn Farmat nnenelMecense

»

Finish Cancel
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Starting the Resource Manager

= Parallel Runtime - Eclipse

. . File Edit Refactor Navigate Search Run Project Window Help
+ Right click on new B B 0-Q-Q- O G-l
resource manager and T —— ASL
SeleCt Start resource @Open_MPI@abe.ncsa.uiuc.edu (Open MPI)
ma nager +, PBS@abe.ncsa.uiuc.edu (PRS)
Add Resource Manager...

If eveI"Ythlng |S Ok, Remove Resource Manager

you ShOUId see the 3 s 52 Edit Resource Manager [{S} .
resource manager iuc. Set Default Resource Manager |
change to green gabencss “"“"“\p Stoat Resotice Manoges

Stop Resource Manager

If something goes -
wrong, it will change

to N ¢ Yoo

e . O ) = e 2, D )
THE AL A % v MR ” A A "
() Resource Managers $3 O Resource Managers g3

*.Open_MPi@abe.ncsa.uiuc.edu (Open MPI | ». Open_MPI@abe.ncsa.uiuc.edu (Open MPI (
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System Monitoring

Machine status shown
in Machines view

Node status also
shown Machines view

Hover over node to see
node name

Double-click on node to
show attributes

Module 4
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= Parallel Runtime - Eclipse

File Edit Refactor Navigate Search Run Project Window Help
IR D R’ RdD IR o RIERUR

(¥ Resource Managers &2

@ Open_MPI@abe.ncsa.uiuc.edu (Open MPI)
@ PBS@abe.ncsa.uiuc.edu (PBS)

585 Machines i3 =X | F ~ ‘ 5~ =0

PBS@abe.ncsa.uiuc.edu: abem5.ncsa.uiuc.edu - Root [1392]

] ped Bl ) | ] ]
A D D O D O I
(Y I O 7 D
[ A 7

=== abe.ncsa.uiuc.edu

=== abem5.ncsa.uiuc.edu

_Node Attributes
Attribute Value

Name abe0636
Node_NP 8
Node_NType cluster

| Process Info

Node_Properties rl6,lomerr

< 1] »
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Create a Launch Configuration

= Run Configurations

+ Open the run configuration - . p—
. reate, manage. and run configurations
d I a Iog Ru n >- Ru n Create a configuration to launch a parallel application in Parallel Perspective
Configurations...
Configure launch settings from this dialog:

* SeIeCt Pa ra I Iel Appl Icatlon Type filter text - Press the 'New' button to create a configuration of the selected type.

* S e | eCt th e N ew ; C/C++ Application =| - Press the 'Duplicate’ button to copy the selected configuration.

[¥] Fortran Local Application ) .
b tt ¥ - Press the 'Delete’ button to remove the selected configuration.
u O n = Launch Group

5=} Parallel Application > - Press the 'Filter' button to configure filtering options.

§3 shallow . . L ) i .
- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the P tives preference page.

£ mn

Filter matched 5 of 5 items
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= Run Configurations

= &3 =

Create. manage, and run configurations

Create a configuration to launch a parallel application in Parallel Perspective

X| B3~

type filter text

Name: shallow (PBS)

5-} Resources

) Application | €= Arguments | Fi§ Environment| Synchronize| %5 Debugger| %/ Source| ™1

»

».
%

[c] C/C++ Application Resource Manager: [PBS@abe.ncsa.uiuc.edu

[F] Fortran Local Application
| @ Launch Group

5=} Parallel Application

| 83 hello

| 83 shallow

| 5=} shallow-PBS

Launch Attributes

Current Template

default_template

Optional Commands

Output_Path
Resource_List.nodes 4
Resource_List.walltime 00:30:00

destination nomss

Filter matched 7 of 7 items

‘/ MPI Command: mpirun -
Attribute Value
‘? Account_Name dvd
Error_Path
Job_Name

- rensim)

Description
Account to which to charge this job.

The final path name for the file containing the job's standard error str
The name assigned to the job by the gsub or qalter command.

The final path name for the file containing the job's standard output
Number and/or type of nodes to be reserved for exclusive use by the
Maximum amount of real time during which the job can be in the rur

v Designation of the queue to which to submit the job.

1 »

.
[ Run |[ Close y
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= Run Configurations

Create. manage, and run configurations

Create a configuration to launch a parallel application in Parallel Perspective

-,
x‘ = 5P Y Name: shallow

type filter text 5=} Resourcey [£] Application

[T] C/C++ Application Parallel Project:

[¥] Fortran Local Applicatio

,,u PP shallow

@ Launch Group

5=} Parallel Application Application program:

£ shallow /u/ac/etrain?/shallow/shallow
Copy executable from local filesystem
Path to the local file:
@ ay output from all processes in a console view

< I »

Filter matched 5 of 5 items

)= Arguments | B Environment | Synchronize| %5 Debugger| >

pod

Browse

Apply ’ [ Revert ]

Run J [ Close
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-t'ﬂ\\\

- L%

-

Job Monitoring :

= Parallel Runtime - Eclipse
File Edit Refactor Navigate Search Run Project Window Help
5~ =) -:wvov(!vu“v O~

+ Job status is @ R ares

@ Open_MPI@abe.ncsa.uiuc.edu (Open MPI)

t ra C ked h e re ; (@ PBS@abe.ncsa.uiuc.edu (PBS)
successful jobs
d i Sa p p e a r fro m PBS@abe.ncsa.uiuc.edu: abem5.ncsa.uiuc.edu - Root [1392]

] == abe.ncsa.uiuc.edu !l_] ZE2EEEEEN -
I I St === abem5.ncsa.uiuc.edu EEEEEEEEEEN
A N ) D

To cancel, select ) e e e |
job and select
Red button in s

- Node_NType cluster
J O b S LI St Node_Properties r16,lomerr

< T »

888 Jobs List 52 m = O

oao m—
gag Jobs List &2

S Name queue Rerunnable Resource List.walltin S.. Name queue Rerunnable Resource_List.walltime Priority
- (] nomss False 00:30:00 0

Module 4
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Module 5: Parallel Debugging

+ Objective
+ Learn the basics of debugging parallel programs

+ Contents
+ Launching a debug session
+ The Parallel Debug Perspective
+ Controlling sets of processes
+ Controlling individual processes
+ Parallel Breakpoints
+ Terminating processes
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Debugging an Application

Debugging requires interactive access to the application

Since PBS is for batch execution, we will use Open MPI to
provide interactive access to the machine (PBS will
support interactive execution in the future)

First switch to the Parallel Runtime perspective if not

already there
Parallel Runtime - shallow/main.c - Eclipse SDK - /Users/beth/ews/test1106_ptp404_tuto

‘ THEA A A’ S & L=+ y v lv XD (P v [ Ficlremote C/C... %8 Parallel Runt...

K:-) Resource Managers &3 = B || & console 2 w il B35 =0

(:o) Open_MPI@abe.ncsa.uiuc.edu (Open MPI) Open_MPI@abe.ncsa.uiuc.edu:default:;jobl

(_?) PBS@abe.ncsa.uiuc.edu (PBS)
s Remote@abe.ncsa.uiuc.edu (Generic Remote Launch)

588 Machines 53
Open_MPl@abe.ncsa.uiuc.edu: abe.ncsa.uiuc.edu - Root [32]

0

-~ abem5.ncsa.uiuc.edu
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Start the Resource Manager

+ If the Open_MPI Resource manager is not already
started (green icon), start it now:

+ Right-click on the resource manager and select
Start Resource Manager from the menu

ﬂ M O Parallel Runtime - Eclipse SDK - /Usérs/greg/Do

L = | lono 1\;5' o “?" 0.....' 0' s S v ==

(+) Resource Managers 3 = O | E console 3
# Remote (Generic Remote [faunch) C-Build
(@) PBS@abe.ncsa.uiuc.edu (JBS)

(F) Open_MPi@abe
__® OpenMPiga Adgl Resource Manager...

Remove Resource Manager
Edit Resource Manager

=

828 Machines 8% \_| pet Default Resource Manager | ‘{5’}' - O
PBS@abe.ncsa.uiuc.ec
528 JbemS.ncsa.uiuc.d Start Resource Manager

B Stop Resource Manager

A Y I I I

T
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e ‘}\\\

Create a Debug Configuration

Parallel Runtime - Eclipse - /

A debug configuration is
essentially the same as a run
configuration (like we used
in modules 3 & 4)

We will re-use the existing
configuration and add debug TT— & o

i nfo rm atl O n Open_MPlfabe.ncsa.uiuc.edu: abe.ncsa.uiuc.edu - Root [32]
=% abe gfcsa.uiuc.edu o [N (N I I

Use the drop-down next to o e
the debug button (bug icon) SEEEEEEEEE

instead of run button

Select Debug
Configurations--- tO Open Node Attributes Process Info

Attribute Value

the Debug Configurations Name honestl.ncsa.uiuc.edu

Node Number 0

dlalog Open MPI num 1

¢} 1 shallow (pbs)
&=} 2 shallow
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_——

-

DA

Configure the Debugger Tab

Select Debugger tab

Select the shallow
configuration

Make sure SDM is
selected in the
Debugger dropdown

Check the debugger
path is correct

+ Should be the path to
the sdm executable on
the remote system

Debugger session
address should not
need to be changed

Click on Debug to
launch the program

Module 5

e NO

Debug Configurations

Create, manage, and run configurations

Create a configuration to launch a parallel application in Parallel Debug Perspective

type filter text

[E]C/C++ Postmortem Dah
P r——
[F]Fortran Local Application
4] Java Applet

[3]Java Application

JuJUnit

Ju Junit Plug-in Test

= Launch Group

4% 0SGi Framework

5=} Parallel Application

5 hello
&} shallow (PBS)
', Remote Java Application
Filter matched 16 of 16 items

@

Name: .shallow

5=} Resources | [Z] Application |()= Arguments | B Environment |Synchronizf

Debugger: | SDM

EI Stop at main() on startup

Debugger Options
Path to debugger executable:

Ju/ac/etrain2/sdm

Debugger session address:

localhost

%5 Debugger ) &/ Source | =] Common
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The Parallel Debug Perspective (1)

+ Parallel Debug
view shows job
and processes
being debugged

Debug view shows
threads and call
stack for individual
processes

Source view
shows a current
line marker for all
processes

0o Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspace

v =1 ﬁ;va@ Q-

£ parallel Debug &2 3 . | 2R
Open_MPI@abe.ncsa.uiuc.edu: default:job0 - Root [4]

£3 job0 ”E > > P>

O~ = 3 . B =1
® 0|8 -

[ ¥ Parallel Debug 888 Parallel Runt... FiglRemote C/C...
{}+ = O | 9 Breakpoi |G Expressi |()= Variables £3 {11 Arrays | )= Variables

=

578 Signals

Name Value
@ argc 1
@ argv 7fffffffd658
@ pi 5.957805E-39
%5 Debug 52 &3 0 * ep [0 - 18]
5=} shallow [Parallel Application] Qu [0 - 18]
Process 0 @V [0 - 18]
1/ Thread [1] (Suspended) @ psi [0 - 18]

= 1 main() main.c:38 4032ca €

= 0| 5= outline &2

PR o %

math.h

+€| main.c P9
2MPI_Datatype * setup_res();

imain (argc, argv)
‘ int argc; O mpi.h
¢ char * argv[]; ™ stdio.h

{ decs.h
8 float pi=4.*(float)atan((double)l.); “+ worker() : void

float  p[n][m]; -+ setup_res() : MPI_Datatype*
222: :E:% E:% ’ main(int, char*(])

float psiln] [r,n] ; setup_res() : MPI_Datatype*
float pold[n][m];
float uold[n][m];
float  vold[n][m];
float h[n][m];

float z[n][m];

float dummyl[m];

float dummy2[n][m];
float tpi=pi+pi;

float di=tpi/(float)m;
float dj=tpi/(float)n;

/* Pressure (or free surface height) */
/* Zonal wind */

/* Meridional wind */

/* Velocity streamfunction */

B console 2
Open_MPI@abe.ncsa.uiuc.edu:default:job0

@ Memory| [2{ Problems

Open Mpi Job

update_global_ds(MPI_Datatype
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The Parallel Debug Perspective (2)

Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspace

[ ¥ Parallel Debug 888 Parallel Runt... FiglRemote C/C...

— ﬂ 99 Breakpoi |67 Expressi |()= Variables &3 &% Signals | {11 Arrays | 0= Variables

+ Breakpoints view
S h OWS b rea prI n tS g}!:;:lPl@abencsa.uruc.edu‘ def:%.;ob'o -'Roo't 4] . _ o

that have been set 2 S roasse
%5 Debug &3 B2 0 3 @p [0 - 18]

( m O re O n th I S I a te r) 8- shallow [Parallel Application] Qu [0 - 18]

Process 0 Qv [0 - 18]
pTead (1) (Suspended) @ psi [0 - 18]

Va riables Vlew = 1 main( main.c:38 4032ca
shows the current
values of variables KR =502 owime 5

2MPI_Datatype * setup_res(); BRY o ¥

for the currently D A

int argc;
char * argv[]; Al stdio.h

{ decs.h
S e I e Cte d p ro Ce S S I n 8 float pi=4.*(float)atan((double)l.); " worker() - void
& ) float p[n][m]; /* Pressure (or free surface height) */ : setup_res() : MP|_Datatype*
th D b 4 float uln][m]; /* Zonal wind */ - - iy
e e u g V I eW 1 float  v[n][m]; /* Meridional wind */ main(int, char*(})
42 float psi[n][m]; /* Velocity streamfunction */ setup_res() : MPI_Datatype*
float  pold[n][m]; update_global_ds(MPI_Datatype

Outline view (from [T
4 float h[n][m];

CDT) Of Source flat dumm;lJ[r;'];

float dummy2[n][m];

d 5 float tpi=pi+pi;
CO e 51 float  di=tpi/(float)m;

float dj=tpi/(float)n;

=2

B console 2 @ Memory| [£( Problems
Open_MPI@abe.ncsa.uiuc.edu:default:job0

Open Mpi Job




Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspa

2 C T, Q- G 1 3 A v v (=L N=L £ #R paral
The bUttonS N the eRratinbDabus { m | R R 3 & & | {z}v = O || % Breakpoi |& Expressi |()= varial

Parallel Debug View .
control groups of T

prOCGSSGS 1 | :::gv
' Mk ) & @p

CI iC k O n t h e Ste p Ove r §hallow [Parallel Application] — = = Qu

&® Process 0 (Suspended) Qv

b U tto n o Thread [1) (Suspended) @ psi
€

Observe that all process

icons change to green,
then back to yellow B manc

¢ float pi=4.*(float)atan((double)l.);

H 39 f ; /* Pressure r free surface hei ) */
Notice that the current % oot plilel; /2 Presurs Cor ace height) */
H ! float [n]1[m]; /* Meridional wind */
Ilne ma rker has moved to 42 flgzt ;s?[n;‘[m]; /* Velocii;astv*e;w?unction */

. 13 float pold[n][m];
the next source line @ float  ueldCnlind;
45 float vold[n][m];
16 float h[n][m];
float z[n][m];
float dummyl1[m];
float dummy2[n][m];
float tpi=pi+pi;
float di=tpi/(float)m;
float dj=tpi/(float)n;
int i, j, chunk_size, nxt, prv;

int master_packet[4];
float p_start[m];
float u_start[m];
float v_start[m];
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eno Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing /works

+ The buttons in the D %707 8- Q10 =S A-lE7e 0 & G0 oy Gl

¥ Parallel Debug &3 1= ] ‘ 2} & 0|8 - {=}v = O |9 Breakpoi |67 Expressi |()=Va

De b u g VieW a re U Sed Open_MPI@abe.ncsa.uviuc.edu: default:job0 - Root [4]
to control an — TR

individual process, in Ei{Zi
. pi
this case process 0 1 Debug 53 T ov

8=} shallow [Parallel Application] @u

CIiCk the Step over é@ProceSSO(Sus A~ :v»
s ead (1) (Suspended) psi

b U ttO n = 1 main() main.c:51 403309

You will now see two

current line markers,

the first shows the o maine %

float pi=4.*(float)atan((double)l.);

1+ 39 float p[n][m]; /* Pressure (or free surface height) */
position of process 0, ol s L e
1 float  v[n][m]; /* Meridionagl wind */
the Second ShOWS the ¥ float psi[n][m]; /* Velocity streamfunction */
float pold[n][m];

positions of processes |IEEETEEsvRle}
15 float  vold[n][m];
1_3 16 float  h[n][m];
47 float z[n][m];
float dummyl[m];

float dummy2[n][m];

float tpi=pi+pi;

float di=tpi/(float)m;

float dj=tpi/(float)n;

int i, j, chunk_size, nxt, prv;

int master_packet[4];
float p_start[m];
float u_start[m];
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Process Sets (1)

+ Traditional debuggers apply operations to a single
process

+ Parallel debugging operations apply to a single process
or to arbitrary collections of processes

+ A process set is a means of simultaneously referring to
one or more processes
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Process Sets (2)

+ When a parallel debug session is first started, all
processes are placed in a set, called the Root set

+ Sets are always associated with a single job
+ A job can have any number of process sets
+ A set can contain from 1 to the number of processes in
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Operations On Process Sets

+ Debug operations on the
Parallel Debug view
toolbar always apply to the
current set:

+ Resume, suspend, stop,
step into, step over, step
return

+ The current process set is
listed next to job name
along with number of
processes in the set

+ The processes in process
set are visible in right hand
part of the view

2% parallel Debug &3 B w3 G
Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root (4]
£3 job0

v i} shallow [Parallel Agblication]
v &2 Process 0
v 1 ThreagA1] (Suspended)

= 7 main() main.c:49 2cc5

Root set = all processes
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Managing Process Sets

+ The remaining icons in the toolbar of the Parallel
Debug view allow you to create, modify, and delete
process sets, and to change the current process set

Create set Remove
from set

7% parallel Debug &3 B . 2R Cha nage
Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - Root [4] g

£ job0 @5+ » current set

%% Debug 53 g v | & Delete

v E§hallow [Parallel Application] Set
v &2 Process 0
v 7 Thread [1] (Suspended)




Select the processes 5 parallel Debug & L EX:

you want in the set by g?:t;gdPl@abe.ncsa.u|uc.edu: default:job0 - Root [4]

clicking and dragging, -

in this case, the last R

three ‘[ Please enter the new set name.
C||Ck on the Create #Tshallow [Parallel Appli ke

v 5@ Process 0 (Suspend

Set button v /@ Thread [1] (Susp|

Enter a name for the 1 main() main
set, in this case
workers, and click OK

You will see the view
change to display only
the selected processes
% Parallel Debug &3 B TR & O | (¢ (&= 0

Open_MPl@abe.ncsa.uiuc.ediingdefault:job0 - workers [3]
£3 job0 A A 4

(" Cancel ) | oK )




Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspd

- v = v QD Qr Q- v |2 | v v = . £ ERPara
With the workers set B = . : = .
b@ Parallel Debug &3 1 B, & ‘ e |0 & O || ®g Breakpoi |54 Expressi |®= varia

aCtive, CIiCk the Step Ones .uiuc.edu: default:job0 - workers [3]
Over button A

You will see only the
first current line
marker move

%5 Debug 53
: shallow [Parallel Application]

Step a couple more

times

You should see two line
markers, one for the

» 5l di=tpi/(float)m;

single master process, 2 float  dj-ti/(Floatdn;

int i, j, chunk_size, nxt, prv;

and One for the 3 l int master_packet[4];
worker processes S Flomt  uoskareind:

float v_start[m];

float psi_start[m];
float pold_start[m];
float uold_start[m];
float vold_start[m];
int proc_cnt;

int tid;

MPI_Datatype * res_type;
MPI_Init(&argc, &argv);

MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);//hello
MPI_Comm_rank(MPI_COMM_WORLD, &tid);
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Process Registration

+ Process set commands apply to groups of
processes

+ For finer control and more detailed
information, a process can be registered and
isolated in the Debug view

+ Registered processes, including their stack
traces and threads, appear in the Debug view

+ Any number of processes can be registered,
and processes can be registered or
un-registered at any time




paratieltools platform

Process Registration (2)

By default, process 0 was
registered when the debug
session was launched

Registered processes are
surrounded by a box and
shown in the Debug view

The Debug view only shows
registered processes in the
current set

Since the “workers” set
doesn’t include process O, it
is no longer displayed in the
Debug view

Module 5

Parallel Debug - shallow/main.c - Eclip

§’£Parallel Debug 23 (1 = ‘ U & O g‘\ S

Open_MPl@abe.ncsa.uviuc.edu: default:job0 - Root [4]

£3 iob0 0 A 2 4

%5 Debug &3
8=} shallow [Parallel Application)
&2 Process 0
o/ Thread (1) (Suspended)
= 1 main() main.c:38 4032ca

Parallel Debug - shallow/main.c - Eclips:
010 't)."v Ov ‘:?v Ouv OV :EE t‘ ".:'v - - ‘_IL_\ v
2% parallel Debug 53 B @2 (80K 00T
Open_MPI@abe.ncsa.uiuc.edu: default:job0 - workers (3]

£3 jobo

1w v

x¥=4a

%5 Debug &3

: shallow [Parallel Application]
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Registering A Process

Parallel Debug - shallow/main.c -

+ To register a process, & %50 Q- |O- |4 iz ]S #-

double-click its process |t B W2 |80 [RA[ 0 ¢ 0@ T O)|% sreay

Open_MPl@abe.ncsatreasdu: default;job0 - workers [3]
icon in the Parallel £3 iobo
Debug view or select a
number of processes and ——
click on the registel“ & shallow [Parallel Application]
button @ process 3 (Suspended) Individual

o Thread (1) (Suspended)

= 1 main() main.c:67 403335

processes

Groups (sets)
of processes

TO un-register a proCess, [ T
double-click on the 60 float pold_start[m];

61 float uold_start[m];

process icon or select a ©2 float vold start[n];

int proc_cnt;

number of processes and |IEEENEE

MPI_Datatype * res_type;

click on the unregister VIR —

MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);//hello
bUtton MPI_Comm_rank(MPI_COMM_WORLD, &tid);

fprintf(stdout, "my rank is %d\n", tid);

if ( proc_cnt < 2 )
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Current Line Marker

+ The current line marker is used to show the
current location of suspended processes

+ In traditional programs, there is a single
current line marker (the exception to this is
multi-threaded programs)

+ In parallel programs, there is a current line
marker for every process

+ The PTP debugger shows one current line
marker for every group of processes at the
same location
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Colors And Markers

l.c| main.c 23
+ The highlight color depends on int piay
the processes suspended at
. . MPI_Init(&argc, &argv);
that ||ne . MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);
. MPI_Comm_rank(MPI_COMM_WORLD, &tid);
+ Blue: All registered process(es) T
* orange: A” unreQIStered process t fprintf(stderr, "must have at least 2 processes, not %¥d\n", proc_cnt);
(es) MPL_F‘,n;‘A.lizc();
return 1;
+ Green: Registered or unregistered

}
process with no source line (e.g.
suspended in a library routine)

Multiple processes marker

The marker depends on the
type of process stopped at that Registered process marker
location

Ed Un-registered process marker

Hover over marker for more

details about the Processes Multiple markers at this line

suspend at that location -Suspended on unregistered process: 2
-Suspended on registered process: 1

Module 5
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Breakpoints

+ Apply only to processes in the particular set that is

active in the Parallel Debug view when the breakpoint
is created

+ Breakpoints are colored depending on the active
process set and the set the breakpoint applies to:

+ Green indicates the breakpoint set is the same
as the active set.

+ indicates some processes in the breakpoint set are
also in the active set (i.e. the process sets overlap)

+ Yellow indicates the breakpoint set is different from the
active set (i.e. the process sets are disjoint)

+ When the job completes, the breakpoints are
automatically removed

else{
| print
MPI_Final
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Creating A Breakpoint

+ Select the process set that
the breakpoint should apply
to, in this case, the workers
set

Double-click on the left edge
of an editor window, at the
line on which you want to set
the breakpoint, or right click
and use the Parallel
Breakpoint» Toggle
Breakpoint context menu

+ The breakpoint is displayed
on the marker bar

Mo Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspa

S| 02 Q|02 |B [ HFl e i B parall

g@Parallel Debug &3 13 |, D ‘{iﬁ‘} {} ‘@3\ G~ & | &y = 0|9 Breakpoi |G Expressi |09= Variah
Open_MPI@abe.ncsa.uiuc.edu: default:job0 - workers [3]

£3 job0 ppu—

Name
@ argc
@ argv
@ pi
%5 Debug 2 5 OB /D = @p
53 shallow [Parallel Application] @u
&2 Process 3 (Suspended) U
o Thread [1) (Suspended) @ psi
= 1 main() main.c:38 4032ca

;¢) main.c 23
MP L_ LG FARR(MP L CUMM_WURLU, &t1aJ;

fprintf(stdout, "my rank is %d\n", tid);

if ( proc_ent < 2 )

fprintf(stderr, "must have at least 2 processes, not %d\n", proc_cnt);
MPI_Finalize();
return 1;

}

if ( (n % (proc_cnt - 1)) 1= 0 )]
{
if ( tid == 0 )
fprintf(stderr, "(number of processes - 1) must be a multiple of %d\n", n);

MPI_Finalize();
return 1;

}
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Hitting the Breakpoint

SN O Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/

Switch back to the Root set
by clicking on the Change
Set button

Click on the Resume button
in the Parallel Debug view

In this example, the three
worker processes have hit the
breakpoint, as indicated by
the yellow process icons and
the current line marker

Process O is still running as its
icon is green

Processes 1-3 are suspended
on the breakpoint

2 parallel Debug 3
Open_MPl@abe.nc

g shallow [Parallelfpplication]
&2 Process 348uspended)
o Thrglid [1) (Suspended: Breakpoint hit.)

|8 ]3O Q- O3 A+ il o

B 100 @ | XL
c.edu: default:job0 - Root [4]

By + €

Name
@ argc
@ argv
@ pi
@p
Pu
v
@ psi

=_ 1 main() main.c:80 4033c4

Thread (3] (Suspended)

1@ Thread [2] (Suspended)
Process 0
3@ Thread [1) (Running)

fprintf(stderr, "must have at least 2 processes, not %¥d\n", proc_cnt);
MPI_Finalize();
return 1;

}
if ( (n ¥ (proc_ent - 1)) 1= 0 )
{

if ( tid == 0 )
fprintf(stderr, "(number of processes - 1) must be a multiple of %¥d\n", n);

MPI_Finalize();
return 1;

}

if (tid 1= 9) {
worker();
MPI_Barrier(MPI_COMM_WORLD);
MPI_Finalize();

} else {

{}v = 8|9 Breakpoi |7 Expressi |
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More On Stepping

The Step buttons are only

enabled when all processes
in the active set are = ‘
suspended (yellow icon) &b Parallel Debug 2

Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - Root [4]

In this case, process 0 is still [y
running

Switch to the set of

suspended processes (the |

workers set) % parallel Debug 53

You Will now see the Step Open_MPI@abe.ncsa.uiuc.edu: default;job0 - workers [3)
buttons become enabled £3 job0 1 ¥ b
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Breakpoint Information

+ Hover over breakpoint icon
+ Will show the sets this breakpoint applies to

+ Select Breakpoints view
+ Will show all breakpoints in all projects

% Breakpoints £3 . S Expressions|®)= Variables

LRI EENER:
4 & main.c [line: 78] {job0:workers}
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au Q

Breakpoints View

+ Use the menu in the breakpoints view to group
breakpoints by type

+ Breakpoints sorted by breakpoint set (process
set)

9 Breakpoints £3 . & Expressions|®= Variables =08
R#-x|BES|N| e 7l

™ v & workers  Add Event Breakpoint (C/C++)...
4 & main.c [line: 78] {jobO:workers}

%% 1 Breakpoints

oo Select Default Working Set... &% 2 Breakpoint Types

oo 3 Breakpoint Working Sets
| 4 Files
# Show Qualified Names
=% 6 Projects
= 7 Resource Working Sets
| 1= 8 Advanced...

Working Sets...

o* Focus on Active Task
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Global Breakpoints

+ Apply to all processes and all jobs

+ Used for gaining control at debugger startup
+ To create a global breakpoint

+ First make sure that no jobs are selected (click in white
part of jobs view if necessary)

+ Double-click on the left edge of an editor window

+ Note that if a job is selected, the breakpoint will apply to
the current set

if (my_rank !'= 0) {
/* create message */
sprintf(message, "Greetin




Terminating A Debug Session

+ Click on the Terminate
icon in the Parallel
Debug view to
terminate all processes
in the active set

Make sure the Root set
is active if you want to
terminate all processes

You can also use the
terminate icon in the
Debug view to
terminate the currently
selected process

Module 5

eSO

O- | | B

#2 parallel Debug 53 =g | ‘ & O

Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - Root [4]

£3 job0 B+ + @

Parallel Debug - shallow/main.c - Eclip{

010 ‘v‘:?v O'?'(/u' 0' am | B A v " e
%’,{{?Parallel Debug 23 (B ) ‘ 2w & 0|8 S| o ‘(S}' = b

Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]

£3 job0 0 L 2 4

%5 Debug 53
8=} shallow [Parallel Application)
&2 Process 0 (Suspended)
o Thread (1) (Suspended)

= 1 main() main.c:50 40326

Parallel Debug - sha

{y
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Module 6: Fortran

+ Objective
+ Learn what Photran is and how it compares to CDT

+ Learn how to create a Fortran MPI application
+ Learn about refactoring support

+ Contents

+ Overview of Photran

+ Module 3 redux (in Fortran)

+ Differences between Photran and CDT

+ Pointers to online documentation for Photran
+ Refactoring support
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“Fortran - bstfit.f90 - Eciipse Piatform ™™ SIEE

File Edit Navigate Search Project Run Window Help

(& ) By O Q- F~ &~ v | ™ & 21 [@Fortran’
R Fortran Projects £2 5= Outline 2 =8

B R e

N

module Mdataset
2l - =
P ESMMFP implicit none DE v ) Mdataset

v 'g%>org.eclipse.photran-samp v ) Tdataset

<@

! Declare a Tdataset type to hold data points
b <& Binaries type :: Tdataset
( ‘i‘.src-fixed-form real i datapt(4,1000) @

- integer o
Y3 src-fortran-and-c . ¢ valsum

datapt
npts

tioXysum(3)

(3 src-includes logical :: has np(2) ¢ xysum

(4 src-language-features end type Tdataset ¥ has_np

b
b
P (f} src-gaussian-elimination ¢ valsum
b
b
v

g1 >src-line-fitting end module Mdataset v ) BstFitProj

) program BstFitProj
5 .cvsignore 1.1 (ASCI Ph t
(4 src-modules |~ O ran

0 | ' * http://www.eclipse.org/photran
@ Make Targets &2 = B [Zi Problems &2 . Console Properties e Official ECIipse Foundation prOjeCt;
) Dy (|26 errors. 0 wamings, 0 infos part of the Parallel Tools Platform (PTP)

Description

P = org.eclipse.photran-samples

b EEwhatever2 @ Derived type definition has no compone] Supports Fortran 77 90 95 and 2003

S URSEERSIEad o Byjilt on CDT; largely similar to it
@ FILE tag must be of type CHARACTER

@ lllegal preprocessor directive

* Primary contributor: UIUC
* Contrib’s from Intel, IBM, LANL, & others

6-3




File Edit Navigate Search Project

v O-

010
R Fortran Projects £2

& v
&

P ESMMFP

¥ [g>org.eclipse.photran-samp

Fortran
Editor &
Outline

¥ i3 >src-line-fitting

ge-features

3§ .cvsignore 1.1 (ASCI

P (i src-modules
(o] l

@ Make Targets 2

D % 26 errors, 0 warnings, 0 infos

P = org.eclipse.photran-samples

P =Swhatever2

= 0O |[Z! Problems £2

Description

parateltools plat
[=|[=][x]

=0

Run Window Help

Cﬁv [Fiv &8~ [f~
b3
R L R R ey |
module Mdataset
implicit none

o= Outline 2

B’ e
v iy} Mdataset
v ) Tdataset

~

=

! Declare a Tdataset type to hold data points

type :: Tdataset v
real i1 datapt(4,1000) @
integer : npts

datapt
npts

“  wvalsum

“  valsum

xysum(3)
logical :: has_np(2)
end type Tdataset @

¢ xysum

has_np
< (&P BstFitProj
“ LoadDataSet

end module Mdataset

program BstFitProj @ showDataPoints

@ squareDistances ¥/

l ) €1 T D

Console Properties ¥ =08

g
!

-+

Resource

@ Derived type definition has no components

bugl38221f[]

@ FILE tag must be of type CHARACTER bugl18974.f

@ lllegal preprocessor directive bug118961.1 |

[*]
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(7] hello.f 7

Fixed format sourc
integer :: if = 3
integer :: end = 5
character :: endif = "Hello"

ce with context-aware

if (if .gt. end) then Context-
print *, &
Rendif Aware

endif Highlighting

E:I.:
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T T e =li=]x]

File Edit Navigate Search Project Run Window Help

= ¥y QO Q- | F> &8~ [F~v | & & =ReE By @Fortran’

R Fortran Projects £2 = 8 |Ne 5= Outline 2 =8

% R W e T

D ESMMFP i ¥ () Mdataset el

¥ [z5>org.eclipse.photran hold data points v ) Tdataset
oLd date D ( S

P < Binaries < datapt
(4 src-fixed-form (4,1000) Y npts

( src-fortran-and-c — < valsum

(5 src-gaussian-elimination ¢ valsum
tioXysum(3) @

| logical :: has_np(2) Xysum

(f} src-language-features end type Tdataset ¥ has_np

b
b
P
P (3 src-includes
b
v

i3 >src-line-fitting end module Mdataset < () BstFitProj

“  LoadDataSet

program BstFitProj °

3§ .cvsignore 1.1 (ASCI ShowDataPoints

A src-modules hd @  squareDistances |/
(«] I I ) €1 T [»)

@ Make Targets 2 = B [L Problems $2 " Console Properties v =0

-+

D % 26 errors, 0 warnings, 0 infos

Description Resource

P = org.eclipse.photran-samples
P = whatever2 @ Derived type definition has no components bu9138221‘fD
@ FILE tag must be of type CHARACTER bugl18974.f
@ llegal preprocessor directive bugl18961.f[,]
[
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=l(=]x]

File Edit Navigate Search Project Run Window Help

= ¥y QO Q- | F> &8~ [F~v | & & = By @Fortran’

R Fortran Projects £2 = 0 ¥ ]

o= Outline 2 =8
R e S

B R e ¥
_module Mdataset

b ESMMFP implicit none < () Mdataset [+]

¥ [g>org.eclipse.photran-samp

P < Binaries

) v ) Tdataset
! Declare a Tdataset type to hold data points

type :: Tdataset ¥ datapt
3 src-fixed-form real i1 datapt(4,1000) »

- integer :: npts
(3 src-fortran-and-c . @

npts

valsum

valsum
xysum(3)

1 logical :: has np(2) Xysum
(4 src-language-features end type Tdataset @

(f} src-includes

has_np

b
b
P (f} src-gaussian-elimination
b
b
v

i3 >src-line-fitting aend module Mdataset BstFitProj

LoadDataSet
) program BstFitProj
p .cvsignore 1.1 (ASCI
(3 src-modules

[« | Tl |

(@ Make Targets &2 = B [Z. Problems 2 . Console Properties
D % 26 errors, 0 warnings, 0 infos

) Description
org.eclipse.photran-samples '

= -
P = whatever2 @ Derived type definition has no components

@ FILE tag must be of type CHARACTER bugl18974.f

@ lllegal preprocessor directive bugl18961.1 ]
[*]
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=101 x|

File Edit MNavigate Project Run Window Help

¥~ Q- - ” ! 75 | %5 Debug GF)Fortran >

= || e9=variables 53 _Breakpo... | Registers | Memory 2

SR L L t) <& 0| % % K v
]-3F SayHello-Photranz. 1-win32-g95 [Fortran Local Applic: « ¥ language
=-&@ Cygwin GDB Debuagger (2{15/05 11:32 AM) {(Suspe
=4 Thread [1] {Suspended)
= 3 speak_.474{) at sayhello.f90:86
= 2 MAIN_() at savhello.f90:71 |

2 Debugging
(GDB GUI)

call RANDOM HUMBER (rand)

if (rand > .7) then
language = 'Greek!'

else if (rand > .3) then
language = 'Polish'

else
language = 'Japanese'

end if
<|

& Console 52 _Tasks = ‘ AL

SayHello-Photranz, 1-win32-g95 [Fortran Local Application] Debuager Process (2[15/05 11:32 AM)
feyvgdrive/ o/ WINDOWS/ systen32/kernel32.dll

\Writable Smart Insert 86:1
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Installing Photran

http://wiki.eclipse.org/PTP/photran/documentation/photran6#Installation_Procedure

+ You will need a Fortran compiler
(e.g., gfortran), make, and gdb to Available Software

Complle & debug Fortran prog rams Check the items that you wish to install.

+ From the Help menu, choose
Install New Software...

+ Select the Helios update site

Work with: | Helios - http://download.eclipse.org/releases/helios Z] ‘/_ Add... )
Find more software by working with the "Available Software Sites” preferences.

v Photran

* Under Programming Langs W N:me Programming Languages veren

Check Fortran Dev. Tools B
+ Click Next
+ Finish installing: -

+ Next, Accept license, Finish Photran - An Eclipse-based Integrated Development Environment

+ Features and prerequisites
are downloaded and installed...

+ Restart Eclipse when prompted
Module 6

—_—

( SelectAll ) ( Deselect All ) 1 item selected

M Show only the latest versions of available software [ Hide items that are already install

v Group items by category What is al
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Using Photran

+ It’s just like using CDT...
+ Similar New Project wizards

+ Similar build procedure
+ Similar launch/debug procedure

+ ...but not exactly
+ Remote development not supported
+ Configuring fixed vs. free form file extensions
+ Different editor features
+ Different advanced features (Module 7)
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Fortran

Switch to Q/@4# Perspective

(same as for C/C++)
+ Only needed if Window T
you're not New Window

already in the . '
perspective _ Open Perspective > RSl

Show View > &Y Team Synchronizing

Customize Perspective... Other...

Save Perspective As...
Reset Perspective... ?QC."C+
Close Perspective iz CVS Reppsitory Exploring

Close All Perspectives *,‘*; Debug

> #Finc‘Bugs

?;.,Jjava (default)

&=J .

& Java Browsing
f:;:JJava Type Hierarchy
«J=Plug-in Development

+What Perspective
am in in?
See Title Bar

® 00

Navigation

@ Eclipse SDK

B [ Q@ Qe |[FlY 637 [FY [O-

6-11
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Creating a Fortran Application

(same as Creating a C/C++ Application)

Steps:

+ Create a new Fortran project
+ Edit source code

+ Save and build

& Fortran - Eclipse SDK

Edit Navigate Search Run Project Window Help
New Alt+Shift+N » | [] Fortran Project

Openﬁb... "] Project... \

5%  Source Folder

%7 Folder

" Source File
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New Fortran Project Wizard

(similar to New C/C++ Project Wizard)

e o Fortran Project

Create a new MPI project

+ Fi Ie > N ew > Fo rt ra n P roj ect Create a Fortran project of the selected type
(see prev. slide)

+ N a m e th e p roj ect :fc::i::efault location
‘ MYHel IOPrOjeCt, Choose file system: There are

+ Under Project types, under T - ;Tjjgiff;jo?“”d"
Makefile Project, select MPI %u - ‘ projects for.

H e I Io Wo r I d Fo rt ra n P rOj ect & Executable (Gnu Fortran on MacOS X)

&> Static Library (Intel(R) Fortran)

a n d h it N ext & Executable (Intel(R) Fortran) ‘ ves bUt th IS IS d

& Shared Library (Intel(R) Fortran)

. | Makefile project
- - & Executable (XLF Fortran on MacOS X) i 4
On Basic Settings v Mk project where you

@ Empty Project

page, fill in information maintain the

@ Hello World Fortran Makefile Project

for your new project " MPI Hello World Fortran Makefile Pro} Makefile

@ MPI Pi Fortran Makefile Project

(Au t h o r n a m e etc O ) 7] Show project tyPagand toolchair;s onI; if’they are supported on the platform
and hit Finish

) ( cancel ) Finish )
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Fortran Projects View

(similar to C/C++ Project Explorer view)

+ Represents user’s data

+ It is a set of user defined
Fresources Uf) Fortran Projects 53

+ Files .
+ Folders

= ‘.,,[ Binaries

+ Projects » [n) Includes

. ) ¥ [ src
+ Collections of files and » [F) MyFortranProject.fo0

folders > (= bin
+Plus meta-data

4+ Resources are visible in the
Fortran Projects View
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Editor and Outline View

(similar to C/C++)
e 00 Fortran - MyHelloProject/src/MyHelloProject.f90 - Eclipse SDK

+ Double-click on fe @SB R B |3 0 8 Qe B 6 [ 2 [EfForan
Bg Fortran Pr 88 = B || [F] MyHelloProject.fo0 53 = O || 5= outline 83 =8

source file to N P
Open FO rtran Lf;Jlt’Zliél‘o?foject use mpi <Free Form Source>

+¥ Binaries implicit none ) (anonymous)

ed Itor 2 sr integer, parameter :: LEN = 100

» [F] MyHelloProject.f90
b (= bin integer
integer
. =
integer 11 source
integer 11 dest
integer :: tag

.cproject
|=| .project
& Makefils

. . . h ter(len=LEN) :: ge ! :,f:,:
+ Outllne VIeW IS character(le 4 e ZiZizzzMPl_SlAIUS_SML) | re

integer

shown for file in ¢ )
{2 Problems 3 =l console| &, Fortran Declaration ¥ =08

editor 0 items i

Description A |Resource Location

Writable
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Build

(same as C/C++)

+ Your program should build when created.

+ To rebuild, many ways include:
+ Select project, Hit hammer icon in toolbar

+ Select project, Project » Build Project - :
. . 5 Bun PAPI Window Hel
+ Right mouse on project, Clean Project

Close Project

o Build Al Ctrl+B
A TR Dr et Build Configurations >
New Build Project
Go Into Build Working Set
Clean...
<! Build Automatically

. Project Explorer &3

b 4 Binaries
P @l Include!
b & src Open in New Window
v (= Debug = Copy

P = src
. Make Target
P % MyH( % Delete

Properties

Rename...

g2 Import...
w5 Export...

Clean Project
2 Refresh
Close Project
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Et Cetera

+ Creating a launch configuration is identical
(Suggestion: Uncheck Stop on startup at main

in the Debugger tab) pymwrm

Create. manage. and run configurations

EIEER

type Qlter text

Name: FortranOnWindows Debug

Main . (9= Arguments| B Environment | >
C/C++ Application S : -

&< clipse Application Fortran Application:

Ll Ertran Local Ap'pllcatlon Debug/notepad.exe | Search Project... l Browse... \
| £ | FortranOnWindows D _—

5] Java Applet Project:

{31 Java Application FortranOnWindows Browse... \

Ju JUnit I : -
7 JUnit Plug-in Test Build (if required) before launching
JU -

@ Launch Group Build configuration: [Delwg—'

4 0SGi Framework
Enable auto build Disable auto build

@) Use workspace settings Configure Workspace Settings.

b L I Apply Revert I

Filter matched 10 of 10 items

[ mn [ o
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Et Cetera

+ Debugging is identical
+ Launching a parallel application is identical

+ Debugging a parallel application is identical
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Diagnosing Common Problems

(also true for C/C++)

Building: Are compile errors
not shown in the Problems
view?

+ Right-click on the project
in the Fortran Projects
view, and choose
Properties

+ Expand Fortran
Build » Settings

+ Switch to the Error
Parsers tab

+ Are Photran’s error parsers
checked? If not, click
Check all

+ Click OK and re-build

Module 6

Launching: Is a binary not

listed when creating a launch

configuration?

+ Right-click on the project in
the Fortran Projects view,
and choose Properties

Expand Fortran
Build » Settings

Switch to the Binary
Parsers tab

Make sure the parser for
your platform is checked
PE = Windows
ElIf = Linux
Mach-O = Mac OS X

Click OK
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Differences (1): MPI Project Wizard

+ In the MPI Hello World C Project (local project),
the MPI compiler is set in the project settings...
(Local, managed build project: see Module 7, Advanced
Features)

+ ...but in the MPI Hello World Fortran Project,
the MPI compiler is set in a Makefile.

.PHONY: all clean

all: _sa&MyHelloProject. f90
-02 -g -0 bin/MyHelloProject \
src/MyHelloProject. f90

clean:
rm -f bin/MyHelloProject *.mod
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Differences (2): Content Assist

+ Content assist is disabled by default.
(So are Declaration View, Hover Tips, Fortran Search, &
refactorings.)
You must specifically enable it for your project.
: :
+ Right-click on the —

type filter text Analysis/Refactoring =R v

Resource
p ro_] eCt I n th e FO rt ra n AnyEdit Tools To enable Open Declaration, Find All References, the Fortran Declaration
view, content assist, and refactoring in Fortran programs, check the

PrOJ eCtS VI eW, a n d MB:L;?:{EISBUHC’ following box. A program database (index) will be updated every time

a Fortran file is created or saved.
pC/C++ General

ChOOSE PI‘O pe I‘tieS b Fortran Build ™ Enable Fortran analysis /refactoring

¥ Fortran General

Expand Fortran»

Paths and symbols |ﬂ Enable Fortran content assist (Ctrl+Space)

Iz‘ Enable Fortran Declaration view

Project References

Ana IYSiS/ Refa Cto ri ng Run/Debug Settings 'z LR
C h eC k E n a b I e Fo rtra n The following specify the paths searched for modules

and INCLUDE files during analysis and refactoring.
These MAY BE DIFFERENT from the settings used by

a n a IYSi S/ refa Cto ri n g your compiler to build your project.

Folders to be searched for modules, in order of preference:

CI iC k O K /MyHelloProject

Close and re-open any
Fortran editors

Module 6

New...

Cancel
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Differences (3): Source Form

+ Fortran files are either free form or fixed form;
some Fortran files are preprocessed (#define, #ifdef, etc.)
+ Determined by filename extension
+ Source form is set in the project properties

+ Defaults:
Fixed form: .f fix for fpp ftn 77

Free form: .fO8 .fO3 .fo5 .fo0 < unpreprocessed
.FO8 .FO3 .F95 .F90 < preprocessed

+ Many features will not work if filename extensions
are associated incorrectly

(Outline view, content assist, Fortran Search, refactorings,
Open Declaration, ...)

Module 6




paratieltools platform

Differences (3): Source Form

Set free/fixed form associations in the project properties

Properties for org.eclipse.photran-projects.collections

+ RI g ht- Cl | C k a p rOJ eCt " type filter text Source Form
1 b Resource
I n th e FO rt ra n Builders The list of Fortran filename extensions is determined
= - p C/C++ Build by the workspace-wide content type settings.
Projects view

ovs Source form/filename associations:
p Fortran Build File Name/Extension Source Form

. . vFortran General *F Fixed Form - INCLUDE lines i red
+ Click Properties

Paths and Symbols *.FO3 Free Form - C Preprocessed

m *.FO8 Free Form - C Preprocessed

+ N a V I g a te th e tree tO ;Lc:iegeizgr;c':;?gs = Fixed Form - INCLUDE lines ignored

Task Repository Free Form - C Preprocessed

Fo rtra n Ge n e ra I > = Free Form - C Preprocessed
Sou rce Fo rm *.FD vrixc-d Form - INCLUDE lines ignored

vrixed Form - INCLUDE lines ignored

+ Se | ect SO u rce fo rm :F?xed Form - INCLUDE I?nes ?gnored
! Fixed Form - INCLUDE lines ignored

fo r ea Ch fi Ie n a m e brixed Form - INCLUDE lines ignored
extension D

+ Click OK

i3 EEEEEEEEEEE

Fixed Form - INCLUDE lines ignored

( Cancel ) (8] )

=




+

+
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Differences (3): Source Form

Add new filename extensions in workspace preferences

24110 File Edit Refa
About Eclipse SDK

) O

Preferences

Preferences... 38,

v General

p» Appearance

Hide Eclipse SDK  3H
Hide Others \3¥H
Show All

Capabilities
Compare/Patch
Content Types
p Editors
Keys
» Network Connections
Perspectives
Search
P Security
p Startup and Shutdown
Web Browser
» Workspace
vAnt
v Editor
Content Assist
Formatter
Templates
Runtime
vC/C++

Add custom bk
HEREINE
extensions

Quit Eclipse SDK  #Q

Navigate the tree
to General»
Content Types

Expand Text»
Fortran Source
File

Module 6

Content Types

See 'File Associations' for associating editors with file types.
Content types:

b Binary File
Java Class File
vText
Assembly Source File
» C Source File
Fortran Source File
» JAR Manifest File
b Java Properties [

File associations:

*f (locked)

*f03 (locked)
*f08 (locked)
*f77 (locked)
*fo0 (locked)
*f95 (locked)

* fiv (larkad)

Default encoding:

Cancel
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Differences (4): Remote Support

+ Remote Fortran projects are not supported

+ Basic features will work
(editor, Outline view, etc.)

+ Advanced features should not be enabled
(content assist, search, refactoring, etc.)
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For More Information

+ Photran online documentation
linked from http://www.eclipse.org/photran

+ User’s Guide
General introduction, basic features

+ Advanced Features Guide
Features requiring analysis/refactoring to be enabled

+ Online tutorial: Compiling and running the
Parallel Ocean Program using Photran and PTP
linked from http://wiki.eclipse.org/PTP/photran/tutorials
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Refactoring

(making changes to source code that don’t affect the behavior of the program)

Roractor _ Refactoring is the research
Rename... : motivation for Photran @ Illinois

Illinois is a leader in refactoring research

ol n : ” H :
IMPLICIT NONE... Refactoring” was coined in our group
Introduce (Opdyke & Johnson, 1990)
riable ) ) .
Encapsulate V2 bl We had the first dissertation...
 ate Entity FUD =" e Opdyke, 1992
Make PnLVYatcelause o USE Stateme? (Opdy . ) | |
Add ON ONLY List- ol ...and built the first refactoring tool...
Minimizeé mes Cons!® (Roberts, Brant, & Johnson, 1997)
MMON yariable %aMMoN glock
Make SAvEVariabl = ...and first supported the C preprocessor
Move S(Unche‘ked)“' <oC (Garrido, 2005)

4 Case- Photran’s agenda: refactorings for HPC,
’ Keywof rators- 4 . .
Unify language evolution, refactoring framework

Photran 6.0: 16 refactorings
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Rename Refactoring

(also available in C/C++)

+ Changes the name of a variable, function, etc.,

including every use

(change is semantic, not textual, and can be workspace-wide)

+ Only proceeds if the new name will be legal
(aware of scoping rules, namespaces, etc.)

C/C++ - MyHelloProject/src/MyHelloP:
File Edit Source Navigate Search Proje
Rename... Shift+Alt+R

~

(Debugging)

EE Fortran Rename... \

Extract Procedure...

1= For Extract Local Variable...

+ Select Fortran Perspective
+ Open a source file

+ Click in editor view on
declaration of a variable

4+ Select menu item
Refactor» Rename

4+ Or use context menu
4+ Enter new name
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Extract Procedure Refactoring

(also available in C/C++ - “Extract Function”)

+ Moves statements into a new subroutine, replacing the
statements with a call to that subroutine

+ Local variables are passed as arguments

= Extract Procedure

Changes to be performed
4 [V] @3 Extract Procedure

[V] @5 gauselim.f90 - org.eclipse.photran-samples/src-gaussian-elimination

S vl + Sclect a sequence of statements
Original Source

Refactored Source
KEABL, INIENL (IN)

R - + Select menu item

- . . return
 Weite che matrix, o | ong subroutine vowwrs Refactor» Extract Procedure...
write (%, ¥) vet: subroutine read input (amtx, bvct,
end do -

oucine readt + Or use context menu

i real :: amtx(10,10)

| end subroutine vctwri T bvct(lo; + Enter neW na me
integer :: irow(10)
integer :: nsize
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Introduce ImpLicIT NONE Refactoring

+ Fortran does not require variable declarations
(by default, names starting with I-N are integer variables; others are reals)

+ This adds an IMPLICIT NONE statement and adds explicit
variable declarations for all implicitly declared variables

= Introduce Implicit None

-
4 V] @3 Introduce Implicit None
V] @5 gauselim.f90 - org.eclipse.photran-samples/src-gaussian-elimination

[F] gauselim.fo0

Original Source Refactored Source
program GaussianEliminati program GaussianElimiy -
-! Solve a linear system o implicit none
and Back Substitution integer :: indx
integer :: jndx
! SUBROUTINES: mtxrd,mtxw integer :: kndx
integer :: 1lndx
! Always declare ALL vari integer :: nsize
REAL :: amtx(10,10)
REAL :: bvct (10)

! Solve a linear syste
and Back Substitul _

» < (T} )

e

Changes to be performed 41 4 ‘ 2 o

+ Introduce in a single file by
opening the file and selecting
Refactor» Introduce IMPLICIT
NONE...

+ Introduce in multiple files by
selecting them in the Fortran
Projects view, right-clicking on
the selection, and choosing

Refactor» Introduce IMPLICIT
NONE...
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Module 7: Advanced Development

+ Objective

+ Become familiar with other tools that help
parallel application development

+ Contents
+ Parallel Language Development Tools: MPI, OpenMP, UPC
+Overview of UPC tools
+ Performance Tuning and other external tools:
+PTP External Tools Framework (ETFw), TAU
+Parallel Performance Wizard (PPW)
+ MPI Analysis: GEM (Graphical Explorer of MPI Programs)

Module 7
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Eclipse UPC Features

+ CDT:

+ Parser/Editor support

+ Code templates

+ IBM XLc (incl. xIUPC) - remote

+ Berkeley UPC toolchain - local (see backup slides)

+ PTP:

+ Artifact identification; Hover/dynamic help assistance
+ More Code templates

+ Remote UPC parsing and builds with xlupc

+ Parallel Performance Wizard integration with PTP

Demo

Module 7
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CDT - UPC Support

+ Filetypes of “upc” will get UPC syntax high-
lighting, content assist, etc.

+ Use Preferences to
change default for *.c  [Eyww——
if you like
(we’ll show you how)

int 1,j,1; // private variables

1=0; 1<N; 1++; &a[1][0])
=07 §<P; j4+)
a[1][3]=1*P+3+1;

alize the matrix b[][]

(Gpc_forall(p-0; j<M; je+; &6[0I(51)

7; 1<P; 144)
b[11[3]=3%2;
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UPC Content Assist, Hover Help

Z21int main(int argc, char *argv[]) {
printf("Hello, I am %d of %d.\n", MYTHREAD,

+ In Editor, type 1
upc and hit control- g
Space y
(Once) 1 @ upc_global_exit(int) : void
. . o upc_global_lock_alloc(void) : *
A list of possible upc_lock(*) : void

upc_lock_attempt(*) : int

completions is upc_lock_init(*) : void

p rOV|d ed . upc_unlock(*) : void .
C h Oose With m O u Se 6 Press "~Space’ to show Template Propos
or Cursor.

Q

upc_

® upc_affinitysize(,,) A

@ upc_all_lock_alloc(void) : * O

j

27 void my_upc_all_gather(shared void *dst,
R shared const void *src,

Hover Over size_t nbytes) {

upc_mem*oy( (shared char *)dst + MYTHREAD * THREADS * nbytes,

A PI Name: upc_memcpy
¢ Prototype: void upc_memcpy(shared void * restrict dst, shared const void * restrict src, size_t n)
33 Description:
14 doCopies n characters from a shared object having affinity with one thread to a shared object having affinity

H ype rI i n k too . with the same or another thread.

=

3 return tv.tv_sec + ((double) tv.tv_usec / 1000000);
g%
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UPC templates - using

+ In Editor, type
upc and hit control-space
(twice)

int main(int argc, char *argv[]) {
printf("Hello, I am %d of %d.\n", MYTHREAD, THREADS);
upc_
-| upc_forall - upc_forall loop int 1;
- upc_init_shared_array - Initialize a UPC shared “PCJOF_'OUQT@; 1<N; i+4; &A[L]) {
-| upc_init_shared_array_int - Initialize a UPC sha A[i]=<init valuex;

- upc_max_blocksize - UPC_MAX_BLOCKSIZE key .
upc_barrier;
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UPC templates - viewing/adding

+ Eclipse preferences: add - | _
more! Or just see OO0

type filter text Templates

W h a t ,S th e re gigiri] Create, edit or remove templates:

Appearance Name Context Description Auto Ins

O Build ™ if C/C++ if statement on
+ C/C++ > Editor > [l C R S -
Debug ™ main C/C++ main method on
Editor ™ mpiif C/C++ MPI_Init and Finalize on P
Te m Iates Content Assig mpisr C/C++ MPI Send Receive on \ Remove /
p Folding ™ namespace C/C++ namespace declaration on
Hovers ™ new C/C++ create new object on
Mark Occurre] ™ stderr C/C++ print to standard error on
Save Actions M stdout C/C++ print to standard output on
Scalability M switch C/C++ switch case statement on
Syntax Colori ™ try C/C++ try catch block on
Templates ™ upc_forall C/C++ upc_forall loop on
Typing | & |upc_init_shared C/C++ _____[Initialize a UPC shared arrayl___on |
Environm ™ upc_init_shared_:C/C++ Initialize a UPC shared array on
File Types M upc_max_blocksi C/C++ UPC_MAX_BLOCKSIZE keywc on
Indexer W usinag CiC++ using a namesnace on
Language Mappi « -
New CDT Project
Property Pages §
Task Tags int ${i};
H
HEITempIate Defaul upc_forall(${i}=0; ${i}<N; ${i}++; &S{AI[${i} D) {
p . 2.
Install/Update ${AI[${i}]=<init value>;
Parallel Tools
Remote Systems
Remote Tools
Run/Debug
Service Configuratic v

=

Preview:

) Use code formatter

~ Restore Defaults

( cancel ) ek
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Show UPC Artifacts

+ Add some UPC api’s to your sample project
+ Show UPC Artifacts

eOO C/C++ - samplesort_BUPC/src/sample_sort.upc - Eclipse - /Users/beth/ews/test0610-remoteDemo

& | o | € &S~ v @&~ &
3 v ﬁ;v@vg?j—v(l&v O b |2

@ 4y | @ 1] | £+ 51+ 9 Show MPI Artifacts
T ——— # Show OpenMP Artifacts

£5Team Synchr... ¥ Parallel Debug %35 Debug [ZlRemote C/C... 888 Parallel Runt... HE)C/C++
A <lava>

»

z L gl T| ™1 =0
7 MP| Barrier Analysis

= ck - upc.all lock allocO; AR 0 -
c =2 > Show UPC Artifacts RN o ¥
Iz >samplesort_BUPC [lexc 2

excvsl.le
¥ excvsl.le

% Show LAPI Artifacts ?) fprintf(stdout, "Samples (dist = %d):\n' upc.h 4
(= Debug ot o - upc_collective.h
[p}Y Includes stdio.h

& >src )9 upc.lockl(lock);

|} >driver.upc 1.1
|p} mt19937ar.h 1.1
|7} mt19937ar.upc 1.1

|k} >sample_sort.h 1.3

.7} >sample_sort.upc 1.2

fprintf(stdout, " %d: ", MYTHREAD);
for (i=0; i<nSamples;++i)

fprintf(stdout, "%d ", 1Samples[i]);
fprintf(stdout, "\n");
upc.unlock(lock);

stdlib.h

mt19937ar.h
sample_sort.h
bucketSize : int(]
comp(const void*, const

upc_barrier;

my_upc_all_gather(void*
if (MYTHREAD=-9) upc_lock. free(lock);

mysecond() : double
[ : [] = . = 3, v =
-‘r} UPC Artifact View &3 [Z( Problems ] console }.) Remote Environments i X 5T ]
UPC Artifact
upc_memcpy
upc_all_alloc
upc_all_lock_alloc
upc_lock

Filename LineNo
sample_sort.upc 30
sample_sort.upc 76
sample_sort.upc 94

sample_sort.upc 99

% A2 A

™

Writable Smart Insert 99:13
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Other UPC features

+ UPC parser is remote-enabled
+ Remote UPC projects can be developed efficiently

+ Remote xXIUPC toolchain enables remote build
of IBM xIUPC project

+ Managed Build (user-friendly) way to specify and
manage complex build options without makefiles
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More Advanced Features: Demos

+ ETFw - External Tools Framework and
TAU, Tuning and Analysis Utilities
+ Wyatt Spear, U. Oregon

+ PPW - Parallel Performance Wizard
+ Max Billingsley III, U. Florida

+ GEM - Graphical Explorer of MPI Programs
Dynamic Formal Verification for MPI
+ Alan Humphrey, U. Utah
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PTP/External Tools Framework

formerly “Performance Tools Framework”

—<tool name="Valgrind">
—<execute>

G oa I : <utility command="bash" group="inbin"/>

—<utility command="va group="valgrind">
—<optionpane title=" ratewith="">

A\ Y - - 1 4 4 i = ="-leak-check=full" i
+ Reduce the “eclipse plumbing Soemtion label Snam Reechai” sptname o show rosthamocy

</optionpane>

necessary to integrate tools e

+ Provide integration for
instrumentation, measurement, and |

programs from within Eclipse via the PTP.

b

analysis for a variety of performance [FEESalaEEE
tools

+ Dynamic Tool Definitions:
Workflows & Ul

+ Tools and tool workflows are @

Id C, C++ or Fortran applications with performance analysis tools. Launch parallel ‘\'J
r

ui
rograms from within Eclipse via the PTP.

specified in an XML file e

‘type filter text ‘

+ Tools are selected and configured in | [
the launch configuration window S [ a——

matmult

+ Output is generated, managed and
analyzed as specified in the
workflow

Module 7
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PTP TAU plug-ins

http://www.cs.uoregon.edu/research/tau

+ TAU (Tuning and Analysis Utilities)
+ First implementation of External Tools Framework (ETFw)

+ Eclipse plug-ins wrap TAU functions, make them available
from Eclipse

+ Compatible with Photran and CDT projects and with PTP
parallel application launching

+ Other plug-ins launch Paraprof from Eclipse too
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TAU Integration with PTP

+ TAU: Tuning and S—
A n a |ys | S U tl I Itl eS ’ Selestive insnml‘l'entation-
* TAU stub makefile selection
+ Performance data

collection and analysis L e

.
Source . ) .
* execution options

fo r H PC COd es moatfication * PAPI environment variables

* TAU compiler options

‘ * TAU environment variables

+ Numerous features

+ Command line interface T\ Sy —e el —
+ The TAU Workflow: [ e T memee e

+ Instrumentation TAU profile data —p:nr;szmliﬂ:::lj

4+ Execution

+ Analysis

slog? file — jumpshot visualization
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Parallel Performance leard (PPW)

(-5

+ Full-featured performance tool for
PGAS programming models

+ Currently supports UPC, SHMEM, and
MPI

+ Extensible to support other models

+ PGAS support by way of Global Address
Space Performance (GASP) interface
(http://gasp.hcs.ufl.edu)

+ PPW features:

+ Easy-to-use scripts for backend data
collection

+ User-friendly GUI with familiar
visualizations

+ Advanced automatic analysis support

+ More information and free
download: http://ppw.hcs.ufl.edu
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PPW Integration via ETFw

+ We implement the ETFw to make

PPW'’s capabilities available within & e
E CI | p se S . 12 % Source [A Envroment (B Common (aamATE ALATEN ™

PPW Compiler Wrapper - UPC PPW Program Run - UPC

Create, manage, and run configurations

parallel Performance Analy:

testProject

+ Compile with instrumentation,
p a ra I I e I I a u n C h W i t h P PW @ Record data for shared-local accesses.

[ Use polite synchronization

+ Generates performance data file in
workspace, PPW GUI launched

&7

55 Debugger |®= Arguments [/ Source | B Environment | Common (Performance Analysis - s

> L hG
2Lnchl o Tool Selection PPW Compiler Wrapper - UPC PPW Program Run - UPC
Parallel Performance Analysis
testProject comm-stats

+ PPW is often used for UPC

B Parallel Performance Wizard - sar_upc_v1_5_t.par,

= 5AR VL
Pqser upc_vi S t.par

+ ETFw extended to support UPC ‘ ==

application analysis

Profile Charts | Profile Table | Tr Data Transfers | Array Distribution | Analy

It

+ Many UPC features in PTP

Filter matched 4 of

n

‘
[ weraiy  wcvicis | o)
_upc_vl 1.11901

3.94463 ms

6.00112

_migration.c azimuth_compression.c

+ For more information: | |
+ http://ppw.hcs.ufl.edu

fseek(ifile, (i*mm_valid_az*par.bytes_per_line), SEEK_SET):
check = read_inputfile(ifile, p_image c, par.bytes per_line, \
par.header_bytes, a_din);

_FAILURE:}
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GEM - Graphical Explorer of
MPI Programs

+ Contributed to PTP by the University of Utah
+ Available with PTP since v3.0

+ Dynamic verification for MPI C/C++ that detects:

+ Deadlocks

+ Local assertion violations

+ MPI object leaks

+ Functionally irrelevant barriers

+ Offers rigorous coverage guarantees
+ Complete nondeterministic coverage for MPI
+ Communication / synchronization behaviors
+ Determines relevant interleavings, replaying as necessary

Module 7
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Program

+

paratieltools platform

GEM - Overview

Executable

Proc,

Interposition

Layer

MPI Runtime

C/C++ - ParMetis-3.1/Programs/ptest.c - Eclipse

File Edit Source Refactor Navigate Search Project Run Window Help

(- Project Explorer 3 =0

=

b 5 MPI_ProcNull_NoDeadLock
b S MPI_RedBlueAssert

b S MPI_RedHerring

b &5 MPI_ReduceProblem

¥ 3% MPI_ResourceleakTest

Binaries

& Debug
< MPI_TwoDeadlocks
b 4 Binaries
> ) Includes

& gem
3 MPI_TwoDeadlocks.c
Debug
v 35 ParMetis-3.1
> @) Includes

[2 05proc-ptest.isp.log
[2 07proc-ptest.isp.log
2 10proc-ptest.isp.log
[5 15proc-ptest.isp.log
[2 32proc-ptest.isp.log
bricks.hex3d
mtestisp

ptest.isp

rotorgraph

v 35> Ov @ Qv | O~
Set Number of Processes

[¢ MPI_TwoDeadlocks.c | ¢ comm-create-ng

Ty pe—r—o iew GEM Console Output
MPI_Send((void *)part, vtxdist[mype+1]-vtxdist[mype], IDX DATATYPE, ©, 1, comm);
rocessor @ does all t
idxmalloc(vtxdist[npes], "ComputeRealCut: gpart");
idxcopy (vixdist[1], part, gpart);
for (i=1; i<npes; i++)
MPI_Recv((void *)(gpart+vtxdist([i]), vtxdist[i+1]-vtxdist[i], TDX DATATYPE, i, 1, comm,

ReadMetisGraph(filename, &nvtxs, &xadj, &adjncy); u
e the cut *
; d<nvtxs; i++) {
< ievadifis1l. es)

B Console |[2 Problems | €] Error Log | GEM Console { GEM Analyzer &3

o] 6] 9] 2] mmmmmie] [ 15] 5] 3] A 6] |6 wnmemcons 6 s s

Detailed Runtime Information-
adlock in interleaving

rransitiun B—— nterleavin Step Order for MPI Calls-

Code Windows-
Rank: 0
File: MP|_TwoDeadlocks.c Line: 17
<2 Originating Call
PHNI(This test needs more than 4 proc
exitw) )
MPL_Ssend(&data, 1. MPLINT. 0.
WPI_Ssend(sdata, 1, MPLINT, 0

0, MPI_COMM_WORLD(

MP|_Comm rank(MP|_COMM_WORLD, rank)
if (rank == 0) { } else i (rank ==2) {
MPI_Recv(Sdata, 1, MPIINT, 1 0. MP1_COMM WORLD, § Yelse if (rank==3) {
P Ssend(sdata, 1, M
MPI_Recv(Sdata, 1, MPIINT, 2 0, MP1_COMM_ WORLD, § )
MPLRecv(Sdata, 1, MPIINT, 3 0. MP1_COMM WORLD, §
[z | mPpi BarriertMPI COMM WORLDY

0, MPI_COMM_WORLD(

7

Writable Smart Insert

e+

Formally Verify MPI Program =5

[ x| i Hoviewer | i srowsempicans| & o teo s 1 Browse Erors

Scheduler

i parallel % parallel D.

&= Outline & . v Tasks

% R

parmetisbin.h

main(int, char*[]) : int
TestParMetis_V3(char*, MPI_Cor:
ComputeRealCut(idxtype*, idxty|
ComputeRealCut2(idxtype*, idx!
TestMoveGraph(GraphType*, Gr:
SetUpGraph(CtriType, idxtype*

——T
® Make Target &%

5 MPI_RedBlueAssert
MPI_RedHerring
£ MPI_ReduceProblem
S MPI_Resourcel eakTest
& MPI_TwoDeadlocks
& ParMetis-3.1
b ¢ Graphs
Manual
& METISLib
@ ParMETISLib
Programs
® clean
%) defauit

Front-end for In-situ Partial Order
(ISP), Developed at U. Utah

Offers “push-button” verification
from within the Eclipse IDE

Automatically instruments and runs
user code, displaying post
verification results

Variety of views & tools to facilitate
debugging and code understanding

(Image courtesy of Steve Parker, U of Utah)
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GEM - Views & Tools

Analyzer View
Highlights Bugs, and facilitates

Post-Verification Review / Debugging

] Console |2 Problems | €] Error Log | /. GEM Console |

Transition: 14/71633
No Ranks Locked | v i¢

| & | 21

Detalled Runtlme Informatlon

v 4? HBViewer

Resource \eaks foLu d please brouse o

Code Windows

Rank: 4
File: io.c Line: 173

[ Originating Call

your_xadj[your_nvtxs] : maxnedges;

if (pe < npes-1) {

MPI_Send((void *)your_xadj, your_nvtxs+1, IDX_DATATYP

MPI_Send((void *)your_vwagt, your_nvtxs*ncon, IDX_DATA
}
else {

for (i=0; i<your_nvtxs+1; i++)

xadj[i] = your_xadj[i];
for (i=0; i<your_nvtxs*ncon; i++)

vwat[i] = your_vwat[i];

Download / documentation:

Module 7

Interleaving: 1/1
: 4 o Internal Issue Order Program Order

GEM Analyzer 223

Step Order for MPI Calls

fs- Browse MPI Calls  t:- Browse Leaks L]

Rank: 0
File: io.c Line: 187

ol Matching Calls

GKfree(&your_xadj, &your_vwat, LTERM);
}

else {
MPI_Recv((void *)xadj, nvtxs+1, IDX_DATATYPE, npes-1, 0,

MPI_Recv((void *)Jvwgt, nvtxs*ncon, IDX_DATATYPE, npes-1
}

graph->nedges = xadj[nvtxs];
adjncy = graph->adjncy = idxmalloc(xadj[nvtxs], "Parallel

adjwgt = graph->adjwgt = idxmalloc(xadj[nvtxs*nobj, "Pz

Happens-Before Viewer

Shows required orderings and
communication matches

Switch Interleavings O.sﬁ?‘f{:?é‘.‘fé?:

Showing Interleaving: 2/2 <| >| ot [ Deadiock: Yes [ Show Matches Clear| O Hide Source

Pro(esso Processl

Barrier | - .
Irecv } -
i Process0
Recv |
]
Send |

‘I

Recv. { Barrier

Barrier
Finalize

Recv

DEADLOCK

Barrier

Finalize

http://www.cs.utah.edu/fv/GEM
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Using GEM - ISP Installation

+ ISP itself must be installed prior to using GEM

+Download ISP at
4+ Make sure libtool, automake and autoconf are installed.

+ Just untar isp-0.2.0.tar.gz into a tmp directory and:
+ Execute the following commands from tmp directory
+ ./configure
+ make

+ make install

+ Do this with root privelage, sudo, etc. Puts binaries and
necessary scripts in /usr/local/bin, /usr/local/lib, etc
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Using GEM

+ Create an MPI C Project within C/C++ Perspective
+ Make sure your project builds correctly

+ Set preferences via GEM Preference Page

+ From the trident icon or context

Enable FIB

3
b ++
menus user can. R
- > He [J Enable OpenMP
b Insta ate

Use Blocking sends
[ Report Progress

"/ Set Number of Processes b Javascript O Verbose Mode
v Parallel Tools

i View GEM Console Output - , [

b Parallel Languag: 5
b Resource Manag Report Progress Every (n) MPI Calls: |4]

- - Viewer [ Clear GEM Console on Each Run
+ Formally Verifying MPI Program
b Remote Tools GEM Paths
> Run/Debu isp executable: |/usr/local/bin Browse...

3
+ La u n C h e S I S P . ispcc script:  [/usr/local/bin Browse...
b Specfile Editor ispCC script:  |/usr/local/bin Browse...

+ Generates log file for post- SOl [ —

verification analysis views
+ Opens relevant GEM views
Module 7
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GEM Analyzer View

+ Reports program errors, and runtime statistics

+ Debug-style source code stepping of interleavings
+ Point-to-point / Collective Operation matches
+ Internal Issue Order / Program Order views
+ Rank Lock feature - focus in on a particular process

+ One click to visit the Eclipse editor, to examine:

@] Error Log | (. GEM Console | s GEM Analyzer 2

+ Calls involved in deadlock e

Step Order for MPI Calls
I ¢ | No Ranks Locked

+ Helps find root-cause

+ MPI Object Leaks sites
+ Locates allocated object

+ Local Assertion Violations
+ Takes user to failing assertion
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GEM -

Extensive how-to sections, graphical aids and

paratieltools platform

Help Plugin

trouble shooting section

Search:

Contents
Workbench User Guide
C/C++ Development User Guide
Eclipse Marketplace User Guide
Mylyn WikiText User Guide

Parallel Tools Platform (PTP) User Guide

B Contents

B overview

B PTP Prerequisites

[ Creating an MPI Project

[ Resource Managers

B Launching Parallel Programs

5 Monitoring Parallel Machines and Jobs

Parallel Debugging

Parallel Language Development Tools (P!

@
[0 External Tools Framework (ETFw)
@

Graphical Explorer of MPI Programs (GEM)

5 Overview
5 GEM Plug-in Prerequisites
2 GEM Plug-in Preferences

5 Understanding GEM Console Output

5 Console View
& Analyzer View
5 Happens Before Viewer
5 Makefile Support
2 Troubleshooting the GEM Plug-in
B PTP Preferences
5 New and Noteworthy
Tasks User Guide
Usage Data Collector

Help - Eclipse

Scope: All topics

Parallel Tools Platform (PTP) User Guide >

‘|' PTP: Graphical Explorer of MPI Programs (GEM)

Release 1.5.0

The Graphical Explorer of MPI Programs (GEM) Eclipse plug-in, part of the Parallel Tools Platform
(PTP), is a graphical front end for In-situ Partial Order (ISP), a dynamic formal verification tool for MPI
C/C++ programs, developed at the University of Utah. GEM greatly enhances the usability of ISP by
providing an intuitive graphical way to track down bugs in MPI C/C++ programs, examine
post-runtime results and to analyze MPI runtime behavior.

GEM can be used by anyone who can write simple MPI C/C++ programs, and requires no special
training. GEM allows you to formally verify your MPI C/C++ programs automatically without any extra
efforts on your part (apart from compiling and making your examples) and flags the following errors:

® Deadlocks
® Assertion violations
® Object leaks

In addition, GEM helps you understand as well as step through all relevant process interieavings
(schedules). Notice our use of the word relevant: even a short MPI program may have too many (an
"exponential number") of interleavings. For example, an MPI program with five processes, each
containing five MPI calls, can have well in excess of 1000 interleavings. However, ISP generates a
new interleaving only when it represents a truly new (as yet unexamined) behavior of your programs.

Overview, Background, and Setup information
1. e
2. GEM Plug-in Prerequisites

Help Topics
1. GEM Plug-in Preferences
. Understanding GEM Console Output

2
3
4.
5.
6.
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GEM/ISP Success Stories

+ Umpire Tests
+ http://www.cs.utah.edu/fv/ISP-Tests
+ Documents bugs missed by tests, caught by ISP

+ MADRE (EuroPVM/MPI 2007)

+ Previously documented deadlock detected

+ N-Body Simulation Code

+ Previously unknown resource leak caught during
EuroPVM/MPI 2009 tutorial !

+ Large Case Studies

+ ParMETIS, MPI-BLAST, IRS (Sequoia Benchmark), and a few
SPEC-MPI benchmarks could be handled

+ Full Tutorial including LiveDVD ISO available
+ Visit http://www.cs.utah.edu/fv/GEM
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GEM Future Plans

-
‘ I a b b e d b ro W S I I l g fo r e a C I l |c] comm-create-no-free.c &3 . |[c| red_blue_assert.c <] MPI_MatrixMultiply-4.c [¢) MPI_TwoDeadlocks.c =0

4l

33 printf("(%d) is alive on %s\n", rank, processor_name);

type of error

+ Each error mapped to
offending line of source code
in Eclipse editor

] Console |2 Problems | €] Error Log | (. GEM Console | |; GEM Analyzer|; GEM Error Browser %

+ Adding more error and e
property checks, e.qg. —
+ MPI send/recv type mismatch
+ Insufficient recv buffer
+ MPI argument mismatch
+ List unfreed requests at finalize
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GEM Future Plans

+ GEM will serve as a front-end for other tools

+ Integration of Distributed Analyzer of MPI Programs
(DAMPI), developed at University of Utah
+ ISP scales to 10s of processes
+ DAMPI scales to 1000s of processes (C/C++/Fortran)
+ Decentralized scheduler uses Lamport Clocks
g% Set Number of Processes
I» Formally Verify MPI Program: ISP

“* Formally Verify MPI Program: DAMPI
. View GEM Console Output

Use ISP at small scale,

then launch DAMPI at
scale on a cluster
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PTP Adv. Development: Summary

+ A diversity of other tools aid parallel development

+ Parallel Language Development Tools:
MPI, OpenMP, UPC, LAPI, etc.

+ External Tools Framework (ETFw) eases integration of
existing (command-line, etc.) tools

+TAU Performance Tuning uses ETFw
+PPW (Parallel Perf. Wizard) uses ETFw for UPC analysis
+Feedback view maps tool findings with source code

+ MPI Analysis: GEM

+ A diversity of contributors too!
+ We welcome other contributions. Let us help!
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Backup

+Not covered in today’s tutorial,

but included for reference

+ Creating a local MPI project, and using the wizards
+ MPI Assistance tools
+ MPI Barrier analysis on a local project

+ OpenMP tools
+ UPC tools installation and local projects

+ External Tools Framework (ETFw) details, overview
of integrating other tools into PTP

+ ETFw Feedback view incl. sample exercise
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&ty Parallel Lang. Dev. Tools

+ PLDT Features

+ Analysis of C and C++ code to determine the
location of MPI, OpenMP, and UPC Artifacts

+ Content assist via ctrl+space ("completion™)

+ Hover help

+ Reference information about the API calls via Dynamic
Help

+ New project wizard automatically configures managed
build projects for MPI & OpenMP

+ OpenMP problems view of common errors

+ OpenMP “show #pragma region”, “show concurrency”

+ MPI Barrier analysis - detects potential deadlocks

Some MPI features were covered in Module 4
Note: Some PLDT features don’t work on remote (RDT) projects
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MPI Assistance Tools

Added by PLDT (Parallel Lang. Dev. Tools)
feature of PTP

+ MPI Context sensitive help
+ MPI artifact locations

+ MPI barrier analysis

+ MPI templates

+ For this part, we will use the /local MPI New
Project Wizard and the "MPI Hello World”
project
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Creating Local Project

+ The next slide shows you how to create a local
MPI project.

+ If you do not have MPI on your local machine,
you can't build or run.

+ But you should be able to demonstrate the MPI
features in PTP’s PLDT regardless.

+ Several PLDT MPI features pertain to developing
code - just using the local editor, etc.

+ Most PLDT features do work on remote projects.
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Create local MPI Project

Using a Managed

C Project

Build Project - for a
quick sample /ocal
MPI prOJeCt M Use default location

+ F = I N C Location: /Users/beth/ews/testptp/HelloMP
I e > ew > Choose file system: = default

-
P rOJ eCt Project type: Toolchains:
¥ (= Executable A MacOSX GCC

1 . E Proj XLC/C Tool Chai
+ Give Project a m S

@ MPI Hello World C Project

name, e.g. @ MPI Pi C Project

@ MPI Pi C++ Project

H e | I O M PI @ MPI Empty C Project
@ OpenMP Hello World C Proji
@ OpenMP Empty C Project

+ Confirm Toolchain Gy

+ Select MPI Hello
World C Project
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Set MPI Preferences

+ When creating a local

MPI project with the
Wiza rd’ you need to Set Jusr/local fopenmpi-1.3.3/include
MPI Preferences (once)

+ This assures the include
paths, etc. will be set P
for new MPI projects -
fOr bUlI dln g’ an d fOr # Prompt to include MPI APIs found in other locations (C only)?
Eclipse assistance
features for MPI.
Select Yes to set the MPI

references.
P Note: if you do not have MPI on your local

machine, you can use just an MPI header
No file (mpi.h) so you play with the PTP MPI
MPI? / development features without building or
running on your local machine.

Module 7 7-31




paratieltools platform

Set MPI Preferences (2) =

SO Preferences

On the MPI mpi o | MPI =L
P refe re n Ce S p a g e J a d d Parallel Tools @ Recognize MPI Artifacts by prefix (MPI_) alone?

Parallel Language C

a n eW M PI i n CI u d e " r;’A:slri/nl:c:u.::‘/3ol::::::rsr';pi—1.4‘2,finclude
path.

New ... and point to
the directory
containing your MPI

h ea d e r fi | e ( m pi . h ) MPI build command (C):  mpicc

MPI build command (C++):  mpic++

Se I ect 0 K @ Prompt to include MPI APIs found in other locations (C only)?

Back on New Project )0 s e
Wizard page, select [ »

Next> and fill in
Author name, etc.

( cancel ) ¢ oK )
———lul ) € y,
Author |

Copyright notice 7Your copyright notice

Hello world greeting  Hello MPI World
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-u ‘2\\

Review MPI Project Settings

On the next wizard page,

review the MPI project P! Project settings

settings based on the Sl e M e a1,y st an bl
i nfo rm atl 0 n yo u h ave :::;; MPI project settings to this project

p rOV i d ed . é‘ Use default information

Make changes if you wish. .,

The defaL”tS ShOUld be fine- Library search path: sr/loca

Click Finish. T

You will be prompted to

switch perspectives

n i Perspective? —~ - _ _ .
Open Associated p @ ) ( cancel ) € Finish )

This kind of project is associated with the C/C++ perspective. Do you want to
open this perspective now?

C Project

("] Remember my decision
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Create MPI Project =

C Project

Re Ca p : CCF::J;eecctproject of selected type
File > New > C Project

Give PrOjeCt a name’ e'g " M Use default location
Hel IOM PI Location: /Users/beth/ews/testptp/HelloMP

Se | ect TOO | Ch a i n Choose file system: = default

Project type: Toolchains:

Select MPI Hello World C v G Erecutable 1
P rOj eCt ® Hel‘laoyWorIJd ANSI C Project

. i} i @ MPI H}ello WQrId C Project
Set MPI Prefs, if first time e
@ MPI Empty C Project

C I i C k Fi n i S h @ OpenMP Hello World C Proje

@ OpenMP Empty C Project
P (= Executable (XL UPC)
<4

Note: if it doesn[t build On MShowprojecttypesandtoolchainsonlyiftheyaresupportedonthe platform ,
your machine, you can still
continue with this exercise

Project name: HelloMPI
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Project Properties:
Managed Build Project

+ Right-click on project in Project Explorer
view and select Properties

+ Project Properties for Managed Build project

+ Compiler, Linker, etc. settings set automatically
without a Makefile

Properties for HelloMPI

type filter text Settings
Resource

Builders -
C/C++ Build Configuration: Debug [ Active | anage Configuration

Build Variables e

Discovery Options

Environment

Logging (553 Tool Settings -Build Steps Build Artifact Binary Parsers 9 Error Parsers

Settings e A e e Ry

Tool Chain Editor
C/C++ General
Project References
Run/Debug Settings
Service Configurations fiscellaneous
Task Repository 3Shared Library Settings
WikiText GCC Assembler

MacOS X C Linker Command: mpicc

eneral All options: ~l/usr/localfopenmpi-1.4.2/include -00 -g3 -Wall -c -fmessage-length=0
ibraries

2 General

Va;
v 5% GCC C Compiler Expert settings:

ﬁ:;";:;"e‘fn $S{COMMANDY} S{FLAGS} S{OUTPUT_FLAGIS{OUTPUT_PREFIX}S{OUTPUT} S{INPUTS}

3 Miscellaneous

Module 7 (Gancei )




Show MPI Artifacts LT

Select source file in Project Explorer; B> Show OpenP Artifacts
Select Show MPI Artifacts WAL WP Barrer Analysis

I n P LDT m e n u ‘L' C/C++ - MyMPIproject/src/MyMPIprg'ect.c - Eclipse SDK

File Edit Refactor Navigate Search Project Run Window Help

Cie & & | @ | €& 68v [y G | Ry By |y O Qv (O | ™ 5

dL A 2 o o
v RARTER AR SARERE S8 ¢

L Project Explorer &2 =8 MyMPlproject.c &3

Markers indicate the - A

. O 0 int dest = 0; rank of
location of artifacts in 7 My e oo, /e e e
b 3 Binaries MPI_Status status ; return status

editor P [mY Includes

<! c n MP
v Esrc start up MPI

In MPI Artifact View - TR

sort by any column

sl ((MPT_COMM_WORLD, &my_rank);

(click on col. heading)

MPT Comm Slze(MPI COMM WORLD &num_procs)

Navigate to source code

. . - [
|Ine by dOUbIe_C“Cklng v Tasks | El Console | (2. Problem ml

o= Outli 2
= mpi.h
 stdio.h
= string.h
@ calc_pi(int, int)

@ main(int, char'[

i X P

on the artifact Tineve

| Construct

¥ MPI_Bcast MyMPIprOJectc 22

Run the analysis on e s 7
another file and its »

» MPI_Comm_size MyMPlproject.c 63

markers will be added to P MPLSend

¥ MPI_Recv MyMPlproject.c

th e VieW » MPI_Bcast MyMPlproject.c
. ¥ MPI_Finalize MyMPIproject.c
Remove markers via

Wiritable Smart Insert 60: 18

Module 7
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MPI Barrier AnaIyS|s

= C/C++ - MyBarrier/src/MyBarrier.c - Eclipse SDK - C:\ews\runtime-cdt40

paratieltools plat

File Edit Refactor Source Statistics Navigate Search Project Run Window Help
010 c~ &Y~ SRMLC A ﬁv@v(}u-

= 8|/ [ matrixio.c &) MyBarrier.c &2

L Project Explorer &2 l.€| zzzzTemplateTest.c

= <& if (my_rank !=0)({

= g_—'f MyBarrier
#-[a)Y Indudes
=3 src
+ Déj MyBarrier.c
+- (= Debug
3 Uc MyCproject
# x5 MySampleProject

sprintf (message,
dest = 0;

"Greetings from process

I-IPZ_Ser.d(rressage strlen (rressace]
dest, tag, MPI_COMM WORLD):
MPI Barrier (MPI_COMM WORLD):
}
else{
printf ("From process 0:
for (source = 1; source < p; source++) {
MPI_Recv(message, 100, MPI_CHAR,
MPI_COMM WORLD, &status):;
printf ("$s\n",message);
}
MPI Barrier (MPI COMM WORLD) ;
Barrier():

/7, MP1 Barriers % N

< >
=0

Function [2. Problems | v Tasks | & Console | /i Barrier Matches 2

=0

Num processes: d\n'

source,

Ov

B | c/c++
L Resource

5= outline 52

AN

H stdio.h

™ string.h

™ mpi.h

@ Barrier() : void

@ main(int, char*[]) : int

v

/4 Barrier Errors &%

i ¥ Barrier Matching Set

LineNo |
MyBarrier.c 8
MyBarrier.c 8
MyBarrier.c 41
MyBarrier.c 31
MyBarrier.c 31
MyBarrier.c 41
MyBarrier.c 8
MyBarrier.c 41
MyBarrier.c 57
MyBarrier.c 62

Barrier Matching Set Function Filename
=W Barrier 1(2)
Wi Barrier 1
77 Barrier 3
=W Barrier 2 (1) main
/i Barrier 2 main
=W Barrier 3 (2) main
i Barrier 1 Barrier
i Barrier 3 main
/4 Barrier 4 (0) main
+- W Barrier 5 (1) main

PRIIR

Barrier
Barrier

Barrier

=" Error
+- W Path 1 (1 barrier(s))

7 path 2 (0 barrier(s))

=" Error
+- " Loop (dynamic number of barriers)

“E‘MakeTargets =0

B RN e

i v =5

Function

main

Module 7

Local
files only

Verify barrier
synchronization in C/
MPI programs

Interprocedural static
analysis outputs:

+For verified programs,
lists barrier statements
that synchronize
together (match)

+ For synchronization
errors, reports counter
example that illustrates
and explains the error
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e ‘}\\\

MPI Barrier Analysis — Try it

Add some barriers:

+ Inside the sample if
(rank...) add a barrier:

+ Use Content Assist to . if (my.rank 1=0){ y
help you type /* create message */

sprintf(message, "Hello MPI World from

+ Type: MPI_ and press dest = 0;
Ctrl_space. See /* use strlen+l so that '\@' get transn
. - MPI_Send(message, strlen(message)+1, MHA
completion alternatives. dest. taa. MPL.COMM WORLDY:
Keep typing until you see MPI_B o€

MPI_Barrier and hit enter. else{ y © MPI_Barrier(MPI_Comm ) int

. rintf e MPI_Barrier(MPI_ Comm comm) : int
For args, start typing for (a o P -
MPI_Comm__ etc. and it wp ¥ VPLBAND
will also complete
MPI_COMM_WORLD
Add the same barrier

statement at the end of Resulting statement
the else as well.

.c| *HelloMPl.c &3

MPI_Barrier(MPI_COMM _WORLD);|

Module 7




parateltools plat

MPI Barrier Analysis — Try it (2)

Run the Analysis:

+ In the Project Explorer,
Select the source file (or :
directory, or project) of €| HelloMPl.c 33
file(s) to analyze
if (my_rank !'=80){
Ly Project Explorer 52 /* create message */
v S HelloMPI sprintf(message, "Hello MPI World from prog
b 3 Binaries dest = 0;
» [}l Includes /* use strlen+l so that '"\@' get transmitt
v (B src MPI_Send(message, strlen(message)+1l, MPI_C
dest, tag, MPI_COMM_WORLD);

b |.c| HelloMPIl.c
P (= Debug MPI _Barrier(MPI_COMM_WORLD);

Pf:;‘_“:,':»shallow [cvs.ncsa.uiuc. }
else{
printf("Hello MPI World From process @: Nu

for (source = 1; source < p; source++) {

4+ Select the MPI Barrier v TR
. . . _Kecv(message, ’ - y Sourceg
Analysis action in the MPI_COMM_WORLD, &status):

QDEQ & printf("%s\n" ,message);
7 P }

W Show MP Artifacts V7 MPI Barrier(MPI_COMM_WORLD);

» Show OpenMP Artifacts

£/ MPI Barrier Analysis
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_—

MPI Barrier Analysis - V|ews

/i MP1 Barriers 2% = O ||[2. Problems | v:| Tasks | &l Console | " Barrier Matches 2 = O || %4 Barrier Errors 3 =0

i © i || Barrier Matching Set Function
=" Error main
+-W Path 1 (1 barrier(s))
i Path 2 (0 barrier(s))
=W Error main
+-" Loop (dynamic number of barriers)

Functon Barrier Matching Set Function Filename LineNo |#
"mam SN - Barrier 1 )] Barrier MyBarrier.c
main i Barrier 1 Barrier MyBarrier.c 8

main /i Barrier 3 main MyBarrier.c 41

main =)W Barrier 2 (1) main MyBarrier.c 31

main /i Barrier 2 main MyBarrier.c 31

Barrier = Barrier 3 (2) main MyBarrier.c 41
7 Barrier 1 Barrier MyBarrier.c

/i Barrier 3 main MyBarrier.c 41

¥4 Barrier 4 (0) main MyBarrier.c 57

+- W Barrier 5 (1) main MyBarrier.c 62

MPI Barriers view Barrier Matches view Barrier Errors view
Groups barriers that

match together in a If there are errors, a
Like MPI Artifacts view, parrier set — all counter-example

double-click to navigate processes must go shows paths with
to source code line (all  through a barrier in the ~ MiSMatched number
3 views) set to prevent a of barriers

deadlock

Simply lists the barriers
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MPI Templates

Allows quick entry of

common patterns in MPI

programming

Example. MPI Send_ MPI_Comm_rank(MPI_COMM_WORLD, &rank);

. MPI_Comm_size(MPI_COMM_WORLD, &p);
recejve if (rank == @){ //master task
brintf("Hcllo From process @: Num processes: %d\n",p);
Enter: mplsr <Ctr|_ for (source = 1; source < p; source++) {

MPI_Recv(message], 100, MPI_CHAR, source, tag,
space> MPI_COMM_WORLD, &status);

printf("%s\n",message);
Expands to the code , !

ShOWﬂ at rlght else{ // worker tasks
/* create message */

nghllghted Varlable sprintf(message, "Hello from process %d!", my_rank);

dest = 9;

names Can a” be /* use strlen+l so that '\@' get transmitted */
Changed at once MPI_Send(message, strlen(message)+1, MPI_CHAR,

dest, tag, MPI_COMM_WORLD);
Type mpi <ctrl-space>
<ctrl-space> to see all
templates

mpi

+Eclipse preferences: add more!

e e o +C/C++ > Editor > Templates
| mpisr - MPI Send Receive +Extend to other common patterns
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OpenMP Managed Build ;.5
Per ect files only

. . Wt C Project
+ This will need OpenMP C Project
preferences (e.g. include file
location) set up as well

+ Create a new OpenMP project B e defatfoction
+ File» New »C Project [T
+ Name the prOjeCt e.g. Project type: Toolchains:

(= Executable Cygwin GCC

\ Myo pen M PprOJeCt, @ Empty Project Linux Berkeley UPC
@ Hello World ANSI C Project Linux GCC
+ Se I ect TOO | C h a i n @ MPI Hello World C Project MacOSX Berkeley UPC
® MPI Pi C Project
@ MPI Pi C++ Project MinGW GCC

+ Select openM P Hello @ MPI Empty C Project Solaris GCC

@ OpenMP Hello World C Project

wOrId C Project @ OpenMP Empty C Project

@ Hello World UPC Project
(#=Shared Library

4+ Select NEXt, then fill in (= Static Library

(= Makefile project
Oth er i nfo I i ke M PI p roject (> Remote Makefile Project

(] Show project types and toolchains only if they are supported on the platform

_ Next> ) ( cancel ) (€ Finish )
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Setting OpenMP Special
Build Options

= Properties for MyOpenMPproject

+ OpenMP typically requires [FE== settings
special compiler options. R o=t
+ Open the project
properties
+ Expand C/C++ Build

&) Tool settings * Build steps Build artifact | a9 Binary parsers | €3

Other flags | -c -fmessage-length=
[Jverbose (+v)

iler
[]support ANSI programs (-ansi)

+ Select Settings
+ Select C Compiler

+In Miscellaneous,
add option(s).
-fopenmp
+ Click OK; Project should
attempt to build
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¥ Show MPI Artifacts

¥ Show OpenMP Artifacts
#7) MPI Barrier Analysis

0 JDE J A >

= C/C++ - MyOpenMPproject/src/MyOpenMPproject.c - Eclipse SDK - C:\ews\runtime-temp

l=Jojes

File Edit Refactor Navigate Search Project Run Window Help
Ci~ &l 010 R N g R C I :;)‘}'O'(’u' 0'
» i ®s 74 B e

= O || [g) *MyopenMPproject.c £2
= double *x, *y; =

L5 Project Explorer &3

- SR
=

=125 MyMPIproject
#-[m}} Indudes

-G8 1 MP 2
. ’ if (omp in parallel()){
+-(= Debug ot ST I S A e

= g:;:L MyOpenMPproject .
#-[m}} Indudes ! .

printf ("true”);

=2 src
+- .| MyOpenMPproject.c
+-(= Debug

( arraySize ¥
( arraySize ¥*

F %5 Debug |G cjc++ |8 Java

= B lou » =0
7Bl mw e
S stdio.h
™ string.h
o stdib.h
= math.h
= openmp.h
@ main(int, char

sizeof (do
sizeof (do

* Here's the O that he for-1lo =
’ fpragma omp parallel for
for (1 = 0; i < arraySize; i++ )
{ o
v[i] = sin( exp( cos( - exp( sin(x[i]) ) )z
}
return 0;
¥ v
< > < >
(2 Problems | 77| Tasks =] Consoladtnshusdaudpumiinmrasiel | B OpenP Artifact View 3 =0
5" :ﬁy >
OpenMP Artifact Filename LineNo Co
'{)’i omp_in_parallel MyOpenMPproject.c 26 Fur
#pragma omp parallel for MyOpenMPproject.c 34 Opt
< >
VA WA
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Show Pragma Region

Run OpenMP

analysis Bevraoma op parasier cor
R|ght CIle On fo:‘ (i=0; i < arraySize; i++ )
pragma in }
artifact view e

<

v[i] = sin( exp( cos( - exp( sin(x[1]) ) ) ) )’

|2 Problems | v Tasks | E] Console | %f Debug | ‘@ OpenMP Problems | §9» OpenMP Artifact View £33

S e | e Ct S h ow OpenMP Artifact Filename LineNo
p ra g ma I‘eg ion omp_in_parallel MyOpenMPproject.c 2%

T T pject.c 34
Show pragma region

See highlighted region in C editor
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UPC
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UPC Features Installation

+ If you installed PTP PLDT UPC feature, you should
have CDT UPC feature too e

[?j 100 Parallel Tools Platform
4" PTP Parallel Language Development Tools UPC Support

+ See Also:

+ You can also install UPC features from the CDT-specific update site
+ Enable it in update manager
+ Help, Install New Software, Click available Software Sites link
+ Check the CDT site:

+ Click OK to return to Install dialog
+ In Work with: select the CDT site you enabled =~ BUPC toolchain
+ Check UPC features Sy @ LB Sl

+ Finish install Name .
a n d reSta rt JUJ CDT Optional Features

«J*= Unified Parallel C Berkeley UPC Toolchain Support
«J*Unified Parallel C Support
«J*Unified Parallel C Support SDK
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UPC syntax in .c files

|| hello.c g, main.c &, helloMPI.c

) #include <upc.h>

+ UPC syntax is y
recognized by the [E R,
parser in *.upc s
files

+ Copy helloUPC.upc

return 0;

}

) #include <upc.h>

1

Z1int main(int argc, char *argv[]) {

printf("Hello, I am %d of %d.\n" X\ MYTHREAD, THREADS);
return 0;

to hello.c to see
the difference

}

/ [ vz the matrix a[][] KeYWOI’dS as
et SICIVE el as new
1=0; 3<P; j++)
a[i][§]=1*P+j+1; SyntaX are

recognized
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UPC syntax in .c files (2)

+ To enable UPC syntax in *.c files, we will
change the language mappings

+ Preferences, C/C++, Language Mappings
+ Click the Add... button to add a Language

S NO Preferences

-
a p p g c W Language Mappings l4=X 4 v
A
+ FO r C O n te n t T e JC++ These settings are global to the entire workspace. They are overridden by
4 earance project-specific language mappings.

Content Type Language

C Source File

+ For Language,
select UPC New COT rject Wead

Task Tags
Template Default Values v

+ Click OK, OK S
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UPC syntax in .c files (3)

L] hello.c I, main.c 12, helloMPI.c &, omp.c
+ Now UPC syntax &g

) #include <upc.h>

- : : Highlight color
IS recog n |Zed ]l.l int main(int argc, char *argv[]) {

c both types 1 pr‘tntf(;i'icllo, I am %d of %d.\n",

In 14 return 0;

of files

+ You may need

10 #include <upc.h>

11

12 int main(int argc, char *argv[]) {

1 printf("Hello, I am %d of %d.\n",
1 return 9;

1

to close anc
re-open a file
to see the change.

+ Note: in Project Properties, you can do this
for just individual projects.

}
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Berkeley UPC toolchain

(< JONG) C Project

C Project

+ Loca I p rOj eCtS O n I y Create C project of selected type

Project name: | helloUP(

* Fi I e > N eW > ™ Use default location
C project R —

default v
‘ H eI IO WO rI d Project type: Toolchains:
(= Executable Cygwin GCC

@ Empty Project Linux Berkeley UPC

U P C - t @ Hello World ANSI C Project Linux GCC
p rOJ e C @ MPI Hello World C Project MacOSX Berkeley UPC
@ MPI Pi C Project MacOSX CCC
® MPI Pi C++ Project MinCW GCC

.
+ Select toolchain 8 e Emy C rec
@ OpenMP Hello World C Project

@ OpenMP Empty C Project

H /4
if you don't have
(= Shared Library
- - - (== Static Library
the toolchain, it just [
, J u (= Remote Makefile Project
¥ 4 . I ) Show project types and toolchains only if they are supported on the platform

won’t build.)

+ Next, Next, Finish

( Next> ) ( cCancel ) & Finish-9)
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BUPC toolchain

®NO Properties for helloUPC

+ B I‘I N g u p type filter text ' Settings

Resource

Pro 1 ect Builders
J C/C++ Build Configuration: | Debug [ Active ]

Build Variables

P ro p e rti eS to Discovery Options

Environment

see deta | IS ;:ff;;f [ 55 Tool Settings Build Steps
Tool Chain Editor

Of B U PC C/C++ General 8] [iirkeley UPC Compiler |Command: upcc
(22 General

Project References —~ All options: -g -C
(222 UPC options

${COMMAND} §¢

1 Run/Debug Settings
to O I C h a I n : Service Configurations (22 Symbols
1 i85y Berkeley UPC Linker Expert settings:
rlg ht mouse, #2 General Command
Properties B Libraries

Task Repository i“'ﬁDirectories
o
52 Advanced options

P roj ect WikiText ii"':'fAdVanced OptionS

' V4 (23 Miscellaneous
3 UPC options line pattern:
"

:

Cancel
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Hello World UPC project

+ Hello (Berkeley) World UPC project
+ Note UPC syntax highlighting
+ Toolchain has been modified for UPC

L{*5 Project Explorer 23 = 0| [c| hellouPC.upe 3 L€ hello.c 1€, helloMPI.c 1€l omp.c

= hello
E> helloMPI
k> helloUPC
(= Debug
2 src ' Description : UPC Hello worl
l.c) helloUPC.upc -
= omp

b 10 #include <upc.h>
= shallow

11

12 int main(int argc, char *argv[]) {

13 printf("Hello, I am %d of %d.\n", MYTHREAD, THREADS);
14 return 9;

15 }
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UPC on abe.ncsa.uiuc.edu

+ BUPC is located at:
+ /usr/apps/mpi/upc/berkeley_upc
+ To run from cmd line on abe:
+ setenv PATH /usr/apps/mpi/upc/berkeley_upc/bin:${PATH}

TO RUN FROM PTP/ECLIPSE:

+ In your home dir on abe: use ‘helloUPC’ to make a remote proj
+ Set Remote Paths and Symbols to include:

+ /usr/apps/mpi/upc/berkeley_upc/opt/include/upcr_preinclude
+ To run: use a Generic Remote Launch for Resource Manager
+ Run config:

+ Application program: /usr/apps/mpi/upc/berkeley_upc/bin/
upcrun

+ Arguments tab: -q -n 4 ~/helloUPC/helloUPC
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External Tools Framework
ETFw Motivation

4+ There are numerous command-line oriented
development tools employed in HPC

+ These can be complicated or time consuming
to use

+ IDE integration for individual development
tools is slow and inconsistent

+ We want all our development tools in one
place with one interface

+ We want our development tools to work
together
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ETFw: Development Tool
e lg GIWE

+ Variations on ‘Compile, Execute, Analyze-
Results’ are common to most software
development

+ These steps may be tedious and time

consuming, especially over multiple iterations

+ By defining both tool interfaces and behavior
in an XML document these steps can be
simplified and automated

Module 7




paratieltools platform

ETFw: The Build Phase

<compile>
-'J.Ulfﬂ'-- arnarm i |o commands <e I~ 1 om,

immand sharing that tag --»
vampirtrace" >
<l-- Arguments to be pa 0 a command may ecified with the argument tag as shown here. -->
<argument value="-vt:cc"/>
</CCx>
<CXX command="vtexx" group="vampirtrace":>
<argument value="-vt:cxx"/>
</ CXx]
<F90 comoand="vt£90" group="vampirtrace'">
<argument value="-vt:£90"/>
</F90>
</compile>

+ Set compilers and arguments for each language

+ Define UI for compiler/compiler-wrapper
configuration
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ETFw: The Execution Phase

<execute>
<utility command="mpirun" group="mpi">
<argument value="-np 4"/>
</futility>
<utility command="psrun" group="perfsuite':>
</futility>
</execute>

+ Specify composed execution tools such as

Perfsuite or Valgrind
4+ Set launch environment variables

+ Define variables and tool options in XML or
provide a Ul in the IDE

+ Integrates with PTP parallel launch
environment
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ETFw: The Analysis/Post-
Processing Phase

and="expert" group="Kkojak">
<argument value="a.elg"/>
</futility>
<utility co and="paraprof" oup="tau" >
<argument value="a.cube"/>
</futility>

Application 13, Experiment 23, Trial 57.
File Options Windows Help

4
() Triangle Mesh

+ Sequentially run

() Scatter Plot

tools on program T

Inclusive v | |Time

Color Metric

output WSy T e

+ Launch external s 2 g
visualization tools B g

Function

Color value

Bar Plot | Axes ColorScale Render
Plot Width

Plot Depth

Plot Height

Bar Size

v] Transparency
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ETFw: XML-Defined Ul
Components

<tool name="Valgrind2">
<execu tex
<utility command="bash" group="inbin'"/>
<utility command="valgrind" group="valgrind">
<optionpane title="Valgrind2" seperatewith=" ">
<togoption label="Leak Check" optname="--leak-check=full" tooltip="Full memory leak check" defstate="true"/>
<togoption label="Show Reachable" optname="--show-reachable=yes" tooltip="Show reachable units"/>
<togoption label="Verbose" optname="--verbhose" tooltip="Verbose output"/>
</optionpane>
</utility>
</execu te>
</tool>

+ Each pane constructs a set of options Il
sent to a tool or a set of environment =y
variables

M Leak Check

+ Numerous options for converting a e
command line interface into an 0 Verbose
intelligent GUI without Eclipse coding

Module 7
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ETFw: Advanced Components

= g v —
ro| Select the PAPI counters to use with TAU

+ EXte n S i O n p O i n tS Ereate, manage, and run configurations S PAPLLL DCM

reate a configuration to launch a program to be instrumen| |[=) PAPI_L1_ICM

allow integration with EEEIEEEE

‘w‘ [E) Main | ®= Arguments | B§
UIs and workflow -+ Local appic | [ mnalysis ptiens [Tau camp
~ &3 Parallel Application

behavior too complex |[EEe —
to define in XML * | oo on

Select All ‘ ‘ Deselect All ‘ |Counter Descriptions‘

+ Logical and iterative o ) ]
workflows for M [ol] @ s i O e
successive executions
and parametric
studies

Select Makefile: [Makefile tau-phase-multiplecounters-mpi-papi-pdt | 7|

‘ Apply ‘ ‘ Revert ‘

| Profile l ‘ Close ‘

Module 7
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ETFw: Using Workflows

+ New workflows are : — -
reate, manage, and run configurations L\

a d d e d to t h e ET FW Ertglgr;:r,é—;:;r;:}rﬁ;agcﬁgsgc\zgc;ﬁz v;gs performance analysis tools. Launch parallel I\\{
launch configuration 1B % B | o [N comiguaon

type filter text — = -
‘ypi‘ % Environment | 5 Parallel

SYStel I I v Parallel Performar || | ool Selection | valgrind

New_configuraf

+ Multiple workflow ¥ peromanceAnl| [t nays oo [lnd ] 7]
CO n fi g u ra ti O n S Ca n b e memtest (] Build the instrumented executable but do not launch it
defined and saved for , rery ) [rewn

different use cases

+ XML Workflow
definitions can be saved
and reused in different

environments
Module 7
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ETFw: General Purpose Workflow

Compilation § o
program * Instrumentation
source * Compiler selection + A U tO I I I a te d

* Performance tool options
Re—compile wit] + G e n e ra I i Ze d

| modified option
Source " . . .-
* Execution options A

nodification * Performance tool options ;' + Q U i C k p e rfo r m a n Ce

l * Executable composition Re—execute with |

) modified Iopn’o;;sv“x‘:",""' a n a I yS i S a n d Ot h e r

* Analysis tools .
* Format conversion — I t g t I
t * Data storage I n e ra I O n

* Visualization

W development tool

+ Exposes tool
capabilities to the user

Module 7
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ETFw: Continuing Development

Plans:

+ Integration with PTP Remote Development
Tools

+ Additional options for GUI definition

+ Generalization of TAU specific features such as
hardware counter selection and performance
data storage

+ Contact: Wyatt Spear

Module 7
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ETFw Feedback view

+ Many existing tools provide
information that can be mapped to
source code lines

+ Compiler errors, warnings,
suggestions
+ Performance tool findings

+ ETFw feedback view provided to
aid construction of these views Examples:

+ Currently geared toward data + Compiler optimization
provided by tools in XML files report

+ Original ETFw facilities aid the + Performance tool data
CALL of external tools from PTP + Refactoring tool uses
+ Feedback view aids the “advice” from external files

exposition of results to the
user

Module 7
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Feedback Sample

+ Download a sample implementation of the
feedback view:

+ Complete instructions here:
http://wiki.eclipse.org/PTP/ETFw/feedback

+ And on following slide...

Module 7
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Feedback Sample - (1) Install

+ Download the plugin jar file

+ http://download.eclipse.org/tools/ptp/misc/feedback/
org.eclipse.ptp.etfw.feedback.sample_1.0.0.201010280927.jar

+ Save it in your eclipse/dropins directory
+ This is a “quick and dirty” type of installation

+ Eclipse knows to look here when it starts, and it
installs whatever it finds here

+ Then restart eclipse
+ You should see the feedback icon

Module 7
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. 3\\

Feedback Sample - (2) data files =

+ You have the Feedback sample plug-in installed

+ Now you need some sample files for it to process
+ sample.c and sample.xml
+ They are hidden in the plug-in!
+ Let’s take it apart to find them
+ Unzip the jar file; they are in the data/ directory
+Alternate instructions on the wiki page
+ Put them in a (local) eclipse project

Module 7
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Feedback Sample - (3) Try it

e ‘}\\\

+ You have the Feedback sample plug-in installed

+ You have an xml file that it can parse, and the
source file that it refers to.

. Select xml file

. Click feedback button
. See Sample Feedback
view
Double-click in view
to navigate to source
code lines

Module 7
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END
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Module 8: Other Tools and
Wrap-up

+ Objective
+ How to find more information on PTP
+ Learn about other tools related to PTP
+ See PTP upcoming features

+ Contents

+ Links to other tools, including performance tools
+ Planned features for new versions of PTP

+ Additional documentation

+ How to get involved
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+ Tools for NCSA Blue Waters
+
+ Sustained Petaflop system

+ Based on Eclipse and PTP
+ Includes some related tools m{{ﬂs

+ Performance tools SUSTAINED PETASCALE COMPU

+ Scalable debugger

+ Workflow tools (https://wiki.ncsa.uiuc.edu/
display/MRDPUB/MRD+Public+Space+Home
+Page)

+ Part of the enhanced computational environment
described at:
http://www.ncsa.illinois.edu/BlueWaters/ece.html
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Coding & NCSA HPC Workbench .
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Planned Future Work

+ Improvements to the PBS resource manager
+ Job templates
+ Interactive jobs

+ Remote development improvements
+ Photran

+ Enhancements to the debugger
+ Stability enhancements
+ Transition to Scalable Communication Infrastructure (SCI)

+ Scalability improvements
+ Ul to support 1M processes
+ Optimized communication protocol
+ Very large application support

Module 8
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Useful Eclipse Tools

+ Linux Tools (autotools, valgrind, Oprofile, Gprof)
+ http://eclipse.org/linuxtools

+ Python
+ http://pydev.org

+ Ruby
+ http://www.aptana.com/products/radrails

+ Perl
+ http://www.epic-ide.org
+ Git
+ http://www.eclipse.org/egit

+ VI bindings
+ Vrapper (open source) - http://vrapper.sourceforge.net
+ ViPlugin (commercial) - http://www.viplugin.com

Module 8
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Online Information

+ Information about PTP
+ Main web site for downloads, documentation, etc.
+ http://eclipse.org/ptp
+ Developers’ wiki for designs, planning, meetings, etc.
+ http://wiki.eclipse.org/PTP
+ Articles and other documents
+ http://wiki.eclipse.org/PTP/articles

+ Information about Photran
+ Main web site for downloads, documentation, etc.
+ http://eclipse.org/photran
+ User’s manuals
+ http://wiki.eclipse.org/PTP/photran/documentation
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Mailing Lists

+ PTP Mailing lists

+ Major announcements (new releases, etc.) - low volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-announce

+ User discussion and queries - medium volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-user

+ Developer discussions - high volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-dev

+ Photran Mailing lists
+ User discussion and queries
+ http://dev.eclipse.org/mailman/listinfo/photran

+ Developer discussions -
+ http://dev.eclipse.org/mailman/listinfo/photran-dev
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Getting Involved

+ See http://eclipse.org/ptp
+ Read the developer documentation on the wiki
+ Join the mailing lists

+ Attend the monthly developer meetings
+ Teleconference Monthly
+ Each second Tuesday, 1:00 pm ET
+ Details on the PTP wiki

+ SC BOF Wednesday 5:30 PM, Room 397

PTP will only succeed with your participation!
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PTP Tutorial Feedback

+ Please complete feedback form
+ Your feedback is valuable!

Thanks for attending
We hope you found it useful
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Module 9: Reference

+ Objective
+ Topics not covered in this Tutorial but may be useful

+ Contents
+ PTP-specific update site
+ Platform Differences
+ CDT local projects
+ CVS and source code repositories
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PTP-specific update site

+ If PTP needs to be updated, we will point you to
the PTP-specific update site:

http://download.eclipse.org/tools/ptp/updates/helios
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Platform Differences

+ Single button mouse (e.g. MacBook)
+ Use Control-click for right mouse / context menu

+ Context-sensitive help key differences
+ Windows: use F1 key
+ Linux: use Shift-F1 keys

+ MacOS X
+ Full keyboard, use Help key

+ MacBooks or aluminum keyboard, create a key binding
for Dynamic Help to any key you want

+ Accessing preferences

+ Windows & Linux: Window » Preferences...
+ MacOS X: Eclipse» Preferences...
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Creating a Local C/C++ Project

Steps:

+ Create a new C project
+ Edit source code

+ Save and build

C/C++ - HelloC/src/HelloC.c _ Eclipse SDK - /home/beth/ews/tutori
lil=H Edit Source Refactor Navigate Search Project Run PAPI Window Help
™ Salie 2 IS B €7 C++ Project

Open File...

™ Project...
Close Ctri+w

Close All Shift+Ctrl+W | [c] Convert to a C/C++ Project
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New C Project Wizard

C Project

C rea te a n eW C p roj ect Create C project of selected type

+ File»New»C Project Pojectrame: [wyiioprajees ]
(See p rev N SI id e) Y Use default location

+ Name the prOJeCt Location:
‘MyHelloProject’
Project type: Toolchains:

+ Under Project types, under BEEEERS

@ Empty Project

Executable, SE|€Ct He"o ® Hello World ANSI C Project. €——_This is a

» (= Executable (XL UPC) n . ”
World ANSI C Project Y e Managed Build
f- ’ b (= Static Library project
( n O m a ke I Ie req d ) P (= Static Library (XL UPC)
and hit Next S st v 1
&> Shared Library (XL C/C++) H :
1 i vecutable (XL UP Makefile project;
On Basic Settings page; Qo uf;:a:ii;fu?c/

e . < Libra provide your
fill in information for your @ Shared ibrary (1L UPC) own makefile

1, Makefile project
n eW p rOj eCt (Auth o r 4 Pohgiect types and toolchains only if they are supported on the platform
name etc.) and hit Finish

Choose file system:

) ( cancel ) ( Finish
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Changing the C/C++ Build
Settings Manually

‘typefiltertext ) | Settings

Open the project properties
by right-mouse clicking on
project and select
Properties

Expand C/C++ Build

Select Settings

Select C Compiler to change
compiler settings

Select C Linker to change
linker settings

It's also possible to change
compiler/linker arguments

Hit OK to close

Module 9
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Build

e Q

+ Your program should build when created.

+ To rebuild, many ways include:
+ Select project, Hit hammer icorrin toolbar
+ Select project, Project » Build Project IZ0Ead Bn PAPI Window e
+ Right mouse on project, Clean Project Close Project

o Build Al Ctrl+B
o Build Configurations
New " Build Project
Go Into . .
b &) Include! - Build Working Set

b = src Open in New Window Clean...
<! Build Automatically

L Project Explorer $3 ==

b 4 Binaries

v (= Debug = Copy

P = src
. Make Target
P % MyH( % Delete

Properties

Rename...

2 Import.. : see build output

w5 Export...

Clean Project

Close Project
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Build (2)

+ See the results of the build in the Console View
+ Executa ble ShOUId {2. Problems | ¥ Task : Properties

C-Build [MyHelloProje

be In Debug fOIder: *+** Build of configuration Debug for project MyHelloProject ****

make all

Building file: ../src/MyHelloProject.c

Invoking: GCC C Compiler

gcc -00 -g3 -wall -c -fmessage-length=0 -MMD -MP -MF"src/MyHelloProject.d" -
MT"src/MyHelloProject.d" -o"src/MyHelloProject.o" "../src/MyHelloProject.c"
Finished building: ../src/MyHelloProject.c

. Project Explorer £3
v =% MyHelloProject

b #¥ Binaries
Building target: MyHelloProject

P @l Includes Invoking: GCC C Linker

b @ src gcc -o“MyHe_.'llc_)Project“ ./src/MyHell_oProject.o
Finished building target: MyHelloProject

v (= Debug

P = src

» ‘& MyHelloProject
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Build problems?

+ If there are problems, see:
+ Marker on editor line
* PrObIems View {2 MyHelloProject.c 2 | =g|isox > =0

puts("!!!Hello World !!!"); /% prints !!lHello World!!! */ [Alm <
return EXIT_SUCCESS;

%0 + laz \ Xﬁ e %

¥ Returns f(x) = 3.0%x + 2.0 2 stdio.h

¥/ = stdlib.h

+ Double-click on [ ot sametsonie

c!quble c =2.0; ¢ evaluate(double

|||_’1e in Problems
view to go to
location of error

Description Resource Path Type
< @ Errors (2 items)
@ make: *¥** [src/MyHelloProject.o] Err MyHeIIoProje§ C/C++ Problem
® expected ‘," or ;" before ‘return’ MyHelloProje /MyHelloProject/< line 26  C/C++ Problem
< & Warnings (2 items)
% control reaches end of non-void funé MyHeIIoProjeé /MyHelloProje C/C++ Problem
% unused variable 'y’ MyHeIIoProje§ /MyHelloProje C/C++ Problem
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Build problems? Try it

4+ Remove a semicolon from a line
in your “Hello World” example

+ Save file \
- puts("!!!Hello World !!!"); /* prints !!!Hello World!!! */ [Alm
return EXIT_SUCCESS;
‘ RebUIId } B B R e

JEL
¥ Returns f(x) = 3.0%x + 2.0 4 stdioh

+ See the 7 ¢ o
double evaluate(double x)
{

o main(void) : int
double ¢ = 2.0; # evaluate(double

P ro b I e m S v i ew ’:f ;j;uble yazci;;fl\icilgn to end of next line

4+ Double-click on line in
Problems view to go to

Description Resource Locatior Type

location of error

@ make: *** [src/MyHelloProject.o] Erri MyHelloProje: line 0 C/C++ Problem
® expected’," or ;" before ‘retum’  MyHelloProje /MyHelloProject/s line 26 C/C++ Problem

+ Fix it and rebuild to

% control reaches end of non-void funcz MyHelloP HeIIoProject/sg line 27 C/C++ Problem

CO n t i n u e % unused variable ‘y’ MyHelloProje: /MyHeIIoProject/s§ line 25 C/C++ Problem

Module 9
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Run - Local Launch

+ To run your C program,

+ Create a launch configuration
(see next slide)

+ This saves the run/launching information and
can be used to quickly run your program
each time, with and without debug.

Ov (?,v Oﬁv OV

| Run As >

I Run Configurations... i

Organize Favorites..)
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Create a Launch Configuration

a.k.a. Run Configuration

Run Configurations

Create, manage, and run configurations

OK‘&'V Qv | Ov

Run As >

-_—m i " Configure launch settings from this dialog:
RUﬂ Conﬁguratlons-" type filter text ¥ - Press the 'New' button to create a configuration of the selected type.
Organize Fayorites..'? [t]C/C++ Application

[c]C/C++ Remote Applicat
= Launch Group J{ - Press the 'Delete' button to remove the selected configuration.

- Press the 'Duplicate’ button to copy the selected configuration.

+ Open the run
configuration
dialog Run»
Ru n Co nfig u ratians. . Configure launch perspective settings from the Perspectives preference page.

Select C/C++
Application

Select the New Filter matched 3 of 12 items
button

:' - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

@)

Depending on which flavor of Eclipse you

installed, you might have more choices in
Application types.




paratieltools platform

aw ‘2\\

Complete the Main Tab

+ Ensure that the correct
project is selected

+ Select the C/C++
Application (executable) if [
necessary e fitertext
+ Search Project... will search v [E1C/C++ Application

[€ |MyHelloProject Debug

_]USt W|th|n the prOJeCt :ch,r'C4— Remote Application

+ Browse will search anywhere ¥ Launch Group
on the local file system Build Configuration [ Debug

Select Connect process C/C++ Application:
input/output to a
terminal if desired

Create, manage, and run configurations

Name: MyHelloProject Debug

= Arguments "'.;[nvironment “v'p Debugger , Source| 17 Refresh | -] Common

.MyHeIloProject 1 (" Browse... )

Debug/MyHelloProject (" Search Project... ) [ Browse.. )

Z Connect process input output to a terminal.

Filter matched 4 of 13 items

@)
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Complete the Arguments Tab

+ Enter any program — Run Configurations
arguments |nt0 the teXt bOX Create, manage, and run configurations

+ Eclipse variables can also be
passed using the |
va riables--- button jz: Zl;zitf):pphcatioﬂ 5] Mai g Environment| %5 Debugger| &, Source| 1" Refresh | ] Common

Program arg

»

- ’ .
R | E S5 Name: MyHelloProject Debug

[t |MyHelloProject Debug

+ SeIeCt a different Working [€]C/C++ Remote Applicatic
directory if desired P Launen Growp

("Variables... )
Working directory:

Y Use default

Revert

Filter matched 4 of 13 items

@




Create, manage, and run configurations

Select Debugger tab

Make sure gdb/mi is
selected

Change where the
program should stop if

v [C]C/C++ Application

= Launch Group

[ |MyHelloProject Debug
[E]c/C++ Remote Application

desired

Change any gdb-specific
options if desired
(advanced users only)

The information on the
debugger tab will only be
used for a debug launch

+ Hit the Run button to
launch your program

Filter matched 4 of 13 items

@)

Name: MyHelloProject Debug

[5] Main | 9= Arguments | g Environmen “y';} Debugger (‘Y‘i Source| 1" Refresh | =] Common

Debugger: | gdb/mi

4> z’ Stop on startup at:  main (" Advanced... )

Debugger Options

| Main  Shared Libraries |

CDB debugger: .gdb ] Browse... )

GDB command file: v.gdbinit | / Browse... )

(Warning: Some commands in this file may interfere with the startup operation of the debugger, for
example “run®.)

CDB command set:

| Standard (Mac OS)

Protocol: | mi

[ Verbose console mode

["] Use full file path to set breakpoints
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Viewing Program Output

+ When the program runs, the Console view should automatically
become active

+ Any output will be displayed in this view (stderr in red)

2| Problems | ;| Tasks | E] Console 3 | Properties X% el &Hd #Byriy= 0O

<terminated> MyHelloProject Debug [C/C++ Application] /Users/greg/Documents/workspace/MyHelloProject/Debug/NM
111Hello World!!!




paratieltools platform

Debug your code

+ Launch with same config
used for Run

+ If asked, you can set:
+ Preferred Launcher: Standard

+Use Config-specific or
change Workspace setting
Debug As I

+ Debugger: gdb/mi Debug Configurations...

* ECIipse aSkS tO SWitCh Organize Favorites...
to Debug Perspective

+ Select Yes to continue

B Ov Q_;v Oﬂv . LEQ = -.';.':'v
€1 MyHeIIoProject\

We’ll cover debugging in much more

detail when we cover parallel debugging
9-16
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Debug your code (2)

+ Upon launch, Eclipse switches to
Debug Perspective

+ Program stops at main

+ Set Breakpoint by double-clicking Terminate
in editor left margin Run/Resume /" step Over

i T 2 ? 9 2 *
A Breakpoint AL al L
¥ | c |MyHelloProject [C/C++ Application]
Marker v &2 gdb/mi (9/25/09 12:59 PM) (Suspended)

v 7 Thread (0] (Suspended: Breakpoint hit.)

‘ St - t h F 5 v — 1 main() /Users/beth/ews/runtime-pldt-upc-3.0/MyHelloProject/src/MyHz¢
e p WI O r p| gdb (9/25/09 12:59 PM)

p| /Users/beth/ews/runtime-pldt-upc-3.0/MyHelloProject/Debug/MyHelloProject (

+ Run with F8 or
+ Hit Breakpoint; inspect variables; inspect stack
+ End with Terminate, or run to end of Prog

Module 9
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Other CDT features

+ Searching

+ Open Declaration / hyperlinking between files
in the editor

+ Rename in file (in-place in editor)

+ Refactoring
+ Rename refactoring / Preview panes
+ Extract Constant refactoring
+ Other refactorings in CDT
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Language-Based Searching

Project Window
Search... Ctrl+H

7 File..
Text

» C/C++...

5 Fortran...

“Knows” what things can
Search string (* = any string, 7 = any character): be d eCIa red In ea Ch
get' + [ Case sensitive language (functions,
Search For - ‘ Liemit To——————— variables, classes,
Class / Struct V| Function Variable Declarations Definitions

[7] Union V| Method Field 7| References | All Occurrences m Od u I e5, etC . )

Enumeration Enumerator Namespace

7 File Search: €57 C/C++ Search E5” Fortran Search | %7 Java Search I % Plug-in Search

Typedef Macro Any Element

Scope E.g., search for every call

@ Workspace Selected resources Enclosing projects to a fu n Ctl 0 n W h ose n a m e
Working et [ chomse.. ] starts with “get”

Search can be project- or

';71 Customize... Cancel .
] workspace-wide

9-19
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Open Declaration

.c| MyHelloProject.c 53 . ‘{h stdio.h

Jumps to the declaration 7 Undo Typing

of a variable, function, Authon
etc., even ifit'sin a w_’rf-rsig
different file el Open Declaration
’ Open Type Hierarchy
Right-click on an identifier Open Call Hierarchy
Click Open Declaration : Quick Outline
#includ Quick Type Hierarchy

- i Explore Macro Expansion
Can also Ctrl-click (Mac:
( Toggle Source/Header

Cmd-click) to ' i
“hyperlink” to declaration & pasy in 3w
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Rename Refactoring

+ Changes the name of a variable, function, etc.,

including every use
(change is semantic, not textual, and can be workspace-wide)

+ Only proceeds if the new name will be legal

(aware of scoping rules, namespaces, etc.)

C/C++ - MyHelloProject/src/MyHelloP: Select C/C+ + PerSPeCtive

File Edit Source Navigate Search Proje Open a source file

8l B Repame... SITHAIEHR Click in editor view on declaration of

$v §lv *o <ov Extract Local Variable Shift+Alt+L a variable

Extract Constant... Alt+C 3
'35 Project Explorer B Select menu item

E*tract Function... Shift+Alt+M Refactor» Rename
Hide Metw...
4+ Or use context menu
Enter new name
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CDT Rename in File

+ Position the caret 6] example.ce 82
over an identifier. class {

public:

MyClass|() ;
+ Press Ctrl+1 ( \s

(Command+1 on Mac).
int getX();
void setX(int X);

4+ Enter a new name.
Changes are private:

propagated within int x ;

. };
the file as you type.
“int MyClassl::getX() {

return x ;

}
-void MyClass|: :setX(int x) {

X = X;

}




parateltools plat

CDT Extract Constant Refactoring

int main(void) {
e No Refactoring double intvalue—@.@l;

The following changes are necessary to perform the refactoring. Source ” H ’
Refactor Rename... {4XR

Changes to be performed Declarations Extract Constant... \C
M ¥ &3 Changes s -
l?‘ @~ MyCproject.c - MyCproject/src

@ MyCoroject< Y| +Other refactorings

Original Source Refactored Source

#include <stdio.h> #include <stdlib.h> f that a re pla n ned :

#include <stdlib.h>

__—{static const float MYZERO = 9.9;

int main(void) { [int main(void) {
double intvalu double intvalue=MYZERO;
puts("!111Hello WoP™Td!!!"); /* prints | puts("!!!1Hello World!!!"); /* prin
return EXIT_SUCCESS; return EXIT_SUCCESS;

} }

int foo(){ int foo(){
double myin double myint=MYZERO;

}

Extract Function

Hide Member Function

Move Field or Member Function
Extract Subclass

Extract Baseclass

Separate Class

Implement Function

Declare Function

Move Function Definition

++ 4+ 4+

(W_\ S (Cancel ) (FmEH Generate Getters and Setters

9-23
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CVS Source Code Repository

+ Configuring version control
+ Checking out the source code
+ Team support
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Connecting to a Repository

+ Select Window »Open
Perspective »Other...

+ Select CVS Repository
Exploring then OK




Specify Repository Location

Right-click in the CVS
Repositories view, then select
New » Repository Location...

Set Host to the hostname of
remote machine

Set Repository path to the CVS
repository path

Fill in Username and Password

Set Connection type to extssh
to use an ssh connection

+ For anonymous access, use
pserver connection type

Check Save password if you
wish to save the password

Select Finish

Add CVS Repository

Add a new CVS Repository

Add a new CVS Repository to the CVS Repositories view

Location

Host: cvs.ncsa.uiuc.edu

Repository path:  /CVS/ptp-samples

Authentication
User: anonymous

Password:

Connection
Connection type: | pserver
(® Use default port

() Use port:

@ Validate connection on finish

[) Save password (could trigger secure storage login)
To manage your password, please see 'Secure Storage'

Configure connection preferences...

Cancel

) € Finish )

<
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CVS Repository Exploring

eno CVS Repository Exploring - cvs.ncsa.uiuc.edu/CVS/ptp-samples/samples/shallow/calc.c 1.1 - Eclipse SDK

Open the repository in p= 1 4e o 4 . s [ B Raposits /s
the CVS Repository [Eae=rme ® $[B]E~ =0)Caciin ~l=

N | :pserver:anonymous@cvs.ncsa.uiuc.edu:/CVS/ptp-samples
VIeW R HEAD /3K KKK KKK KKK KKK KKK
*
(= CVSROOT
(= lockdir

Open HEAD to view _ veEsample

(= hpcc-1.3.1

files and folders in the e
CVS head S copric 11

I decs.h 1.1
€] diag.c 1.1
I8 dump.c 1.1
1) init.c 1.1

Optional:

@ Makefile 1.1

Il time.c 1.1
Open Branches or

I worker.c 1.1

Versions to view CVS ARacanches

Tig Versions

branches or versions B pates
respectively ({9 Task Repositories 53 F~Yy=0o & History 22

O& Local

Right-click on the s Ecesecr
repository and select
Refresh Branches...

to see all branches and
versions

Commonwealth Scientific and Industrial Research Organisation (CSIR0) *
- Division of Information Technology (DIT) *
- Division of Atmospheric Research (DAR) b
*

Shallow water weather model - Distributed Memory Version
*

Finite difference model of shallow water equations based on :- *
"The dynamics of finite difference models of the shallow water *
equations"” by R. Sadourney, JAS, 32, 1975. *

/
*
*
*
*
*
*
*
*
*
*
* Code from:-
*
*
*
*
*
*
*
*
*
*
*

*
"An introduction to three-dimensional climate modelling"

by Washington and Parkinson *

*

Programmers David Abramson (DIT) rcoda@koel.co.rmit.oz *

Paul Whiting (DIT) rcopw@koel.co.rmit.oz *

Martin Dix (DAR) mrd@koel.co.rmit.oz *
Language BSD c using Argonne NL macros *
0/S Unix System V *

H/W Encore Multimax 320 *
*

D Ty

samples in :pserver:anonymous@cvs.ncsa.uiuc.edu:/CVS/ptp-samples
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Checking out code in Eclipse

New

If the project exists in the repository ———

as an Eclipse Project, then one can Check Out As...
Slmply “ChECk Out" the COde iz Tag as Version...
In thlS Case, you can: Tag with Existing...

Paste Connection

In CVS Repositories view,right-click Compare With...
on project and select Expand All
Project » Check Out % Add to Branch List...

%’ Configure Branches and Versions...

+» Refresh View

But ... our example doesn’t have
Eclipse Project information - this
code was checked in with command
line tools.

Our next slide shows how to add
Eclipse Project information
automatically as you check out the
code.




Check out as an Eclipse Project

In CVS Repositories view, right-click

on project and select
Project» Check Out As...

Make sure Check out as a project

Check Out
Check Out As...

iz Tag as Version...
Tag with Existing...

Paste Connection

configured using the New Project Compare With...

Wizard is selected

Leave Checkout subfolders
checked

Select Finish

The wizard that runs next
will add Eclipse information
to the project.

Expand All

%" Add to Branch List...

' Check Out As
Check Out As

Select the method of check out

Choose how to check out folder 'mpgc-2.3.1"
@ Check out as a project configured using the New Project Wizard

/:_‘ Check out as a project in the workspace
Project Name:

(O Check out into an existing project

M Checkout subfolders

Working sets
7] Add project to working sets

Working sets:

) € Finish )
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New Project Wizard:
Create a C Project

Select a wizard

Create a new C project

Wizards:

The New Project Wizard is used

(2% Java Project

to C rea te a C p roj eCt s Java Project from Existing Ant Buildfile

7 Plug-in Project
P (= General

Enter Project name a—
Under Project Types, select

Makefile project» Empty
P rOj ect ™ Use default location

Location: /Users/greg/Documents/workspaces/tutorial-workspace/s

+ Ensures that CDT will use existing
NELGHIES

- - ecutable -- Other Toolchain --
ared Libra MacOSX GCC
Select Finish
(= M3%efile project

When prompted to switch to the

(= Remote Makefile Project

C / C + + Pe rs pective I Se I ect Yes @ Show project types and toolchains only if they are supported on the platform
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OpenMP: Show Concurrency

Highlight a statement

Select the context menu
on the highlighted
statement, and click
Show concurrency

Other statements will be
highlighted in yellow

The yellow highlighted
statements might execute
concurrently to the
selected statement

Module 7

int simple(){

b=3;‘g\

a=4;
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